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About the Conductor

Overview of the QALoad Conductor

Use the QALoad Conductor to configure, run, and monitor aload test that utilizesthe scriptscreated in the
Script Development Workbench. The Conductor controlsthe QALoad Players and manages tests while they
arerunning. When the Conductor process stops for any reason during aload test, the associated Player
processes automatically terminate.

The Conductor'sinterface isdynamic — it changes depending on where you arein the testing process:
setting up atest or running atest. Both interfaces are described below.

Test Setup

Beforerunning atest, you must set up atest by recording descriptive information about the test, setting
general test options, configuring Player workstations, assigning compiled test scriptsto Players, and setting
up monitoring options. Then, save thetest setup in afile called a session ID. Once you have configured
and saved atest session ID, you can reuse it without re-entering any test information.

The Conductor'sMain Window isdivided into tabs on which you enter information about your test and
set up the machines and scriptsfor the test. For more information about the test setup interface, see Test
Setup Interface.

Running a Test

Whileatest isrunning, the Conductor interface changesto atri-pane view called the Runtime Window
that facilitates monitoring of individual machines and Players, and displaysreal-time test results. You can
view default graphs of performance data that are created for you by the Conductor and create custom
graphsbased on the data being collected during the test. Custom graph layouts can be saved in the session
ID fileand reused in future tests.

QALoad Conductor Menus and Toolbar Buttons

The Conductor'smenus and toolbar buttonsare dynamic; their content depends on whether you are
preparing atest setup or running atest.

Test Setup

The Conductor Configuration and Setup Menus allow you to configure the Conductor and your specific
test. Click amenu or toolbar name below for details:

File
Edit
View
Run
Tools
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Help
Configuration and Setup Toolbar Buttons

Running a Test

The Conductor's Runtime menus and toolbar allow you to control your running test and the datathat is
displayed at test time. Click amenu name below for details:

Test Options

View

Runtime Windows
Virtual User

Graph

Runtime Toolbar Buttons

Test Setup Interface

Test Setup Interface

The Conductor'sMain Window isdivided into tabson which you enter information about your test and
set up the machines and scriptsfor the test. In addition, the Conductor'stoolbar provides access to
standard Windows functionality such as Print and Copy, as well as quick accessto Conductor setup
optionsand to QALoad Analyze. Usethe tabson the Main Window to set up your test. For detailed
information about the fields on these tabs, click one of the links below or press F1 on any Conductor tab.

i+ QAlLoad Conductor - Untitled E||E|E|
File Edit Miew FRun Tools Help

HAE® 4 EEN) (Mg O

Test Dezcription

Test Description: | |

Client System: | |

Server Spstem: | |

Databaze Size: | |

Comments:
Configurable Parameters Lazt Test Statisticz
Session Duration; 00:00:00 Test Time: Tatal Virtual U sers:

Test Date: [ 07722005 Total Pass Transactions: P
Test Duration: I ; Tatal Fail Transactions: ]

[] Enable Test Recording

¢ Test Infarmation || Script Assignment | Monitoring Options ] tlachine Azsignment ‘
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Test Information

Usethistab to enter descriptive information about the test, view statisticsfrom the previoustest, and set a
maximum amount of time for the current test to run. All descriptive information about the test will be
incorporated into your test'stiming file, and can be viewed in Analyze with your test statistics after the test
has finished.

Test Description: Type a description of the test, for example, its purpose. Thisfield iswritten to your test's
timing file to describe the test. Thisfield isoptional.

Client System: Type adescription of the client workstations. Thisfield is optional.
Server System: Type a description of the server(s) under test. Thisfield is optional.
Database Size: Type adescription of the database used in thistest. Thisfield isoptional.

Comments: Type any general comments about thetest in thisfield. Note that thisfield isoverwritten at
theend of atest if the Post Test Remarks check box on the Optionsdialog box, General tab isenabled. In
that case, notesyou typein the Post Test Remarks dialog will be saved to the test's Summary Report.

Session Duration: Type avalue to specify the maximum amount of time for the test to run. Entering zero
(the default) will execute the test indefinitely. You can determine whether to stop the test immediately
when the duration expiresor to allow the virtual usersto complete therunning transactions by using the
option Gracefully Exit Userswhen Session Duration expireson the Optionsdialog box, General tab.

Enable Test Recording: Select thischeck box to record load tests for later review.

Test Time: Displaysthetimethe previoustest started.

Test Date: Displaysthe date the previoustest started.

Test Duration: Displaysthe length of time it took for the previoustest to run.

Total Virtual Users: Displaysthe number of virtual usersassigned to the previoustest.

Total Pass Transactions: Displaysthe number of transactionsthat ran successfully in the previoustest.

Total Fail Transactions: Displaysthe number of transactionsthat failed in the previous test.

Script Assignment

Usethistab to set up any scriptsthat have previously been recorded and compiled. Any scriptsyou add
hereisincluded in your load test, and one virtual user isautomatically assigned to your script on the
Machine Assignment tab. After setting up your scripts here, you must assign additional virtual usersto
your script from the Machine Assignment tab.

Script: Select a script from the drop-down list, or click the New button to add a script. Click the browse
[...] button to open the Select Script dialog box.

New: Click thisbutton to browse for a script to add to the test.
Delete: Click thisbutton to remove the selected script from the load test.
Delete All: Click this button to delete all scriptsfrom thistest.

Type: Liststhe middleware type of the script. Click the browse (...) button to set custom middleware
options.

Transactions: Type the number of transactionsthat each virtual user running the designated script should
run. Once aworkstation reachesthe maximum number of transactions, the script continues execution
with theline following the End_Transaction command rather than returning to the top of the transaction
loop. If you enter 0, the Conductor executesthe script indefinitely.

Debug Options: Click the browse button to accessthe Debug Options dialog box, where you can configure
debug settings for the script.
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Error Handling: Choose how to respond when a non-critical error occurs during execution of the
transaction. During large load tests, errors can sometimesindicate that the test isstraining the limits of the
hardware/software in the testing environment. Options are:

I Continue Transaction — If an error occurswhile a transaction is being executed, the Player should
continue executing the transaction asif the error had not occurred. Select this option when errors
are not critical to the performance of the load test and can be safely ignored.

I Abort Transaction — If an error occurswhile atransaction is being executed, the Player should
abort the current transaction and the virtual user who encountered the error should exit the test.
Use this option when errorswill make the virtual user invalid for executing more transactions.

I Restart Transaction (WWW, SAPGUI, and Citrix scriptsonly) — If an error occurswhile a
transaction isbeing executed, the Player should abort the current transaction entirely and restart a
new transaction from the beginning. Note that the transaction count increases for each transaction
that isrestarted.

QALoad usestwo commands — DO_SetTransactionSart() and DO_SetTransactionCleanup() — to control
error handling. These commands are inserted into your script by the conversion process.

El Note: When the Conductor process stops for any reason during a load test, the associated Player processes
automatically terminate.

Sleep Factor %: QALoad recordsthe actual delays between requestsand insertsthe DO_SLEEP command in
the script to mimic those delayswhen the script is played back in atest. You can maintain the exact length
of therecorded delays at playback, or shorten them by entering a smaller percentage of the originally
recorded delay to play back. For example, if you recorded a delay of 10 seconds, then DO_S EEP (10); is
written to your script. Then, if a Seep Factor of 50% is specified here, the Player will sleep for 5 seconds at
that statement when thetest is executed.

Valid values for Seep Factor % are 0-999,999% and also Random, which causesthe Player to sleep for a
randomly selected duration between 0 and the number of seconds specified in the DO_S_EEP() statements.

When aload test is executed with a Seep Factor of 100% the script executes at exactly the same speed at
which it wasrecorded; therefore, you can simulate the performance of faster users by specifying a lower
Seep Factor % value.

' Hint: Enter a value of zero during unit testing to eliminate the actual deeps from the script. After you unit
test the script, you can restore the original recorded delays by changing the Seep Factor to a higher
percentage.

Service Level Threshold: Enter aresponse time to use asthe threshold for comparing other response
times. When you run atest, alinerepresenting the Service Level Threshold will appear in theruntime
window. Asthe test progresses, you can compare incoming response time datato the Service Level
Threshold. Thisisapreliminary way of analyzing test results without waiting to open thetimingfile at the
end of the test, and can be used as an indicator to determineif/when Dial-Up users should be added to the
test.

Pacing: Enter avaluein thisfield for the rate of pacing. Pacing isthetime interval between the start of a
transaction and the beginning of the next transaction on each workstation running the script. For
example: if atransaction isdesigned to duplicate the process of someone handlingincoming telephone
callsand those calls arrive at arate of 40 per hour/per person, set the pacing rate at 90 seconds.

The default pacing value isone second. Thisallowsthe Conductor to throttle runaway virtual users.

QALoad randomly schedulestransactions so that each transaction executes on an average according to this
predetermined rate. When atransaction completes faster than its pacing rate, QALoad delays the execution
of the next transaction for that workstation so that proper pacing ismet. Snce we do not normally time
eventsaccording to thispredetermined rate, QALoad randomly accelerates or delaysthe pacing on a
workstation-by-workstation basis. However, on the average, QALoad provides pacing according to the value
that you assign.
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Timing Options: Click Browse to open the Timing Options dialog box, where you can chooseto include
QALoad'sautomatic timingsin your test results or determine how much timing datato collect.

External Data: Click Browse to open the External Data dialog box where you can select any central
datapool files, local datapool files, or additional external support files necessary for your test. For additional
information, see Using the certDB File for OFSReplay.

Monitoring Options

Usethe Monitoring Optionstab to specify optionsfor your monitoring task. You also can integrate
ServerVantage into your load test. QALoad assumesthat the appropriate ServerVantage software is
installed, configured, and running before you start aload test.

Enable Performance Monitoring at Runtime: Enablesthe monitoring of the counters specified in a
monitoring task you create.

When you select a monitoring task, the following displays:

Monitors: Displaysthe list of groups of monitors and associated machines selected for thismonitoring
task. Use the selection button to choose to display groups by machine name or by monitor type.

Monitors detail: Displays details of the monitoring task you selected including Machine name,
Monitor Type, and the date it was last updated.

Use theicon to choose how to view the monitors. You can choose:
= Group by machine name
= Group by monitor type
When you select amonitoring template, the following displays:
Templates: Displaysthe name of the template you selected.
Counters: Displaysthe groups and countersdefined in the template.
View Properties: Displaysthe properties for the monitoring task.

Set up monitoring: Displaysthe Set Up Monitoring dialog box, where you can choose to set up anew
monitoring task or use an existing task stored as atemplate.

Machine Assignment

Usethe Machine Assignment tab to assign scriptsto specific Player workstations. You can usethe Edit
menu's Copy and Paste commandsto copy and paste machine entries (rows) as needed.

Script: Thisfield displaysthe script name. To add a script, click New.

Middleware: Displaysthe middleware type the script was created for. Use the browse [...] button to open
the Expert User Optionsdialog box.

Starting VUs: Type number of virtual usersto begin the test.
VU Increment: Typethe number of virtual usersto be added, at intervals, after the test begins.

Time Interval: Displaysthetime interval at which incremental virtual users will be added to atest. Change
thetimeinterval by typing anew value.

Ending VUs: Displaysthe number of virtual users assigned to run until the end of the test.

Machine: From the drop-down list, select Player machinesto assign each script to run on.
For ApplicationVantage integrations, the Player and Conductor machines must be on the same LAN.

Mode: Slect the test mode for each Player machine: thread-based, process-based.
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New: Click to accessthe Select Script dialog box where you can select a script to add to the test.
Delete: Click to delete the selected script.
Delete All: Click to delete all scripts.

Manage Player Machines: Click thisbutton to display the Manage Player Machines and Groups dialog
box.

Auto Configure: Click thisbutton to have QALoad automatically assign scriptsto virtual users.

Run: Click to start atest run. Thisbutton isonly enabled if your test iscompletely set up.

Runtime Window Interface

Runtime Window Interface

When you start atest, the Conductor'sinterface changesto an interactive test control station called the
Runtime Window. The Runtime Window displaysinformation about the scripts, machines, and virtual
usersthat are executing the load test. Thetest dataisdivided into three views — Details, Graphs, and
Session —that are accessed from the Test Views workspace on the left side of the interface.

On the Runtime Window, you can observe the progress of individual scriptsand Player machines, view
real-time graphs, and start or suspend scriptsand Players from arunning test to better ssmulate the
unpredictability of real users. Thiswindow hasthree unique areas. Click on a panein the following graphic
for a brief description of that pane. Or, click on the links below the graphic for detailed information.

Tt QALoad Conductor [Z”E| El

Test Options  Wiew  Runtime Windows  Wirtual User  Graph

» 58 B Bo & D43

Test Yiews
E_ =G Testipts | Llser| M achine | F'ass| Fail| Min| Ma:-:| Last| Status |
i i s 0 dwil4gl. 14 0 0 0 0
Details =l Plaver Machines

o dhwl14310401:3032

d

Graphs

Scrpt Optionz - mjc3 Global Ophions

Error Handling: Timing Updates
|F|estart W | Q Funning ) Mo Updates

—— ) Gend Al
SlEEp [2]1 i = : 1 apply

Pacing [hh:mnm: sz msl: (%) Periodic: Updates
100 | |0000O0.000 | | 2|

Test Time: 00:00:15 Last Update: 00:00:14 Test executing...

Details View

The Detailsview of the Datawindow in the Conductor Runtime Window displays all your test datain real-
timein aseries of interactive tabs. By clicking on icons representing scripts, virtual users, and workstations,
you can view different types of data. By default, each test displaystest detailsin the right pane. You can



Conductor

also choose to view the script asingle virtual user isrunning, the Web page a WWW script isutilizing, or
the RIP file generated by afailed virtual user.

Test Details

Test details display automatically, and describe the object you select in the tree view. You can view details
for all test scripts, individual test scripts, all player machines, and individual player machines.

See Test detailsfor moreinformation about the tree itemsthat can be displayed in the data window.
Runtime Tabs

The following runtime tabs can be displayed for arunning script. These tabs can be enabled from the
Virtual User menu.

Debug
RIP Fle (WWW)

Runtime Control Panel

The Runtime Control Panel isadockable control station that enables you to change virtual user options
and data transfer optionswhile theload test isrunning. For more information, see Runtime Control Panel.

Graphs View

The Graphsview in the Conductor Runtime Window displays graphs of data collected during the test. By
default, the Graphsview displays graphsfor response times, test status, and player machine health.

Other graphs, such as user-defined checkpointsand Remote Monitoring counters, can also be plotted in
theright pane of the Graphsview if they were enabled for the session.

To display graphs:

1. Right-click on acounter or other datatypein thetreeview that you want to plot in a graph.
2. Choose Add Graph or Add Plot To.

You can also modify a graph's appearance by right-clicking on the graph and choosing one of the
formatting options, such as colors and axes properties. To increase the visibility of a plot when you have
multiple plotson a graph, click on aplot (or that plot'snumber in the legend) to highlight it.
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Session View

The Session view in the Conductor Runtime Window provides summary information about the test session
that iscurrently running. The Session view can be printed as a report by right-clicking and choosing Print
from the shortcut menu.

Click on the sectionsin the following graphic for more information about the Session view.
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Running Scripts
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Setting Up a Test

Configuring the Conductor

There are several settings for the Conductor that you should review before beginning your load test.

To set Conductor optionsthat are not specificto one test:

1. From the main menu, choose Tools>Options.

2. On the Optionsdialog box, set optionsrelated to post-test activity, warnings and prompts, runtime
grids, timing settings, interface refresh intervals, Conductor/Player communications, monitoring
intervals, and more.
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3. When you arefinished, click OK to save your changes. Any optionsyou set will apply to all tests
until you change them.

For detailed descriptions of the optionsthat are available, see Options dialog box.

About Setting Up a Test Setup

To set up aload test, set optionsrelated to general Conductor behavior aswell asinformation about your
specific test environment. Before you can successfully set up aload test, you must have recorded and
compiled one or more test scripts. For information about recording atest script, see Developing Scriptsin
the Getting Sarted section.

Determining General Conductor Behavior
General Conductor optionsyou set will be applicable for all testsrun until you change them. Conductor
optionsarerelated to the following:

I Viewing optionsfor real-time results

I Global Player options

! Player machine performance data

I Optionsfor runtime reporting

! And more...

All of the above information, and more, can be configured on the Conductor's Optionsdialog box.

Setting Up a Specific Test Session

To prepare the Conductor for a specific test, save information and parameters specific to that test into a
reusable session ID file (.id). You will need to enter the following types of information to set up atest's
session ID file:

I General information about the test such as adescription, the size of the database, the length of the
test, and any notes or comments

I Information about the test script(s) included in the test, including script name,
middleware/protocol type, pacing, whether to include external data, and so on

I Information about the workstationswhere the QALoad Playersreside, including which script is
assigned to each workstation, how many virtual users are assigned to each workstation, the
machine name, and so on

I (Optional) configuration for server monitoring
I (Optional) integration with other Compuware products.

All of the above information can be entered and saved from the Conductor's main window, see Setting Up
aTest Session ID.

Generating Random Number Seeds

Random number seeds are used to inject random delaysin script execution for each load test. The seed (or
value) isautomatically generated by QALoad. The random value used within the end of transaction
function isused to generate the pacing time. The Player uses a system-generated sequence of numbers, so
that each VU (virtual user) will have its own seed value.
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Setting Up a Test Session

You can enter all theinformation necessary for your session ID fileright in the Conductor's main window,
the Test Information Window.

€ Hint: The following procedures guide you through setting up areusable test session ID using the
Conductor's main window, the Test Information window. Follow each step in turn to configure your test, or
revisit this help topic later to make changesto any specific part of the test setup.

Step 1: Enter descriptive information about the test:

On the Test Information tab:

1. (Optional) Type descriptiveinformation about thetest in the Test Description, Client System,
Server System, Database Size, and Comments fields.

2. In the Session Duration field, typeatimelimit to specify the maximum duration for the test to
run. Type O (zero) if you do not want to specify a maximum duration.

' Hint: For details about any field on the Test Information tab, see Test Information.

Step 2: Assign compiled scriptsto the test:

On the Script Assignment tab:

1. Click New to open the Select Script dialog box. The Select Script dialog box liststhe scripts
available for your transaction type. If it doesnot, select your transaction type (middleware
environment) from the Scriptsof Type list.

' Hint: To open the Select Script dialog box from the Script column, click in the Script column to
enable the Browse (...) button. Then, click Browse.

The Select Script dialog box lists a status for each script that indicateswhether the script is
compiled. If it isnot, you must compile the script before attempting to use it in atest.

Select a script from thelist and click Select to return to the Script Assignment tab.
3. Continue selecting scriptsuntil all scriptsyou wish to usein thistest are listed.

4. (Optional) Select ApplicationVantage Mode to enable AV timings. When you make this selection.
you must also perform Sep 5: Set up ApplicationVantage Options.

' Hint: For details about any field on the Script Assignment tab, see Script Assignment.

Step 3: Set test options for each script:

For each assigned script on the Script Assignment tab:

1. IntheTransactionscolumn, typethe number of transactionsthat each virtual user running this
script should run. Once a workstation executesthe number of transactionsthat you specify, script
execution continueswith theline following the End_Transaction command rather than jumping
to the beginning of the transaction loop

2. Clickin the Debug Optionscolumn to enable the Browse button. Click Browse to open the Debug
Optionsdialog box, and then set any optionsfor Debug Trace and Logfile generation. For a
description of the Debug Optionsdialog box, see Debug Options.
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In the Error Handling column, select the option that indicates how the Player running this script
should behave when encountering non-fatal errors: Abort the transaction, Continue the
transaction, or Restart the transaction.

Enter avalue in the Seep Factor column to specify the percentage of any originally recorded delay
to preservein the script (for example, a value of 80 means preserve 80% of the original delay).

In the Service Level Threshold column, type amaximum duration for thisscript. At runtime, the
QALoad Conductor will display aruntime graph comparing the Service Level Threshold with the
actual duration.

In the Pacing column, type avalue, in seconds, for pacing.

Click in the Timing Optionscolumn to enable the Browse button. Then, click Brow se to access
the Timing Optionsdialog box and set optionsrelated to checkpointsand datathinning.

(Optional) Click in the External Data column to enable the Browse button. Then, click Browse to
open the External Data dialog box and associate any necessary external fileswith your selected
script.

' Hint: For details about any field on the Script Assignment tab, see Script Assignment.

Step 4: Set up Player machines:

On any tab:

1.

4.

Select Tools>Manage Player Machines. The Manage Player Machines and Groups dialog box
appears.

Click File>Discover Player Machinesto query your network for QALoad Player workstations. All
workstationswith QALoad Playersinstalled are listed. If Player machines are discovered to have
previousversions of QALoad installed, an error message informsyou which machinesneed to be
updated.

Check the availability of all the Player machines on your network by clicking Verify All, or by
selecting individual machines and clicking Verify. The QALoad Conductor requests each selected
Player machineto ensure it isavailable.

If a Player machineisavailable, system information for that machine appearsin the Details area of
the dialog box. View the Properties dialog box for that Player machine by double-click on the Player
machine listing. If the Player machine isnot available, you receive a message that the Player isnot
responding.

(Optional) Use New to manually add a Player machine, or Delete or Delete All to remove
machines. To save the current machine setup for re-use, create a new configuration file (.cfg).

' Hint: For details about any field on the Machine Configuration tab, see Monitoring Options.

Step 5: (Optional) Set up ApplicationVantage:

El Note: You must have ApplicationVantage installed on the Player machine to activate these fields.
This step isrequired if you selected ApplicationVantage Mode on the Select Script dialog box . Refer to Step 2:
Assign Compiled Scriptsto the Test for more information.

On any tab:

1. Select Tools>Manage Player Machines. The Manage Player Machines and Groups dialog box

appears.

2. Double-click on the Player machinelisting. The Edit Player Machine dialog box appears.

12
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Click the ApplicationVantage Settings tab.
In the NIC ServiceName field, select the Network Interface Card on which you will collect timings.

Click Apply, then click OK.

Step 6: (Optional) Set up Remote Monitor machines:

On the Monitoring Optionstab:

1.

Click the Enable Performance Monitoring at Runtime check box to enable monitoring at test
time.

Create amonitoring task to specify which countersto monitor or apply an existing task and
modify the counters as necessary:

= Createanew monitoring task

= Usean existing task

Step 7: Assign scriptsto Player machines:

On the Machine Assignment tab, the scriptsyou assigned to the test on the Script Assignment tab are
listed in the Script column. Fll in the following columns:

El Note: Use Auto Configure to have QALoad automatically assign scriptsto virtual users.

1.

In the Starting VUs column, type the number of virtual usersto initially launch the script on this
machine when atest begins.

In the VU Increment column, type the number of virtual usersthat should be added, at intervals,
if you want thismachineto add incremental virtual users. You must also fill in the Time Interval
and Ending VUsfields.

In the Time Interval column, type thetime interval at which incremental virtual users should be
added to atest. (For example, to add virtual users every 5 minutes, type 00:05:00). You must also
fill in the VU Increment and Ending VUsfield.

Type the number of virtual usersassigned to run until the end of the test.

In the Machine column for each script, select a Player machine from the drop-down list to assign it
to that script. If no Player machines are available in the drop-down list, click the Manage Player
Machines button to set up a Player.

In the Mode column, select the test mode for each Player machine: thread-based or process-based.

(Optional) Use New, Delete, and Delete All to add or remove scripts from thistest.

Step 8: (Optional - WWW only) Enable expert user:

On the Machine Assignment tab:

1.

Click in the Script column to enable the Browse button. Click Browse to open the Expert User
Optionsdialog box.

Select Enable Expert User timings.
In the Virtual User field, type a virtual user number, if necessary.
Click OK.
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When all scripts have been successfully assigned to Player machines and the test isready to run, Run on
the Machine Assignment tab will become available and you can run atest.

Step 9: Save the test setup you just created as a reusable session ID file:

Save the Test Setup
To save the current test setup to areusable test file called a session ID, click File>Save to name and save it.
Save the Machine Configurations

To save the Player Agent, Server Analysis Agent, Remote Monitoring Agent, Expert User, and
ApplicationVantage integration configurationsto areusable file, called a configuration file (.cfg) see Saving
machine configurations.

Anticipating Error Conditions

You know before beginning aload test that errors are a possibility, but you may not alwayswant them to
stop your progress during testing.

QALoad helpsanticipate error conditionsand determine, before running the test, how Playersreact to non-
fatal errors. By setting one option, you can instruct a Player to continue asif no error was encountered,
stop running immediately, or restart at the beginning of the transaction.

IEl Note: When the Conductor process stops for any reason during a load test, the associated Player processes
automatically terminate.

To set the error handling option, see Script Assignment tab.

Managing Large Amounts of Test Data

Your load test probably includes alarge number of checkpointsand virtual usersin order to adequately test
your system. When your test isrunning and your Conductor iscollecting timing information from your
Player machines, the sheer amount of data can take up more of your resources than you'd like to expend.
Use QALoad's Timing Data Thinning option to thin the amount of timing data being transferred back to
the Conductor during the test so that your test can run longer without stressing your resources.

To thin timing data:

1. With your test session ID file open, click the Script Assignment tab.

2. For each script for which you would like to thin your test data, click the button in the Timing
Optionscolumn.

On the Timing Optionsdialog box, click the Enable Timing Data Thinning check box.

4. IntheThin Every... field, type the number of transactionsto average. The average will be sent to
the Conductor for inclusion in the timing file, rather than every value.

5. Click OK.
6. Saveyour changesto your test session ID file by choosing File>Save from the Conductor menu.

For more details about the Timing Options dialog box, see Timing Options.

Saving Machine Configurations

After configuring the machinesto use for aload test, you can save the machine configuration information
into a configuration file (.cfg) that can bereused in later tests, saving you significant time setting up later
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tests. A configuration file includesinformation about which machineson the network were used as Player
machines. You can save multiple configurations under different names. By default, when first using
QALoad, the Conductor uses a configuration file named Def aul t . cf g. The Conductor saves any changes
to your machine configurationsto this file unless you save your configuration to a new file with a different

name.

You can open or save .cfg files from the Manage Player Machines and Groupsdialog box. The .cfg field
always displaysthe active configuration.

To create a new, empty .cfg file:

1.

I AN

On the Monitoring Optionstab, click Tools>Player Machines. The Manage Player Machines and
Groupsdialog box displays.

Click down arrow on the .cfg field at the bottom of the dialog box.
Choose <New>,
On the Save As dialog box, specify aname for the new file and click Save.

Add the necessary Player and agent machinesusing the fieldsand buttonson the Manage Player
Machines and Groups dialog box. The machines you configure are saved automatically to thefile
you just created.

To rename the current .cfg file:

1.

On the Manage Player Machinesand Groupsdialog box, click the down arrow on the .cfg field at
the bottom of the dialog box.

Choose <Save As>.
On the Save As dialog box, specify aname for the new file and click Save.

Make any necessary changesto the configuration. Your changes are saved automatically to thefile
you just created.

To open a previously created .cfg file:

1.

2.

On the Manage Player Machinesand Groupsdialog box, click the down .cfg field at the bottom
of the dialog box.

Choosethe .cfg fileto open.

El Note: The .cfg file only storesinformation about Player machines. It does not store information specific to a
test, such as script names or settings. Test specific information is saved in the session ID file. A session ID file
for a specific test savesthe name of the .cfg file associated with that test, and opensit automatically when the
session ID file isopened. You can change the .cfg file at any time without being concerned about the session
ID file.

Assigning Scriptsto Player Workstations

Usethe Conductor's Machine Assignment tab to assign scriptsto Player workstations. You can assign
scripts manually or enable QALoad to assign them automatically.

1.

Do one of the following:

= Manual assignment — In the Machine column for the appropriate script, select amachine
from thelist to assign it to that script.
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= Automatic assignment — Type thetotal number of virtual usersto assign to thetest in the
Sarting VUs column, then click the Auto Configure button. QALoad will automatically assign
scriptsto each Player workstation.

2. Click File>Save to save your changesto the current session ID file, or click File>Save Asto save
them to anew session ID file.

Changing the Number of Virtual Users

Change the number of virtual usersassigned to a script on the Machine Assignment tab of the
Conductor's main window.

To change the number of virtual users:

1. Typeanew valuein the Starting VUs column for the selected script.

2. If you have assigned incremental virtual users, changethe valuesin the VU Increment column
and the Ending VUs column to determine how many virtual usersto add at the interval specified
in the Time Interval column.

3. Select File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file.

Changing Test Options

To change test options:

1. Makechangesin the Conductor on the Test Information, Script Assignment, Monitoring Options,
or Machine Assignment tabs.

2. Click File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file.

Setting Delays Between Tests

You can set afixed delay or pause between tests by specifying avaluein the Delay Between Tests field on
the Batch Test dialog box. After each test iscomplete, the Conductor delays for the specified amount of
time before starting the next test.

Validating Scriptsin Conductor

Before running atest, you should run your script in asimpletest to ensure that it runswithout errors. You
can validate UNIX or Win32 scriptsin the Conductor.

Debugging a Script

If you encountered errorswhile validating or testing a script, use QALoad's debugging optionsto monitor
the Player(s) that generated errorswhile they are running or after the test. Three debugging strategies are
described below.
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Watch a Virtual User Execute a Script on a Player Workstation While it is Running

To monitor selected virtual usersat runtime, enable the Debug Trace option before you run your test.

To enable the Debug Trace option:

1.
2.

On the Conductor's Script Assignment tab, highlight the script you want to monitor.

In the Debug Optionscolumn, click the browse (...) button (note that the button may not be
visible until you click in the Debug Options column).

On the Debug Optionsdialog box, in the Debug Trace Virtual User Range area, choose which
virtual users (if any) to monitor. You can choose None or All Virtual Users, or choose Virtual
User(s) and then type the numbersassigned to the virtual usersyou want to monitor. You can
monitor individual virtual usersor ranges of virtual users.

Click OK to save your changes.
From the Conductor'smain menu, click File>Save to save your test session ID.

Run your test asusual. Each virtual user for which you enabled Debug Trace will display messages
on itsassigned Player workstation indicating which commands are being executed.

Log Details from Selected Virtual Users While They are Running (citrix, DB2, ODBC, Oracle, Oracle
Forms Server, SAP, Uniface, Winsock, or WWW only)

You can instruct the Conductor to generate and save details about the script execution of selected virtual
users by enabling Logfile Generation before you run your test.

To enable Logfile Generation:

1.
2.

On the Conductor's Sript Assignment tab, highlight the script you want to monitor.

In the Debug Optionscolumn, click the browse (...) button (note that it might not be visible until
you click it).

On the Debug Optionsdialog box, in the Logfile Generation Virtual User Range area, choose which
virtual users (if any) to monitor. You can choose None or All Virtual Users, or choose Virtual
User(s) and then type the numbersassigned to the virtual usersyou want to monitor. You can
monitor individual virtual usersor ranges of virtual users.

Click OK to save your changes.
From the Conductor'smain menu, click File>Save to save your test session ID.

Run your test asusual. Each virtual user for which you enabled Logfile Generation will create afile
containing information about their performance. After thetest isfinished, the Conductor will
request all log filesfrom the Playersand save them in the directory \ Pr ogr am

Fi | es\ Conpuwar e\ QALoad\ LogFi | es on the workstation where the Conductor isinstalled. Log
filesare named <scriptname>_<middleware>_vu<AbsoluteVirtualUserNumber>.<ext>, where:

I <scripthame> isthe name of the script the virtual user ran
I <middleware> isthe name of your middleware application
I <AbsoluteVirtualUserNumber> isthe identification number assigned to the virtual user

I <.ext>isthefile extension, dependent upon which middleware application you are testing.
File extensionsarelisted in the following table:

| Middleware ‘ File Extension |
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Uniface .cap — A standard log file containing
WwWWw information about all statements executed
during atest.

Citrix .log — A standard log file containing

DB2 information about all statements executed
ODBC during atest.

Oracle

Forms Server

SAP

Winsock

WWWwW

View Automatically Generated Log Fles from Failed Virtual Users (oracle and www only)

A Player that failsto execute a test script automatically generates alog file (with .rip extension) that details
therequeststhat were played back by that Player. You can view a Player's .rip file from the Conductor's
Runtime Window while atest isrunning, or later in QALoad Analyze. At the end of atest, all .rip filesare
sent from the Playersto the\ QALoad\ LogFi | es directory and added to the merged timing file, where you
can view them in Analyze.

To view a .rip file while the test isrunning:

1. Inthe Runtime Window'stree-view, right-click on afailed Player icon.
2. From thecontext menu, choose Display RIP File.

A new tab opensin the Runtime Window displaying details about the script the Player attempted to run,
and which subsequently failed.

To view a .rip file in QALoad Analyze:

At the end of your test, after all test results have been collected, open your resulting timing file in Analyze.
Click on the RIP Files group to see alist of all .rip filesthat were collected during the test.

Managing Players and Groups

Overview of Players and Groups

In Conductor, on the Monitoring Optionstab, use Tools>SManage Players and Groups option to configure
the variousmachinesand agentsthat will participate in aload test. You can configure Player Machines,
Player Groups, and ApplicationVantage settingsinformation from asingle screen.

You should use thisoption to update Player or Agent information whenever a Player or Agent isadded to
thetest network, removed from the test network, or the network address of a Player or Agent has changed.

You can collect Player machinesinto logical groups
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Player Agents

Player machines execute the virtual usersthat perform the transactionsrecorded in your test scripts. If no
Player machines are listed, can retrieve information from Player machineson the local network, or you can
add Player machines manually.

Managing Player Machines

Adding Player Machines

From the Conductor'smain menu, click Tools>SManage Player Machines. The Manage Player Machines
and Groups dialog box displays.

To add a Player Machine:

Click FilesSNew Player Machine. The New Player Machine dialog box displays.
On the Properties tab:
1. IntheMachinefield, type aname for the Player Machine.

2. IntheCommunicationsport field, type the port number the Conductor should useto
communicate (using TCP) with thismachine during atest. The default is 3032.

3. Click Test Connection to check that the machine isactive. The Player or Agent returnsthe
operating system, processor type, and amount of memory on the machine.

4. Select the Player Machine settings.
5. Click Apply to add this player machine to the group or groups selected.
On the Groupstab (Optional):
1. Click Add... The Add Groupsdialog box displays.
2. Select the groupsto which this Player Machine will be added, then click OK.

On the ApplicationVantage Settings tab:

El Note: The fields on thistab are available only if ApplicationVantage isinstalled on the Player Machine and
ApplicationVantage Mode is selected when you choose a script in the Script Assighment tab.
I From the drop-down list in the NIC ServiceName field, select the Network Interface Card (NIC)
that isused by the machine.
Save the Player Machine:

I Click Add Player. The Player Machine appearsin the Manage Playersand Groupsdialog box in
the All Player Machines and Groupstree.

Editing a Player Machine

From the Conductor'smain menu, click ToolsSManage Player Machines. The Manage Player Machines
and Groupsdialog box displays. Use the following procedure to edit Player Machines.

To edit a Player machine:

Double-click an individual Player Machine in the All Player Machines and Groupstree. The Edit Player
Machine dialog box displays.
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On the Properties tab:
1. IntheMachinefield, type aname for the Player Machine.

2. Inthe Communications port field, type the port number the Conductor should useto
communicate (using TCP) with thismachine during atest. The default is 3032.

3. Click Test Connection to check that the machine isactive. The Player or Agent returnsthe
operating system, processor type, and amount of memory on the machine.

4. Select the Player Machine settings.

5. Click Apply to add this player machine to the group or groups you selected.
On the Groupstab (Optional):

1. Click Add... The Add Groupsdialog box displays.

2. Select the groupsto which this Player Machine will be added, then click OK.

On the ApplicationVantage Settingstab:

Note: The fields on thistab are available only if ApplicationVantage isinstalled on the Player Machine and
ApplicationVantage Mode is selected when you choose a script in the Script Assignment tab.
I From the drop-down list in the NIC ServiceName field, select the Network Interface Card (NIC)
that isused by the machine.

Save the Player machine you added:
I Click Apply. The Player Machine isupdated with theinformation you entered.

Retrieving Information on Player Machines

In Conductor, you can retrieve information from Player machines on the local network by doing the
following:

To retrieve information on Player machines:

1. OntheMonitoring Optionstab, click Tools>Manage Player Machines. The Manage Player
Machines and Groups dialog box displays.

2. Click File>Discover Player Machines. QALoad Conductor queriesthe network for available Player
workstations and addsthe resultsunder Player Machinesin the All Player Machines and Groups
tree.

Managing Groups

Adding a Group

Use the following procedure to add a group for Player Machineswhile in Conductor.

To add a group:

1. From Conductor'smain menu, click Tools>SManage Player Machines. The Manage Player
Machines and Groupsdialog box displays.

2. Click File>New Group. The New Group dialog box appears.
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In the Group Name field, type aname for the group.
In the Description field, type a description for the group.
Click Add... The Add Player Machines dialog box displays.

Select a Player machine in the Available Player Machines panel, and click Add. The Player
Machine isadded to the Selected Player Machines panel.

2] Note: You can select more than one machine by holding down the Ctrl key and selecting each Player
Machine to select. Select all the available Player Machines by clicking Add All.

Click OK. The New Group dialog box displays with the selected Player Machines displayed in the
Player Machinesin Group panel.

Click Apply to add the Player Machinesto the new group.

Editing a Group

Use the following procedure to edit a group.

To edit a group:

1.

On Conductor's main menu, select Tools>Manage Player Machines. The Manage Player Machines
and Groupsdialog box displays.

Select agroup in the All Player Machinesand Groupslist tree and click Selected>Edit. The Edit
Group dialog box displays.

Usethefieldsin thisdialog box to change the Group Name or Description.

To add a Player Machineto the group, click Add to display the Add Player Machines dialog box.
Use the procedures for adding a Player Machine.

To remove a Player Machine from the group, select the Player Machine in the Player Machinesin
Group panel, then click Remove.

Click Apply to save your changes, then click OK to return to the Manage Players and Machines
dialog box.

Running a Test

Running a Load Test

After validating a script using one of the methods described in Validating Scripts, it issafe to run aload test
with that script.

To start a load test:

Click the Run button E on the configuration and setup toolbar, or from the Conductor’s Run menu,
choose Start Test. Whileatest isrunning, the Conductor'sInterface changesto provide you with real-time
test options.

El Note: While any window on the desktop is re-sizing or re-positioning, all Windows applications pause. Do
not click and hold on a window caption or border for extended periods during a load test because it delays
message handling and may have an impact on test results.
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While aload test isrunning, the Conductor’stoolbar changes from the Configuration and Setup Toolbar to
the Runtime Toolbar. The Runtime Toolbar buttonslet you control the test and access detailed

information about the test while it isrunning. For more information about what to expect from the
QALoad Conductor whileatest isrunning — including descriptions of the Runtime Toolbar buttons — see
Monitoring a Load Test.

Running a Series of Tests

You can also run a series of tests — a batch test. A batch test comprises multiple session ID files. When you
run abatch test, the session files are executed sequentially until all of them are executed. The Conductor
enablesyou to run multiple batch tests without operator intervention.

Checking Out Virtual User Licenses

If you are licensed to run multiple copies of the Conductor, for example so different work groups have
accessto QALoad, you can check out virtual user licenses before running aload test to ensure that enough
are available for your test run.

If you do not choose to check out your licenses before starting atest, QALoad promptsyou after you start
thetest and attemptsto check out the appropriate number of licenses. We recommend that you check
your licenses out manually before starting so you can be sure you have enough virtual users available
before beginning your test run.

To check out virtual user licenses:

1. From the Conductor menu, select Tools>Licensing. The License Information dialog box appears.

I If you arelicensed for concurrent licensing (multiple Conductors) the Conductor queries your
license server to determine how many licenses are currently available, and returnsthe resultsto
thisdialog box. Go to step 2.

I If you have anode-locked license (asingle Conductor), then most of the optionson thisdialog
box are unavailable, asyou will not need to, or be able to, check out virtual user licenses. All
virtual usersfor which you are licensed are available only to this Conductor. Click Close to
return to your test setup.

2. InthelLicensing Operations area, type how many virtual user licenses you want to check out in the
Number of Licensesfield.

3. Click Check Out. Thelicenses are checked out to your Conductor, and are unavailable to any other
Conductor workstations on the network.

When you are done using your licensed virtual users, check them back in so they are once again available
to other Conductor workstations on your network.

To check in virtual user licenses:

1. From the Conductor menu, choose Tools>Licensing. The License Information dialog box appears.

2. If you havelicenses checked out, the Check in Virtual User License option isautomatically selected
for you.

3. Click Check In. Thelicenses are made available to other Conductor workstations on the network.
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Starting the Conductor From the Command Line
To start the Conductor from the command line, type:
nmpwi n32 <sessionl D file_name> /I /e /a It

=] Note: You must have a complete session file before the test can start. For example, you must specify
either a set number of transactionsor atest duration. A transaction count or atest duration of 0 isnot
valid.

Valid startup parameters are;

/1 Creates alog file showing error messages and test status.
(Optional)

/e Exitsthe Conductor when the test completes.
(Optional)

/a Launches Analyze when the test completes.

(Optional)

/It Executesthe Conductor at a set time or a set date and

(Optional) time. Time can be specified by either 12-hour or 24-hour
format. The following examples of the/t parameter
demonstrate each scenario.

Command Result

/1" 03:30: 00 pnt Sartsthe Conductor at
3:30PM today.

/t06:00: 00 Sartsthe Conductor at
6:00AM today.

/t"12/01/04 03:30: 00 Sartsthe Conductor on
pnt December 1, 2004 at
3:30PM.

/t"12/ 25/ 04 14:00: 00" Sartsthe Conductor on
December 25, 2004 at
2:00PM.

Dialing Up/Down Virtual Users

QALoad'sdial-up/dial-down featurein Conductor allowsyou to dynamically add or reduce virtual usersto
your test at the script or Player level while your test isrunning. Thisenablesyou to adjust your running
test according to test behavior on-the-fly, rather than stopping to re-configure playback criteria.

To usethedial-up/dial-down feature, you must:
I belicensed for at least the number of virtual usersrequested
I configure aramp-up session beforerunning thetest
Notes:
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= If you have not configured a ramp-up session, you will not be allowed to add or suspend virtual
userswhilethetest isrunning. For information about configuring aramp-up session, see
Configuring a ramp-up session.

= Ramp-up isnot supported for amachine assignment entry that isusing a player group.

When your test isrunning, the bottom of the Test Information window turnsinto the dockable Runtime
Control Panel, a portion of which isshown below:

Script Optionz - lottastuff
Error Handling:

IHestart j Riunning
Sleep [X]: Facing [hh:rann: ez mgl; I 3 m
[to0 -] fo0.00.01.000 L g Cancel |

| Test Time: 00:04:57 | Last Update: 00:04:55 | Al virtual users have Synched. 5

If you click on a Player or script icon in thetest'stree-view, the Runtime Control Panel will indicate how
many virtual usersare currently running on the selected Player machine or script. You can change the
number of running virtual users per script or per Player by selecting the appropriate script or Player
machine in the tree-view, and then typing anew number in the Running field (or by using the dial
control).

To dial up or down (add or subtract) virtual usersduring a test:

1. When your test isrunning, click on the script or Player workstation in the Runtime Window's tree-
view for which you want to add or subtract virtual users. The Running column in the top pane
shows how many virtual usersare currently running on that script or Player.

2. In the Runtime Control Panel, typeanew number in the Running field or drag the dial control to
change the number.

3. When you are done, click Apply. The Conductor will release or suspend the specified number of
virtual users.

Your change do not take effect until you click Apply.

Increase/ Decrease Runtime Timing Updates

While atest isrunning, you can change the frequency at which timing updates are sent from the Playersto
the Conductor. Decreasing the update interval will reduce the amount of overhead incurred in large load
testsdueto the communications between the Conductor and large numbers of virtual users.

In Conductor, on the Runtime Control Panel (bottom pane), choose from the following options:

No Updates: Choose thisoption to stop sending timing datawhilethetest isrunning. Data will still be
collected at the end of the test.

Send All: Choose thisoption to send all timing data asit iscompiled.

Periodic Updates: Choose thisoption to specify atimeinterval for sending updates, then typethetime
interval (in seconds) below.

Any change takes effect immediately, and appliesto all scriptsin the test.
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Removing a Script from a Test

To remove a script from a test:

1. In the Conductor, on the Test Information tab, click on the selection box to the left of the script
nameto highlight the row.

2. Click Deleteto removethe script from the test.

3. Select File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file.

Removing Used Datapool Records After a Test

You can remove used datapool records after atest by setting the Srip Datapool function before you run the
test. Use thisfunction when running atest where you have datain the external datapool which can only
be used once by onevirtual user at atime. (For example, when running transactionsthat have unique data
constraints.) When activated, the Srip Datapool function will mark each piece of datain the datapool that
isused during your test. When thetest isover, the Srip Datapool function promptsyou to removethe
identified used data from the datapool. If you run thetest again, only new data will be used for your
subsequent test.

To use the Strip Datapool function:

1. With thecurrent test'ssession ID file open in the Conductor, select the Script Assignment tab.
2. Click the External Data button. The External Data dialog box appears.

3. In the Central Datapool area, select the Strip check box. Click OK.
4

At the end of your test, a Srip Datapools prompt will appear asking if you wish to go to the Srip
Datapools screen. Click Yes.

o

The Srip Data Pool dialog box appears. Click the Strip button.

When you are finished, click Close.

Stopping a Load Test
A load test iscomplete when all virtual usersexit. A virtual user automatically exitswhen one of the
following occurs:

I Ascript encountersan EXIT command.

I Ascript completesitstransaction loop.

To stop aload test, click the Exit button.

Adding Post-test Comments

If you selected the Display Post Test Comments option on the General tab of the Optionsdialog box
when you configured the Conductor, the Post Test Commentswindow openswhen you click the Quit
button. Type any comments, which are saved to the test’s Summary Report, which can be viewed in
QALoad Analyze.
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Running a Series of Tests (Batch)

Running a Batch Test

By setting the appropriate optionsin the Conductor, you can elect to run a series of tests as a batch, rather
than oneat atime. A batch test comprises multiple session ID filesthat are executed sequentially.

You can create a batch test by adding a number of session ID filesto a batch file. Before you can add a
session ID to a batch file, the following conditions must be true:

! Thesession must include a defined number of transactions. Sessions of unlimited transactions
cannot be used in a batch test.

I All scriptsto beincluded must exist before starting the batch test. Thismeansthe .c files referenced
in the selected session ID filesmust be present in the scriptsdirectory.

To run a batch test:

1. Select Run>Batch Test.
2. Addtherequired session ID filesto the Batch List using Add or Load.
3. Click Start to initiate the batch.

The Conductor then executes each of the session ID filesin sequence.

Adding Sessionsto a Batch Test

Before a session isadded, the following conditions must be true:

I Thesession must include a defined number of transactions. Sessions of unlimited transactions
cannot be used in a batch test.

I All scriptsmust exist prior to starting the batch test. Thismeansthat the filesreferenced in the
selected session ID files are present in the script directory.

A session can be placed in a batch multipletimes. Thisfeature might be used to re-run atest or to perform
housekeeping chores, such aslogging usersin or out of ahost or database.

To add a session:

1. Fom the Run menu, choose Batch Test.
2. In the Session Files(.id) box, highlight the session you want to add, and click the Add button.

If you want to run a previously defined batch, click the Load button to navigate to the directory
where the batch file (.run) resides. Select it, and click OK.

The session isadded to the Batch List on theright side of the dialog box.

Removing a Session from a Batch Test
1. Select Run>Batch Test.

2. Highlight the session to remove in the Batch List and click Remove.
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Terminating a Batch Test

Sop abatch of teststhe same way you would stop a single session test, by clicking the Abort or Exit

toolbar buttons. When the Conductor process stops for any reason during a load test, the associated
Player processes automatically terminate.

Monitoring a Running Test

Monitoring CPU Usage

To help you monitor the impact of running aload test on a server, QALoad can collect data from selected
Players about CPU usage during aload test. The statistics collected during the test are merged into the test's
timing file so you can view them in Analyze after the test.

When the Top Process Monitoring counter isenabled for a Server Analysis Agent machine, information is
collected periodically during the load test about which processes are using the most CPU. Counter datais
written to your test'stiming file, which you can open in Analyze after your test.

Note: During a load test, if the CPU idle time of your machine falls below 25%, check the individual
processes on your machine. If the Players and virtual users are utilizing most of the active CPU time, you
should use additional Player machines and fewer virtual users per Player to conduct your load test.

To collect Top Processes data:

1. IntheMonitoring Optionstab, click the Set up monitoring link.

2. Select Set up anew monitoring task, and click OK. The New Monitoring Task Wizard opens.
3. In the Define Monitor dialog box, select Server Analysis Agentsin the Monitor Type field.
4

In the Choose Countersdialog box, click the Counterstab, then select Top Process Monitoring
and add it to the Selected Items pane.

5. Completethe stepsin the wizard to save the monitoring task.

When your test isfinished, the Top Processes data collected will beincluded in your test'stiming file which
you can open in QALoad Analyze.

Watching a Script Execute

Use the Debug window in the Details view of the runtime Conductor to view the executing script. Note
that it ispossible that you will not see the execution of every statement, in order to minimize network
traffic between the Conductor and the Players. The QALOAD.INI file’'s debug messages-per-sec parameter
determines how frequently the Player sendsits script debug statusto the Conductor. At its default value of
one message per second, the Player can execute several statementswithout sending a debug message to the
Conductor.

To open the Debug window, select a workstation in the global control window and click the Debug

toolbar button.

El Note: The Conductor highlights the script line that it is currently executing.
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Viewing Datapool Usage

Highlight a script in the global control window and click the Datapool button to open the Datapool
window. Asthe script executes Get_Data commands, the Datapool window reflectsthe current datapool
record being used by the script.

Graphing Checkpoints

Usethe Graphsview of the runtime Conductor to create real-time graphs of checkpoint response times
during script execution. Smilar graphs are also available for post-test analysisin QALoad Analyze.

Selecting Checkpointsto Graph

Before you can review checkpoint response timesin graph form, you must select the checkpoint counters
to include. Checkpointsare listed in the tree view on the left side of the Graphsview of theruntime
Conductor, as shown in the example below. Both automatic and user-defined checkpointsappear in the
Response Times folder of each running script.

-2 Global Counters

E|_| Script Counters

-5 050240010

----- A Running YU s
E|_| Reszponze Times
E|_| Auta Checkpaointz
El_; Tranzaction Duration

' ----- A Responze Time
- Sleep Time

- Line 103: Welcome to QAWEBSERY
- Reszponze Time

- Line 119: QaLoad Wiwhe' Capture Examples

- Line 138: "Standard HT kL E=ample"

- Line 148: QaLoad Wi Capture Examples

- Line 158: The page cannot be found

[ 4mm Al [ A - '

add Graph... |

Add Plak Ta #

Creating a Graph of Checkpoint Response Times

To choose a checkpoint that should appear in agraph, highlight the checkpoint name, right-click and
choose either Add Graph to create anew graph or Add Plot To to add a data plot to an existing graph.

If you choose the Add Graph option, the Add Graph dialog box appears. Select the optionsfor how the
graph should appear and click OK.

To better identify problem checkpoints, you can set thresholds on plotsor graphsthat indicate the number
of timesthe datarecord for that checkpoint has gone above or below the number you set. Thresholds can
be set from the Advanced tab of the Add Graph dialog box or by right-clicking on an existing graph and
choosing Thresholds.

Highlighting Individual Plots

If you create several plotson asingle graph, it may become difficult to see individual plots. To increase a
plot'svisibility, click on a plot in the graph or a plot'snumber in the graph'slegend. When highlighted,
the plot appearsthicker and darker on the graph.

28



Conductor

Saving Checkpoint Graphsto a Session ID

Checkpoint graphsthat are created in the Conductor are automatically saved to the current session ID file.
To remove all graphsyou added, click Graph>Restore Default Graph Layout.

Graphing Counter Data

Usethe Graphsview of the runtime Conductor to create real-time graphs of counter data during script
execution. Smilar graphs are also available for post-test analysisin QALoad Analyze.

Selecting Countersto Graph

All counter datathat isavailable for graphing islocated in the tree view on the left side of the of the
Graphsview Data window, as shown below.

=3 Global Counters
e Running YU %
----- e Total Running YU
b pe Errors
=) Script Counters
=8 ) 0502480025zimplecaptune
----- e Running Wiz
- Reszponze Times
- Transactions
- WAt Tralfic
) Wit Request Attempts
) Wi Zee Successful
S WA e Redirection
) i dww Client Eror
=) Player Maching Health
=03 diw12030d1
----- Joo % Processor
----- oo Memony Uzed
Digk Space
: Digk Tirme
i A % Paging File

- - - - -

3
o

Scripts of any middleware type collect the following default counter data, which isavailablein the
Conductor for real-time graphing:

! Global counters: Running VU%, total running VUs, and errors

I Script counters: Running VUs, response times, and transactions

! Player machine health: % processor, % memory used, % disk space, %disk time, % paging file
Additional middleware-based graphs are also generated by default and vary by middleware. For example,
for the WWW middleware, several performance-based counters are automatically collected and available

for graphing, including server responses and WWW traffic. You can monitor thisdatato determinethe
optimum rate of performance of the application that isrunning.

Graphing Counter Statistics

To choose a counter that should appear in a graph, highlight the checkpoint counter name or group of
counters (folder), right-click and choose either Add Graph to create a new graph or Add Plot To to add a
data plot to an existing graph.
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If you choosethe Add Graph option, the Add Graph dialog box appears. Select the optionsfor how the
graph should appear and click OK.

To better identify problemsin thetest, you can set thresholdson plotsor graphsthat indicate the number
of timesthe datarecord for that counter has gone above or below the number you set. Thresholds can be
set from the Advanced tab of the Add Graph dialog box or by right-clicking on an existing graph and
choosing Thresholds.

Highlighting Individual Plots

If you create several plotson asingle graph, it may become difficult to see individual plots. To increase a
plot'svisibility, click on a plot in the graph or a plot'snumber in the graph'slegend. When highlighted,
the plot appearsthicker and darker on the graph.

Saving Counter Data Graphsto a Session ID

Counter data graphsthat are created in the Conductor are automatically saved to the current session 1D
file. To remove all graphsyou added, click Graph>Restore Default Graph Layout.

Recording and Playing a Test

Recording and Replay Overview

Asaload test isrunning, the Conductor records each event in a .REC file. After the load test completes,
you can open the .REC fileto replay the load test and evaluate important eventsthat occurred, such asa
sudden increase in processor usage.

When you replay the load test, the playback looksidentical to the actual load test, with the exception of
the playback toolbar, which appearsat the top of the screen. When you open the .REC replay filein the
Conductor, you can replay, fast-forward, double fast-forward, or pause.

El Notes: The replay feature provides a visual re-enactment of the load test. It does not perform the actual
test or connect to any servers.

You can only play a .REC file created in the same version asthe QALoad Conductor on which it will play. For
example, a .REC file created in QALoad 5.05 can only be played using a QALoad Conductor from the 5.05
release.

Recording a Test

Load tests can berecorded by selecting the Record Load Test option from the Conductor. When this
option isactivated and the load test begins, a prompt appears for you to specify afile name for the
recording. When the load test iscompleted, you can replay the test.

To set the Conductor to record a load test:

1. OntheTest Information tab of the Conductor's main window, select the Enable Test Recording
check box.

2. Sart theload test. The Record dialog box appears.
3. Typeaname for the record file. Click OK.
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Replaying a Test

If you set the Conductor to record load tests, you can play them back after the test completes. Replaying a
recorded load test does not perform the actual load test. A replay provides a visual re-enactment of the
eventsthat took place during the load test.

To replay arecorded load test:

1. From the Conductor'sRun menu, choose Test Recording>Replay a Load Test. The Open Record
File dialog box appears.

2. Browse for therecordingfile(fi |l enane. rec)that you saved when the load test started. Click Open.

3. Thetest will play back in aviewer that contains a playback toolbar. Use the toolbar buttons
described in thefollowing table to control the playback.

O P —

Restartsthe test replay from the
beginning

Replaysthe test at normal speed

Replaysthe test twice as fast as
normal

Iil;l_

Replaysthe test four times asfast as
normal

k2

Pausesthereplay at the current
snapshot

Ii

Fﬂ Exitstest replay and opensthe
_ Conductor test setup window

IEl Note: Test control features such as dial-up/dial-down do not work during test replay, but the effects from
these features can be observed in the replay. Also, virtual user error details on the Virtual User Info window are
not available during replay. Detailed error information is available in the timing file and can be viewed with
Analyze.

Expert User

Overview of Expert User

Expert User provides an easy, logical guide for drilling down to the root performance problemsfor
applications. It enablesyou to break web pages down into their individual components, providing more
detailed response time data. Response time for each component isbroken into network sand server time.

More detailed information helpstroubleshoot application performance problems. The ability to seetiming
fileson acomponent level can spotlight where the majority of time isbeing spent. A breakdown of
network and server times per component can identify areas for improvement in either the network or
server hardware or configuration, or in application performance.
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The main functionality is provided by a special virtual user (VU). When you enable the Expert User, this
VU collects more detailed information about requeststhat are made while the script isrunning. Every
main request and subrequest logsthe amount of server and network time used. This helps diagnose why
page loads may be taking longer than expected. For example, a particular subrequest, such as css, gif, html,
and so forth, may betaking moretimeto download from the server than other requests. Expert User data
can show you this. It also can help you determine whether the problem isanetwork or a server problem.

You enable Expert User from the Conductor, either before or during aload test. Expert User usesthe
existing custom counter support so Conductor can graph the custom counter information.

Oncetheload test iscomplete, you can view the datain Analyze. The Analyze Workspace includes an
Expert User tab, from which you can access detail reportsand graphson server and network data. The pre-
defined reportsinclude an Expert User report.

Note: Currently, Expert User capability is provided only for the WWW middleware.

Enabling Expert User

You can enable or disable the Expert User for each load test on a script, either before or during the load
test.

To enable Expert User before the load test begins:

1. In Conductor, click the Machine Assignment tab.

2. Clickin theMiddleware column to enable the Browse (...) button. Then, click Browse. The Expert
User Optionsdialog box displays.

Click Enable Expert User timings.
4. Typethe Virtual User (VU) number to represent the Expert User. The default VU number is zero (0).
5. Click OK.

To enable Expert User during the load test:

1. Select the script and any optionsfor the test.

2. From the Machine Assignment tab, and click the Run button, or click Run>Start Test. The Test
beginsand the Test menusdisplay.

3. Click Test Options>Expert User Options. The Update Expert User Options dialog box displays
listing all the scriptsthat support Expert User counters.

4. Click the scriptsin which you want to enable Expert User, then click OK.

Analyzing Load Test Data

Analyzing Load Test Data

By default, load test timing datais sent from the Conductor to Analyze at the end of aload test. Any
appropriate server monitoring dataisalso sent to Analyze and merged into your timing file (.tim).

You can set an option in the Conductor to automatically launch Analyze at the end of aload test (details),
or you can open Analyze manually from the Conductor toolbar or your QALoad program group.

32



Conductor

Creating a Timing Fle (.tim)

Once all workstations stop executing, click the Quit toolbar button @l to completethetest and
automatically create the timing file (.tim).

Viewing Test Statistics

Compute test statistics by choosing Launch Analyze from the Conductor’s Tools menu or by clicking on

T
the Analyze “ftoolbar button.

Integration and Server Monitoring

Server and Performance Monitoring

QALoad integrates several mechanisms for merging load test response time data with server utilization data
and performance metrics. Select the method that best suitsyour needs, or for which you are licensed (if
applicable). Most methods produce datathat isincluded in your load test timing results and processed in
QALoad Analyze. The only exception is Application Vantage. Data captured from ApplicationVantage can
be opened in Application Vantage, but not in QALoad.

This section briefly describes each method, and provideslinksto more detailed information about setting
up atest that includesthe appropriate method.

I Remote Monitoring — allowsyou to monitor server utilization statistics from aremote machine
without installing any software on the remote machine.

I Server Analysis Agents— must beinstalled on each applicable machine.

I ServerVantage — integrates with your existing ServerVantage installation. You must be licensed for
and haveinstalled and configured the appropriate product in order to integrate with QALoad .

I ApplicationVantage — collectstest datathat you can open in Application Vantage.

Integration and Monitoring Requirements

Integration Requirements
ApplicationVantage
I QALoad 5.5.1 supportsintegration with ApplicationVantage 9.9 and 10.0.
I Integration with ApplicationVantageis supported on the Windows platform only.
ServerVantage
QALoad 5.5.1 supportsintegration with ServerVantage 9.9 and 10.0.

Monitoring Requirements

In addition to the integration requirements, your system may need to meet specific requirementsto
support remote monitoring.

Server Analysis Agent Requirements

TCP/IP communications.
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The Server Analysis Agent must be installed on the same Workstation/Server asthe QALoad Player and
therefore sharesthe same system requirements. However, Compuware recommendsthat you do not run
both the Server Analysis Agent and QALoad Player simultaneously on the same workstation, to make load
test management easier.

MM Requirements

SAP, WebLogic, WebShere, and WebShere MQ monitoring all require Java Virtual Machine (VM)
installed on the Conductor machine.

I For WebLogic monitoring version 7 and earlier versions, use WM 1.3. For WebLogic version 8, you
must use VM 1.4 or later. You may also use the WM that isdistributed with the WebLogic
Application Server.

I For WebSphere monitoring, use the VM provided with the WebShere client or server.
I For WebSphere MQ monitoring, you must use ¥M 1.4 or later.
I For SAP monitoring, you must use WM 1.4 or later.

Hle Installation Requirements

SAP, WebLogic, WebSphere, and WebSphere MQ monitoring require the following filesinstalled on the
Conductor machine.
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I For SAP monitoring, the SAP files listed below must be placed on the Conductor machine:

o librfc32.dll
0 sapjco.jar
0 sapjcorfc

To obtain thesefiles, install the SAP Java Connector package (JCo) on the Conductor machine. The
JCo package is available from SAP. Add the location of thefiles, to the Path System Variable of the
Conductor machine. For moreinformation, refer to the Requirements for SAP Remote Monitoring
topicin the ServerVantage Reconfigure Agent Online Help.

I For WebLogic monitoring, the weblogic.jar file must be placed in the Conductor machine. Copy
thejar file from thelib directory of the WebLogic application server to a separate directory in the
Conductor machine. If you are monitoring WebLogic version 8.1, copy the webservices jar file to
the same directory. For more information, refer to Requirements for WebLogic Remote Monitoring in
the ServerVantage Reconfigure Agent Online Help.

I For WebSphere monitoring, the WebShere client filesmust be installed on the Conductor
machine. Installing the WebSphere Application Server Admin Server software on the Conductor
machine providesthe necessary client files. Note the directory path of the
WebSphere\AppServer\Java files. For more information, refer to Requirements for WebSphere Remote
Monitoring in the ServerVantage Reconfigure Agent Online Help.

I For WebSphere MQ monitoring, the WebShere client fileslisted below must be placed in a
directory in the Conductor machine.

0 com.ibm.mgq.jar
0 com.ibm.mgq.pcf.jar
0 connector.jar

Thefilesmay be obtained from theinstallation of the WebSphere Application Server Admin Server
software on the Conductor machine. If the installation doesnot include the com.ibm.mgq.pcf.jar file,
obtain thefile from the IBM Support Pac M 0B. See "http://www-
l.ibm.com/support/docview.wss?rs=171& uid=swg24000668&loc=en_U X cs=utf-8&lang=en".



Conductor

For more information, refer to Configuring WebSphere MQ for Remote Monitoringin the
ServerVantage Reconfigure Agent Online Help.

I For WMI monitoring, WMI security must be enabled on the monitored server machine and the
WMI service must be started. For more information, refer to Configuring WMI for Remote Monitoring in
the ServerVantage Reconfigure Agent Online Help.

! For Cold Fusion monitoring, Performance Monitoring must be enabled from the Cold Fusion
Administrator Page — Debugging Settings of the monitored server machine. Cold Fusion isavailable
under Windows Registry monitoring.

Host Verification for QALoad Monitoring

I Ensure host accessibility. Add an entry for the monitored machine to the system hosts file of the
Conductor machine. Consult the network administrator for more information.

I Test host availability. Type the following command at the Run command: ping <noni t or ed machi ne
name>.

Remote Monitoring

Overview of Remote Monitoring

Remote Monitoring enables you to extract data from Windows Registry, SAP, SNMP, WebLogic,
WebSphere, WebSphere MQ, and WMI counterson the serversunder stresswithout installing any software
on the servers.

Note: Select counters for monitor typesin the application.
To use Remote Monitoring:

! You must have login accessto the machines you want to monitor

I You must select the serversand countersto monitor on the machinesyou identify using the
monitoring optionson Conductor's Monitoring Optionstab.

I To collect SNMP counters, SNMP must be enabled on the Remote Monitor machine. Refer to your
operating system help for information about enabling SNMP.

I To collect Windows registry counters, you must have avalid sign-on for the serversunder test.

I Forrequirementsfor SAP, WebLogic, WebSphere, WebSphere MQ, and WMI, see Integration and
Monitoring Requirements.

QALoad usesthe default ports 7790 and 7788 when it communicateswith the ServerVantage agent and
client. You can override the default portsif your ServerVantage installation requiresit.

While your test isrunning, QALoad collectsthe appropriate counter data and writesit to your timing file
where you can view it in Analyze after the test. What counters are available?

You can simplify the configuration process by creating or applying pre-defined monitoring templates. A
monitoring templateisapredefined group of counters not associated with a specific machine.

To set up Remote Monitoring, see Setting up a Test Session.

About Counters
Using Counters and Counter Instances

You use countersand, in some cases, specific instances of counterswhen you monitor servers.

Counters
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Countersarethe numeric data valuesthat are collected when monitoring servers. For Windows, a large
number of performance counters are provided by the operating system registry and Windows server
applications. Each resource representsitemssuch asindividual processes, sections of shared memory, or
physical devices.

Countersexist for components such as processor, memory, processes, hard disk, and cache, with a set of
countersthat measure statistical information. Registry counters can monitor external components of the
environment such as databases, applications, and printers.

Many of the countersthat are collected are pointsin time data values, such as Process - Thread Count.
Some are cumulative, such as Server - Errors Logon. Some are averages, such as Job Object Details - Page
Faults/ Sec.

In addition to the numeric value counters, a set of extended data countersis provided for a number of key
performance indicators. These extended data counters can provideintelligent data pointsthat have
associated textual data for the numeric value. For example, the extended CPU usage counter'sintelligent
datapoint showsthe top 10 processes consuming CPU at that time.

QALoad's Remote Monitor Agents can monitor the following counter types:
Windows Win2K Registry Counters

Windows NT Registry Counters

SAP Counters

SNMP Counters

WebLogic Counters

WebShere Counters

WebSphere MQ Counters

WMI Counters

Instances

When you select a counter from the Available Itemslist in the Choose Counterswindow, the available
instances, or occurrences for that counter appear.

Counterscan have none or several instances. For example, if a system has multiple processors, then the
counter has multipleinstances as well. For counters with multiple instances, alist of the available instances
for that counter ispresented. Many countershave a _Total instance, which isan aggregate of the
individual instances.

For the processor counter object, instances are numbered beginning with 0, on asingle processor machine
has an instance of _Total and one for 0. If you had a dual-processor machine, you would see instances of
_Total, 0, and 1. Other instances are based on what iscurrently running on the server, and the instance list
displaysthese for each processname or service name that is active.

Some instances are instantaneous, and represent the most recent value for the resource, e.g., Processes,
which isthe number of processesin the computer at the time of data collection. Others are average values
between the last two measurements.

Windows NT Registry Counters

Windows NT Registry Server Counters

QALoad supportsthe following MSWindows NT Server counter categories:

Counter Category Description

Active Server Pages This object type handlesthe Active Server Pages device on your
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system.
Browser This object type displays Browser Satistics.
Cache The Cache object type manages memory for rapid accessto files. Files

on Windows NT are cached in main memory in units of pages. Main
memory not being used in the working sets of processesis available to
the Cache for this purpose. The Cache preservesfile pagesin memory
for aslong as possible to permit accessto the datathrough the file
system without accessing the disk.

Context Index

This object type handlesthe Content Index.

Context Index Filter

This object type handlesthe Content Index Flter.

ICMP

The ICMP object type includesthe countersthat describe the ratesthat
ICMP Messages are received and sent by a certain entity using the
ICMP protocol. It also describes various error countsfor the ICMP
protocol.

This object type includesthose countersthat describe the ratesthat IP
datagrams are received and sent by a certain computer using the IP
protocol. It also describes various error countsfor the IP protocol.

LogicalDisk

A LogicalDisk object type isa partition on a hard or fixed disk drive
and assigned a drive letter, such as C. Disks can be partitioned into
distinct sectionswhere they can store file, program, and page data. The
disk isread to retrieve these items and written to record changesto
them.

Memory

The Memory object type includesthose countersthat describe the
behavior of both real and virtual memory on the computer. Real
memory isallocated in units of pages. Virtual memory can exceed real
memory in size, causing page traffic asvirtual pages are moved
between disk and real memory.

Network Interface

The Network Interface Object Type includesthose countersthat
describe the ratesthat bytes and packets are received and sent over a
Network TCP/IP connection. It also describes various error counts for
the same connection.

Objects

The Objects object type is a meta-object that containsinformation
about the objectsin existence on the computer. Thisinformation can
be used to detect the unnecessary consumption of computer resources.
Each object requires memory to store basic information about the
object.

Paging File

This object displaysinformation about the system's Page File(s).

PhysicalDisk

A PhysicalDisk object type isahard or fixed disk drive. It contains 1 or
more logical partitions. Disks are used to store file, program, and
paging data. The disk isread to retrieve these items and written to
record changesto them.

Process

The Process object typeiscreated when a program isrun. All the
threadsin a process share the same address space and have access to
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the same data.

Process Address Sace

Process Address Space object type displays details about the virtual
memory usage and allocation of the selected process.

Processor

The Processor object type includes asinstances all processors on the
computer. A processor isthe part in the computer that performs
arithmetic and logical computations, and initiates operationson
peripherals. It executes (such asruns) programson the computer.

Redirector

The Redirector isthe object that manages network connectionsto
other computersthat originate from your own computer.

Server

The Server object typeisthe processthat interfaces the services from
thelocal computer to the network services.

Server Work Queues

The Server Work Queues object type handles explain text performance
data.

SMTP Server This object type handlesthe counters specific to the SMTP Server.

System This object type includesthose countersthat apply to all processorson
the computer collectively. These countersrepresent the activity of all
processors on the computer.

TCP The TCP object typeincludesthe countersthat describe theratesthat
TCP Segments are received and sent by a certain entity using the TCP
protocol. In addition, it describesthe number of TCP connectionsin
each possible TCP connection state.

Telephony This object type handlesthe Telephony System.

Thread The Thread object type isthe basic object that executesinstructionsin
aprocessor. Every running process has at least one thread.

UDP The UDP object typeincludesthe countersthat describe the ratesthat

UDP datagrams are received and sent by a certain entity using the UDP
protocol. It also describes various error countsfor the UDP protocol.

Active Server Pages Counters

QALoad supportsthe Active Server Pages category for Windows NT. This object type handlesthese registry
counters:

Debugging Requests Requests Rejected

Errors During Script Runtime Requests Succeeded
Errors From ASP Preprocessor Requests Timed Out
Errors From Script Compilers Requests Total

Errors/Sec Script Engines Cached

Memory Allocated Session Duration
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Request BytesIn Total
Request Bytes Out Total
Request Execution Time
Request Wait Time
Requests/ Sec

Requests Disconnected
Requests Executing
Requests Failed Total
Requests Not Authorized
Requests Not Found

Requests Queued

Conductor

Sessions Current
Sessions Timed Out
Sessions Total

Template Cache Hit Rate
Template Notifications
Templates Cached
Transactions/Sec
Transactions Aborted
Transactions Committed
Transactions Pending

Transactions Total

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Browser Counters

QALoad supportsthe Browser category for Windows NT. This object type handlesthese registry counters:

Announcements Domain/sec
Announcements Server/sec
Announcements Total/sec

Duplicate Master Announcements

Election Packets/sec

Enumerations Domain/sec

Enumerations Other/sec
Enumerations Server/sec
Enumerations Total/sec

Illegal Datagrams/sec

Mailslot Allocations Failed

Mailslot Opens Failed/sec

Mailslot Receives Failed

Mailslot Writes/sec

Mailslot Writes Failed

Missed Mailslot Datagrams

Missed Server Announcements

Missed Server List Requests

Server Announce Allocations Failed/sec

Server List Requests/sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Cache Counters
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QALoad supportsthe Cache category for Windows NT. This object type handlesthese registry counters:

Async Copy Reads/sec
Async Data Maps/sec
Async Fast Reads/sec
Async MDL Reads/sec
Async Pin Reads/sec
Copy Read Hits %
Copy Reads/sec

Data FHush Pages/sec
Data Hushes/sec
Data Map Hits %
Data Map Pins/sec

Data Maps/sec

Fast Reads/sec

Lazy Write Hushes/sec
Lazy Write Pages/sec
MDL Read Hits %
MDL Reads/sec

Pin Read Hits %

Pin Reads/sec

Read Aheads/sec
Sync Copy Reads/sec
Sync Data Maps/sec
Sync Fast Reads/sec

Sync MDL Reads/sec

Fast Read Not Possibles/sec Sync Pin Reads/sec

Fast Read Resource Misses/ sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Content Index Filter Counters

QALoad supportsthe Content Index Filter category for Windows NT. Thisobject type handlesthese
registry counters:

Binding time (msec) Total filter speed (MBytes/hr)

Filter speed (MBytes/hr)

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Content Index Counters

QALoad supportsthe Content Index category for Windows NT. This object type handlesthese registry
counters:

# documentsfiltered

Filesto be filtered
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Index size (MBytes)
Merge progress

Persistent indexes
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Unique keys

Wordlists

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

ICMP Counters

QALoad supportsthe ICMP category for Windows NT. This object type handlesthese registry counters:

M essages/ sec

M essages Outbound Errors
M essages Received/sec

M essages Received Errors

M essages Sent/sec

Received Address M ask
Received Address Mask Reply
Received Dest. Unreachable
Received Echo/sec

Received Echo Reply/sec
Received Parameter Problem
Received Redirect/sec
Received Source Quench

Received Time Exceeded

Received Timestamp/sec
Received Timestamp Reply/sec
Sent Address Mask

Sent Address Mask Reply

Sent Destination Unreachable
Sent Echo/sec

Sent Echo Reply/sec

Sent Parameter Problem

Sent Redirect/sec

Sent Source Quench

Sent Time Exceeded

Sent Timestamp/sec

Sent Timestamp Reply/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IP Counters

QALoad supportsthe IP category for Windows NT. This object type handlesthese registry counters:

Datagrams/sec

Datagrams Forwarded/sec

Datagrams Outbound Discarded

Datagrams Received Unknown Protocol
Datagrams Sent/sec

Fragment Re-assembly Failures
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Datagrams Outbound No Route
Datagrams Received/sec
Datagrams Received Address Errors
Datagrams Received Delivered/sec
Datagrams Received Discarded

Datagrams Received Header Errors

Fragmentation Failures
Fragmented Datagrams/sec
Fragments Created/sec
Fragments Re-assembled/sec

Fragments Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

LogicalDisk Counters

QALoad supportsthe LogicalDisk category for Windows NT. This object type handlesthese registry

counters:

% Disk Read Time

% Disk Time

% Disk Write Time

% Free Space

Avg. Disk Bytes/Read

Avg. Disk Bytes/Transfer
Avg. Disk Bytes/Write

Avg. Disk Queue Length

Avg. Disk Read Queue Length
Avg. Disk sec/Read

Avg. Disk sec/Transfer

Avg. Disk sec/Write

Avg. Disk Write Queue Length
Current Disk Queue Length
Disk Bytes/sec

Disk Read Bytes/sec

Disk Reads/sec

Disk Transfers/sec

Disk Write Bytes/sec

Disk Writes/sec

Free Megabytes

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Memory Counters

QALoad supportsthe Memory category for Windows NT. This object type handlesthese registry counters:

% Committed BytesIn Use

Available Bytes
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Cache Bytes

Cache Bytes Peak
Cache Faults/sec
Commit Limit
Committed Bytes
Demand Zero Faults/sec
Free System Page Table Entries
Page Faults/sec

Page Reads/sec

Page Writes/sec
Pages/sec

Pages Input/sec

Conductor

Pool Nonpaged Bytes

Pool Paged Allocs

Pool Paged Bytes

Pool Paged Resident Bytes
System Cache Resident Bytes
System Code Resident Bytes
System Code Total Bytes
System Driver Resident Bytes
System Driver Total Bytes
Transition Faults/sec

Write Copies/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Network Interface Counters

QALoad supportsthe Network Interface category for Windows NT. This object type handlesthese registry

counters:

Bytes Received/sec

Bytes Sent/sec

Bytes Total/sec

Current Bandwidth

Output Queue Length
Packets/sec

Packets Outbound Discarded
Packets Outbound Errors

Packets Received/sec

Packets Received Discarded
Packets Received Errors

Packets Received Non-Unicast/sec
Packets Received Unicast/sec
Packets Received Unknown
Packets Sent/sec

Packets Sent Non-Unicast/sec

Packets Sent Unicast/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Object Counters
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QALoad supportsthe Objects category for Windows NT. This object type handlesthese registry counters:

Events Sections
Mutexes Semaphores
Processes Threads

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Paging File Counters

QALoad supportsthe Paging File category for Windows NT. This object type handlesthese registry
counters:

% Usage % Usage Peak

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Physical Disk Counters

QALoad supportsthe Physical Disk category for Windows NT. Thisobject type handlesthese registry
counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
Avg. Disk Bytes/Read Disk Bytes/sec

Avg. Disk Bytes/Transfer Disk Read Bytes/sec

Avg. Disk Bytes/Write Disk Reads/sec

Avg. Disk Queue Length Disk Transfers/sec

Avg. Disk Read Queue Length Disk Write Bytes/sec

Avg. Disk sec/Read Disk Writes/sec

Avg. Disk sec/Transfer

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Process Address Space Counters
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QALoad supportsthe Process Address category for Windows NT. This object type handlesthese registry

counters:

Bytes Free

Bytes Image Free

Bytes Image Reserved

Bytes Reserved

ID Process

Image Sace Exec Read/Write
Image Sace Exec Read Only
Image Space Exec Write Copy
Image Sace Executable

Image Space No Access

Image Sace Read/Write

Image Sace Read Only

Image Space Write Copy
Mapped Space Exec Read/Write
Mapped Space Exec Read Only
Mapped Space Exec Write Copy
Mapped Space Executable
Mapped Space No Access

Mapped Space Read/Write

Mapped Space Read Only

Mapped Space Write Copy
Reserved Space Exec Read/Write
Reserved Space Exec Read Only
Reserved Space Exec Write Copy
Reserved Space Executable
Reserved Space No Access

Reserved Space Read/Write
Reserved Sace Read Only
Reserved Space Write Copy
Unassigned Space Exec Read/Write
Unassigned Sace Exec Read Only
Unassigned Space Exec Write Copy
Unassigned Sace Executable
Unassigned Space No Access
Unassigned Space Read/Write
Unassigned Space Read Only

Unassigned Space Write Copy

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

Process Counters

QALoad supportsthe Process category for Windows NT. This object type handlesthese registry counters:

% Privileged Time

% Processor Time (See Note below)

% User Time

Pool Nonpaged Bytes
Pool Paged Bytes

Priority Base
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Elapsed Time Private Bytes
Handle Count Thread Count

ID Process Virtual Bytes
Page Faults/sec Virtual Bytes Peak
Page File Bytes Working Set

Page File Bytes Peak Working Set Peak

2l Note: If you use the % Processor Time counter in an event rule, set the event rule to trigger after two or
more occurrences of the event. The CPU consumption for the first datapoint sample is artificially high
because the agent is starting the task.

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Processor Counters

QALoad supportsthe Processor category for Windows NT. This object type handles these registry counters:

% DPC Time APC Bypasses/sec
% Interrupt Time DPC Bypasses/sec
% Privileged Time DPC Rate

% Processor Time DPCs Queued/sec
% User Time Interrupts/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Redirector Counters

QALoad supportsthe Redirector category for Windows NT. This object type handlesthese registry counters:

Bytes Received/sec Read Operations Random/sec
Bytes Total/sec Read Packets/sec

Bytes Transmitted/sec Read Packets Small/sec
Connects Core Reads Denied/sec

Connects Lan Manager 2.0 Reads Large/sec

Connects Lan Manager 2.1 Server Disconnects
ConnectsWindows NT Server Reconnects

46



Current Commands

File Data Operations/sec
File Read Operations/sec
File Write Operations/sec
Network Errors/sec
Packets/sec

Packets Received/sec
Packets Transmitted/sec
Read Bytes Cache/sec
Read Bytes Network/sec
Read Bytes Non-Paging/sec

Read Bytes Paging/sec

Conductor

Server Sessions

Server Sessions Hung

Write Bytes Cache/sec

Write Bytes Network/sec
Write Bytes Non-Paging/sec
Write Bytes Paging/sec

Write Operations Random/sec
Write Packets/sec

Write Packets Small/sec
Writes Denied/sec

Writes Large/ sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Counters

QALoad supportsthe Server category for Windows NT. This object type handlesthese registry counters:

Blocking Requests Rejected
Bytes Received/sec

Bytes Total/sec

Bytes Transmitted/sec
Context Blocks Queued/sec
Errors Access Permissions
Errors Granted Access
Errors Logon

Errors System

File Directory Searches
Files Open

Files Opened Total

Logon Total

Pool Nonpaged Bytes
Pool Nonpaged Failures
Pool Nonpaged Peak
Pool Paged Bytes
Pool Paged Failures
Pool Paged Peak
Server Sessions
Sessions Errored Out
Sessions Forced Off
Sessions Logged Off

Sessions Timed Out
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Logon/sec Work Item Shortages

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Work Queues Counters

QALoad supportsthe Server Work Queues category for Windows NT. This object type handles these registry
counters:

Active Threads Queue Length
Available Threads Read Bytes/sec
Available Work Items Read Operations/sec
Borrowed Work Items Total Bytes/sec

Bytes Received/sec Total Operations/sec
Bytes Sent/sec Work Item Shortages
Bytes Transferred/sec Write Bytes/sec
Context Blocks Queued/sec Write Operations/sec

Current Clients

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP Server Counters

QALoad supportsthe SMTP Server category for Windows NT. This object type handlesthese registry
counters:

% Recipients Local M essage Bytes Received/sec
% Recipients Remote M essage Bytes Received Total
Avg Recipients/msg Received M essage Bytes Sent/sec

Avg Recipients/msg Sent Message Bytes Sent Total
Avg Retriessmsg Delivered M essage Bytes Total

Avg Retriesymsg Sent M essage Bytes Total/sec

Base % Recipients Local Message Delivery Retries
Base % Recipients Remote M essage Received/sec

Base Avg Recipients/msg Received Message Send Retries
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Base Avg Recipients/msg Sent
Base Avg Retriessmsg Delivered
Base Avg Retriesymsg Sent
Bytes Received/sec

Bytes Received Total

Bytes Sent/sec

Bytes Sent Total

Bytes Total

Bytes Total/sec

Connection Errors/sec
Directory Drops/sec

Directory Drops Total
Directory Pickup Queue Length
DNSQueries/sec

DNSQueries Total

ETRN M essages/ sec

ETRN Messages Total

Inbound Connections Current
Inbound Connections Total
Local Queue Length

Local Retry Queue Length

Conductor

M essages Delivered/sec

Messages Delivered Total

M essages Received Total

M essages Refused for Address Objects
M essages Refused for Mail Objects
M essages Refused for Sze

M essages Retrieved/sec

M essages Retrieved Total

M essages Sent/sec

Messages Sent Total

NDRs Generated

Number of MailFiles Open
Number of QueueFiles Open
Outbound Connections Current
Outbound Connections Refused
Outbound Connections Total
Remote Queue Length

Remote Retry Queue Length
Routing Table Lookups/sec
Routing Table Lookups Total

Total Connection Errors

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

System Counters

QALoad supportsthe System category for Windows NT. This object type handles these registry counters:

% Registry Quotaln Use
% Total DPC Time

% Total Interrupt Time

File Read Operations/sec
File Write Bytes/sec
File Write Operations/sec
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% Total Privileged Time
% Total Processor Time
% Total User Time
Alignment Fixups/sec
Context Switches/sec
Exception Dispatches/sec

File Control Bytes/sec

File Control Operations/sec

File Data Operations/sec

File Read Bytes/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

Hoating Emulations/sec
Processor Queue Length
System Calls/sec
System Up Time

Total APC Bypasses/sec
Total DPC Bypasses/sec
Total DPC Rate

Total DPCs Queued/sec

Total Interrupts/sec

http://msdn.microsoft.com/library/default.asp.

TCP Counters

QALoad supportsthe TCP category for Windows NT. This object type handlesthese registry counters:

Connection Failures
Connections Active
Connections Established
Connections Passive

Connections Reset

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

Segments/sec

Segments Received/sec

Segments Retransmitted/sec

Segments Sent/sec

http://msdn.microsoft.com/library/default.asp.

Telephony Counters

QALoad supportsthe Telephony category for Windows NT. This object type handlesthese registry

counters:

Active Lines
Active Telephones

Client Apps
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Current Incoming Calls Telephone Devices

Current Outgoing Calls

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Thread Counters

QALoad supportsthe Thread category for Windows NT. This object type handles these registry counters:

% Privileged Time ID Thread

% Processor Time Priority Base

% User Time Priority Current
Context Switches/sec Sart Address
Elapsed Time Thread Sate

ID Process Thread Wait Reason

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

UDP Counters
QALoad supportsthe UDP category for Windows NT. This object type handlesthese registry counters:

Datagrams/sec Datagrams Received Errors
Datagrams No Port/sec Datagrams Sent/sec

Datagrams Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Windows Win2K Registry Counters

Windows Win2K Server Registry Counters

Remote Monitoring Agents can monitor the same Windows registry counters as PERFMON, the
performance monitoring application available with the Windows operating system. The Windows registry
option monitors machinesthat run Windows 2000 and XP. To retrieve Windows Registry Counters, you
must have access, via a user name and password, to the remote machine.

QALoad supportsthe following MSWindows counter categories:
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Counter Category

ACYRSVP Service

Description

RSVP or ACSservice performance counters.

Active Server Pages

This object type handlesthe Active Server Pages device on your
system.

Browser The Browser performance object consists of countersthat measure the
rates of announcements, enumerations, and other Browser
transmissions.

Cache The Cache performance object consists of countersthat monitor the

file system cache, an area of physical memory that storesrecently used
data aslong as possible to permit accessto the data without reading
from the disk. Because applicationstypically usethe cache, the cache
ismonitored as an indicator of application I/O operations. When
memory is plentiful, the cache can grow, but when memory is scarce,
the cache can become too small to be effective.

IAS Accounting Clients

IAS Accounting Clients

IAS Accounting Server

IAS Accounting Server

IAS Authentication Clients

IAS Authentication Clients

IAS Authentication Server

IAS Authentication Server

ICMP

The ICMP performance object consists of countersthat measure the
rates at which messages are sent and received by using ICMP
protocols. It also includes countersthat monitor ICMP protocol errors.

The IP performance object consists of countersthat measure the rates
at which IP datagrams are sent and received by using IP protocols. It
also includes countersthat monitor IP protocol errors.

LogicalDisk

The Logical Disk performance object consists of countersthat monitor
logical partitions of ahard or fixed disk drives. Performance Monitor
identifies logical disks by their adrive letter, such asC.

Memory

The Memory performance object consists of countersthat describe the
behavior of physical and virtual memory on the computer. Physical
memory isthe amount of random access memory on the computer..
Virtual memory consists of the space in physical memory and on disk.
Many of the memory counters monitor paging, which isthe
movement of pages of code and data between disk and physical
memory. Excessive paging, a symptom of amemory shortage, can
cause delayswhich interfere with all system processes.

NBT Connection

The NBT Connection performance object consists of countersthat
measure the rates at which bytes are sent and received over the NBT
connection between thelocal computer and aremote computer. The
connection isidentified by the name of the remote computer.

Network Interface

The Network Interface performance object consists of countersthat
measure the rates at which bytesand packets are sent and received
over a TCP/IP network connection. It includes countersthat monitor
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connection errors.

Objects

The Object performance object consists of countersthat monitor
logical objectsin the system, such as processes, threads, mutexes, and
semaphores. Thisinformation can be used to detect the unnecessary
consumption of computer resources. Each object requires memory to
store basic information about the object.

Paging File

The Paging File performance object consists of countersthat monitor
the paging file(s) on the computer. The paging fileis areserved space
on disk that backs up committed physical memory on the computer.

PhysicalDisk

The Physical Disk performance object consists of countersthat
monitor hard or fixed disk drive on acomputer. Disks are used to store
file, program, and paging data and areread to retrieve these items, and
written to record changesto them. The values of physical disk
countersare sums of the values of the logical disks (or partitions) into
which they are divided.

Print Queue

Displays performance statistics about a Print Queue.

Process

The Process performance object consists of countersthat monitor
running application program and system processes. All the threadsin
a process share the same address space and have accessto the same
data.

Process Address Space

The Process Address Space performance object consists of counters
that monitor memory allocation and use for a selected process.

Processor

The Processor performance object consists of countersthat measure
aspects of processor activity The processor isthe part of the computer
that performsarithmetic and logical computations, initiates
operationson peripherals, and runsthe threads of processes. A
computer can have multiple processors. The processor object
represents each processor as an instance of the object.

Redirector

The Redirector performance object consists of counter that monitor
network connectionsoriginating at the local computer.

Server

The Server performance object consists of countersthat measure
communication between thelocal computer and the network.

Server Work Queues

The Server Work Queues performance object consists of countersthat
monitor the length of the queues and objectsin the queues.

SMTP NTFSSore Driver

This object represents global countersfor the Exchange NTFS Sore
driver.

SMTP Server The counters specific to the SM TP Server.

System The System performance object consists of countersthat apply to
more than oneinstance of acomponent processors on the computer.

TCP The TCP performance object consists of countersthat measure the

rates at which TCP Segmentsare sent and received by using the TCP
protocol. It includes countersthat monitor the number of TCP
connectionsin each TCP connection state.
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Telephony The Telephony System.

Thread The Thread performance object consists of countersthat measure
aspects of thread behavior. A thread isthe basic object that executes
instructionson aprocessor. All running processes have at least one
thread.

UDP The UDP performance object consists of countersthat measure the
rates at which UDP datagrams are sent and received by using the UDP
protocol. It includes countersthat monitor UDP protocol errors.

ACSRSVP Service Counters

QALoad supportsthe ACSRSVP Service category for Windows. This object type handlesthese registry
counters:

APl notifications Interfaces

API sockets Network sockets
Bytesin API notifies PATH from API

Failed API requests RESV from API

Failed APl sends RSVP msg buffersin use
GQOSsessions Timers

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Active Server Pages Counters

QALoad supportsthe Active Server Pages category for Windows. This object type handlesthese registry
counters:

Debugging Requests Requests Succeeded
Errors/Sec Requests Timed Out
Errors During Script Runtime Requests Total

Errors From ASP Preprocessor Script Engines Cached
Errors From Script Compilers Session Duration
Request BytesIn Total Sessions Current
Request Bytes Out Total Sessions Timed Out
Request Execution Time Sessions Total
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Request Wait Time
Requests/ Sec

Requests Disconnected
Requests Executing
Requests Failed Total
Requests Not Authorized
Requests Not Found
Requests Queued

Requests Rejected

Conductor

Template Cache Hit Rate
Template Notifications
Templates Cached
Transactions/Sec
Transactions Aborted
Transactions Committed
Transactions Pending

Transactions Total

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Browser Counters

QALoad supportsthe Browser category for Windows. This object type handlesthese registry counters:

Announcements Domain/sec
Announcements Server/sec
Announcements Total/sec
Duplicate Master Announcements
Election Packets/sec
Enumerations Domain/sec
Enumerations Other/sec
Enumerations Server/sec
Enumerations Total/sec

Illegal Datagrams/sec

Mailslot Allocations Failed

Mailslot Opens Failed/sec

Mailslot Receives Failed

Mailslot Writes/sec

Mailslot Writes Failed

Missed Mailslot Datagrams

Missed Server Announcements

Missed Server List Requests

Server Announce Allocations Failed/sec

Server List Requests/sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Cache Win2K Counters

QALoad supportsthe Cache category for Windows. This object type handlesthese registry counters:
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Async Copy Reads/sec
Async Data Maps/sec
Async Fast Reads/sec
Async MDL Reads/sec
Async Pin Reads/sec
Copy Read Hits %
Copy Reads/sec

Data Flush Pages/sec
Data Hushes/sec

Data Map Hits %
Data Map Pins/sec
Data Maps/sec

Fast Read Not Possibles/sec

Fast Read Resource Misses/ sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

Fast Reads/sec

Lazy Write Hushes/sec
Lazy Write Pages/sec
MDL Read Hits %
MDL Reads/sec

Pin Read Hits %

Pin Reads/sec

Read Aheads/sec
Sync Copy Reads/sec
Sync Data Maps/sec
Sync Fast Reads/sec
Sync MDL Reads/sec

Sync Pin Reads/sec

http://msdn.microsoft.com/library/default.asp.

IAS Accounting Clients Counters

QALoad supportsthe IASAccounting Clients category for Windows. This object type handlesthese registry

counters:

Accounting-Requests
Accounting-Requests/sec
Accounting-Responses
Accounting-Responses/sec
Bad Authenticators

Bad Authenticators/sec
Dropped Packets
Dropped Packets/sec

Duplicate Accounting-Requests
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Malformed Packets
Malformed Packets/sec
No Record

No Record/sec

Packets Received
Packets Received/sec
Packets Sent

Packets Sent/sec

Unknown Type
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Duplicate Accounting-Requests/sec Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Accounting Server Counters

QALoad supportsthe IAS Accounting Server category for Windows. This object type handlesthese registry
counters:

Accounting-Requests Malformed Packets
Accounting-Requests/sec Malformed Packets/sec
Accounting-Responses No Record
Accounting-Responses/sec No Record/sec

Bad Authenticators Packets Received
Bad Authenticators/sec Packets Received/sec
Dropped Packets Packets Sent
Dropped Packets/sec Packets Sent/sec
Duplicate Accounting-Requests Server Reset Time
Duplicate Accounting-Requests/sec Server Up Time
Invalid Requests Unknown Type
Invalid Requests/sec Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Authentication Clients Win2K Counters

QALoad supportsthe IASAuthentication Clients category for Windows. This object type handlesthese
registry counters:

Access-Accepts Dropped Packets/sec
Access-Accepts/ sec Duplicate Access-Requests
Access-Challenges Duplicate Access-Requests/sec
Access-Challenges/sec Malformed Packets
Access-Rejects Malformed Packets/sec
Access-Rejects/sec Packets Received
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Access-Requests Packets Received/sec
Access-Requests/sec Packets Sent

Bad Authenticators Packets Sent/sec

Bad Authenticators/sec Unknown Type
Dropped Packets Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Authentication Server Counters

QALoad supportsthe IAS Authentication Server category for Windows. This object type handlesthese
registry counters:

Access-Accepts Duplicate Access-Requests/sec
Access-Accepts/ sec Invalid Requests
Access-Challenges Invalid Requests/sec
Access-Challenges/sec Malformed Packets
Access-Rejects Malformed Packets/sec
Access-Rejects/sec Packets Received
Access-Requests Packets Received/sec
Access-Requests/sec Packets Sent

Bad Authenticators Packets Sent/sec

Bad Authenticators/sec Server Reset Time
Dropped Packets Server Up Time
Dropped Packets/sec Unknown Type
Duplicate Access-Requests Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

ICMP Counters
QALoad supportsthe ICMP category for Windows. This object type handlesthese registry counters:

M essages/ sec Received Timestam p/sec
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M essages Outbound Errors
M essages Received/sec

M essages Received Errors

M essages Sent/sec

Received Address M ask
Received Address Mask Reply
Received Dest. Unreachable
Received Echo/sec

Received Echo Reply/sec
Received Parameter Problem
Received Redirect/sec
Received Source Quench

Received Time Exceeded

Received Timestamp Reply/sec
Sent Address Mask

Sent Address Mask Reply

Sent Destination Unreachable
Sent Echo/sec

Sent Echo Reply/sec

Sent Parameter Problem

Sent Redirect/sec

Sent Source Quench

Sent Time Exceeded

Sent Timestamp/sec

Sent Timestamp Reply/sec

Conductor

For information on theregistry countersrefer to the documentation or developer network for that product

or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

IP Counters

QALoad supportsthe IP category for Windows. This object type handlesthese registry counters:

Datagrams/sec

Datagrams Forwarded/sec

Datagrams Outbound Discarded

Datagrams Outbound No Route

Datagrams Received/sec

Datagrams Received Address Errors

Datagrams Received Delivered/sec

Datagrams Received Discarded

Datagrams Received Header Errors

Datagrams Received Unknown Protocol

Datagrams Sent/sec

Fragment Re-assembly Failures
Fragmentation Failures
Fragmented Datagrams/sec
Fragments Created/sec
Fragments Re-assembled/sec

Fragments Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product

or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.
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LogicalDisk Counters

QALoad supportsthe LogicalDisk category for Windows. This object type handlesthese registry counters:

% Disk Read Time

% Disk Time

% Disk Write Time

% Free Space

% Idle Time

Avg. Disk Bytes/Read
Avg. Disk Bytes/Transfer
Avg. Disk Bytes/Write
Avg. Disk Queue Length
Avg. Disk Read Queue Length
Avg. Disk sec/Read

Avg. Disk sec/Transfer

For information on theregistry countersrefer to the documentation or developer network for that product

Avg. Disk sec/Write

Avg. Disk Write Queue Length
Current Disk Queue Length
Disk Bytes/sec

Disk Read Bytes/sec

Disk Reads/sec

Disk Transfers/sec

Disk Write Bytes/sec

Disk Writes/sec

Free Megabytes

Split 10/Sec

or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Memory Counters

QALoad supportsthe Memory category for Windows. This object type handles these registry counters:

% Committed BytesIn Use
Available Bytes

Cache Bytes

Cache Bytes Peak

Cache Faults/sec

Commit Limit

Committed Bytes

Demand Zero Faults/sec

Free System Page Table Entries
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Pool Nonpaged Allocs

Pool Nonpaged Bytes

Pool Paged Allocs

Pool Paged Bytes

Pool Paged Resident Bytes
System Cache Resident Bytes
System Code Resident Bytes
System Code Total Bytes

System Driver Resident Bytes
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Page Faults/sec System Driver Total Bytes

Page Reads/sec System VLM Commit Charge

Page Writes/sec System VLM Commit Charge Peak
Pages/sec System VLM Shared Commit Charge
Pages Input/sec Transition Faults/sec

Pages Output/sec Write Copies/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

NBT Connection Counters

QALoad supportsthe NBT Connection category for Windows. This object type handlesthese registry
counters:

Bytes Received/sec Bytes Total/sec

Bytes Sent/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Network Interface Counters

QALoad supportsthe Network Interface category for Windows. This object type handlesthese registry
counters:

Bytes Received/sec Packets Received Discarded

Bytes Sent/sec Packets Received Errors

Bytes Total/sec Packets Received Non-Unicast/sec
Current Bandwidth Packets Received Unicast/sec
Output Queue Length Packets Received Unknown
Packets/sec Packets Sent/sec

Packets Outbound Discarded Packets Sent Non-Unicast/sec
Packets Outbound Errors Packets Sent Unicast/sec

Packets Received/sec
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Objects Counters

QALoad supportsthe Objects category for Windows. This object type handlesthese registry counters:

Events Sections
Mutexes Semaphores
Processes Threads

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Paging File Counters

QALoad supportsthe Paging File category for Windows. This object type handlesthese registry counters:

% Usage % Usage Peak

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

PhysicalDisk Counters

QALoad supportsthe PhysicalDisk category for Windows. Thisobject type handlesthese registry counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
% ldle Time Disk Bytes/sec

Avg. Disk Bytes/Read Disk Read Bytes/sec

Avg. Disk Bytes/ Transfer Disk Reads/sec

Avg. Disk Bytes/Write Disk Transfers/sec

Avg. Disk Queue Length Disk Write Bytes/sec

Avg. Disk Read Queue Length Disk Writes/sec

Avg. Disk sec/Read Slit 10/Sec

Avg. Disk sec/Transfer
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Print Queue Counters

QALoad supportsthe Print Queue category for Windows. This object type handlesthese registry counters:

Add Network Printer Calls Max References

Bytes Printed/sec Not Ready Errors

Enumerate Network Printer Calls Out of Paper Errors

Job Errors References
Jobs Total Jobs Printed
Jobs Sooling Total Pages Printed

Max Jobs Sooling

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Process Address Space Counters

QALoad supportsthe Process Address Space category for Windows. This object type handles these registry

counters:

Bytes Free

Bytes Image Free

Bytes Image Reserved

Bytes Reserved

ID Process

Image Space Exec Read/Write
Image Sace Exec Read Only
Image Sace Exec Write Copy
Image Sace Executable
Image Space No Access
Image Sace Read/Write
Image Sace Read Only

Image Sace Write Copy

Mapped Space Read Only

Mapped Space Write Copy
Reserved Space Exec Read/Write
Reserved Space Exec Read Only
Reserved Space Exec Write Copy
Reserved Space Executable
Reserved Sace No Access
Reserved Space Read/Write
Reserved Sace Read Only
Reserved Space Write Copy
Unassigned Space Exec Read/Write
Unassigned Space Exec Read Only

Unassigned Sace Exec Write Copy
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Mapped Space Exec Read/Write
Mapped Space Exec Read Only
Mapped Space Exec Write Copy
Mapped Space Executable
Mapped Space No Access

Mapped Space Read/Write

For information on theregistry counters refer t

Unassigned Space Executable
Unassigned Space No Access
Unassigned Space Read/Write
Unassigned Space Read Only

Unassigned Space Write Copy

o the documentation or developer network for that product

or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

Process Counters

QALoad supportsthe Process category for Windows. This object type handles these registry counters:

% Privileged Time

% Processor Time (See Note below.)
% User Time

Creating Process ID
Elapsed Time

Handle Count

ID Process

IO Data Bytes/sec

IO Data Operations/sec
1O Other Bytes/sec

IO Other Operations/sec
10 Read Bytes/sec

IO Read Operations/sec

10 Write Bytes/sec

IO Write Operations/sec
Page Faults/sec

Page File Bytes

Page File Bytes Peak
Pool Nonpaged Bytes
Pool Paged Bytes
Priority Base

Private Bytes

Thread Count
Virtual Bytes

Virtual Bytes Peak
Working Set

Working Set Peak

=l Note: If you use the % Processor Time counter in an event rule, set the event rule to trigger after two or

more occurrences of the event. The CPU consu
because the agent is starting the task.

For information on theregistry countersrefer t
or the developer kit provided with the product
http://msdn.microsoft.com/library/default.asp.
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Processor Counters

QALoad supportsthe Processor category for Windows. This object type handles these registry counters:

% DPC Time

% Interrupt Time
% Privileged Time
% Processor Time

% User Time

APC Bypasses/sec
DPC Bypasses/sec
DPC Rate

DPCs Queued/sec

Interrupts/sec

Conductor

For information on theregistry countersrefer to the documentation or developer network for that product

or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

Redirector Counters

QALoad supportsthe Redirector category for Windows. This object type handlesthese registry counters:

Bytes Received/sec

Bytes Total/sec

Bytes Transmitted/sec
Connects Core

Connects Lan Manager 2.0
Connects Lan Manager 2.1
Connects Windows NT
Current Commands

File Data Operations/sec
File Read Operations/sec
File Write Operations/sec
Network Errors/sec
Packets/sec

Packets Received/sec
Packets Transmitted/sec
Read Bytes Cache/sec

Read Bytes Network/sec

Read Bytes Non-Paging/sec

Read Operations Random/sec
Read Packets/sec

Read Packets Small/sec

Reads Denied/sec

Reads Large/sec

Server Disconnects

Server Reconnects

Server Sessions

Server Sessions Hung

Write Bytes Cache/sec

Write Bytes Network/sec
Write Bytes Non-Paging/sec
Write Bytes Paging/sec
Write Operations Random/sec
Write Packets/sec

Write Packets Small/sec
Writes Denied/sec

Writes Large/ sec
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Read Bytes Paging/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Counters

QALoad supportsthe Server category for Windows. This object type handles these registry counters:

Blocking Requests Rejected Logon Total
Bytes Received/sec Pool Nonpaged Bytes
Bytes Total/sec Pool Nonpaged Failures

Bytes Transmitted/sec Pool Nonpaged Peak
Context Blocks Queued/sec Pool Paged Bytes

Errors Access Permissions Pool Paged Failures

Errors Granted Access Pool Paged Peak
Errors Logon Server Sessions
Errors System Sessions Errored Out

File Directory Searches Sessions Forced Off

Files Open Sessions Logged Off
Files Opened Total Sessions Timed Out
Logon/sec Work Item Shortages

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Work Queues Counters

QALoad supportsthe Server Work Queues category for Windows. This object type handlesthese registry
counters:

Active Threads Queue Length

Available Threads
Available Work Items
Borrowed Work Items
Bytes Received/sec

Bytes Sent/sec
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Read Bytes/sec
Read Operations/sec
Total Bytes/sec
Total Operations/sec

Work Item Shortages



Bytes Transferred/sec
Context Blocks Queued/sec

Current Clients

Conductor

Write Bytes/sec

Write Operations/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP NTFS Store Drive Counters

QALoad supportsthe SMTP NTFS Sore Drive category for Windows. This object type handlesthese registry

counters:

M essages allocated
M essages deleted

M essages enumerated

Messages in the queue directory
Open message bodies

Open message streams

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP Server Counters

QALoad supportsthe SMTP Server category for Windows. This object type handlesthese registry counters:

% Recipients Local

% Recipients Remote

Avg Recipients/msg Received

Avg Recipients/msg Sent

Avg Retriessmsg Delivered

Avg Retriesymsg Sent

Badmailed Messages (Bad Pickup File)
Badmailed Messages (General Failure)

Badmailed Messages (Hop Count
Exceeded)

Badmailed Messages (NDR of DSN)
Badmailed Messages (No Recipients)
Badmailed Messages (Triggered via Event)

Base % Recipients Local

Local Retry Queue Length

M essage Bytes Received/sec
M essage Bytes Received Total
M essage Bytes Sent/sec

M essage Bytes Sent Total

M essage Bytes Total

M essage Bytes Total/sec
Message Delivery Retries

M essage Received/sec

Message Send Retries

Messages Currently Undeliverable
M essages Delivered/sec

Messages Delivered Total
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Base % Recipients Remote
Base Avg Recipients/msg Received
Base Avg Recipients/msg Sent
Base Avg Retriessmsg Delivered
Base Avg Retriesymsg Sent
Bytes Received/sec

Bytes Received Total

Bytes Sent Total

Bytes Sent/sec

Bytes Total

Bytes Total/sec

Categorizer Queue Length
Connection Errors/sec
Current Messagesin Local Delivery
Directory Drops/sec

Directory Drops Total
DNSQueries/sec

DNSQueries Total

ETRN M essages/ sec

ETRN Messages Total

Inbound Connections Current
Inbound Connections Total

Local Queue Length

For information on theregistry countersrefer to the documentation or developer network for that product

M essages Pending Routing

M essages Received Total

M essages Refused for Address Objects
M essages Refused for Mail Objects

M essages Refused for Sze

M essages Sent/sec

Messages Sent Total

NDRs Generated

Number of MailFiles Open

Number of QueueFiles Open
Outbound Connections Current
Outbound Connections Refused
Outbound Connections Total

Pickup Directory M essages Retrieved/sec
Pickup Directory M essages Retrieved Total
Remote Queue Length

Remote Retry Queue Length

Routing Table Lookups/sec

Routing Table Lookups Total

Total Connection Errors

Total DSN Failures

Total messages submitted

or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

System Counters

QALoad supportsthe System category for Windows. This object type handles these registry counters:;

% Registry Quotaln Use
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Alignment Fixups/sec File Write Operations/sec
Context Switches/sec Foating Emulations/sec
Exception Dispatches/sec Processes

File Control Bytes/sec Processor Queue Length
File Control Operations/sec System Calls/sec

File Data Operations/sec System Up Time

File Read Bytes/sec Threads

File Read Operations/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

TCP Counters
QALoad supportsthe TCP category for Windows. This object type handlesthese registry counters:

Connection Failures Segments/sec

Connections Active Segments Received/sec
Connections Established Segments Retransmitted/sec
Connections Passive Segments Sent/sec

Connections Reset

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Telephony Counters

QALoad supportsthe Telephony category for Windows. This object type handlesthese registry counters:

Active Lines Incoming Calls/sec
Active Telephones Lines

Client Apps Outgoing Calls/sec
Current Incoming Calls Telephone Devices

Current Outgoing Calls

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.
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Thread Counters

QALoad supportsthe Thread category for Windows. This object type handlesthisregistry counter:
User PC

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

UCP Counters
QALoad supportsthe UCP category for Windows. This object type handles these registry counters:

Datagrams/sec Datagrams Received Errors
Datagrams No Port/sec Datagrams Sent/sec

Datagrams Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SAP Counters

SAP R/3 Remote Extended Counters

The following extended SAP R/3 remote counters are provided. These counters extend the monitoring of
your SAP R/3 system:

Active Servers Page/Roll Area
Active Users Page/Roll Area M ax
Alerts Process Monitoring
Buffer Satistics Sool Queue
CCMSMonitoring System Log Entries
Connection Test (SM59) Top CPU Utilization
CPU Consumption Top Load

Itemized Active Users User Function Call
Itemized Job Satus Workload Statistic
Itemized Spool Queue Work Processes
Job Status

Memory Usage

Number of Dumps

SAP Active Servers

Thiscounter returnsthe active SAP application servers for a specified SAP R/3 instance.

Parameters
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SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Server Count

Maximum number of serverson which to report data. The default is10. The value can range between
00 and 100.

Data Point

Primary Data Point
The primary data point (PDP) is the number of active SAP application servers in the specified SAP instance.
If an error isencountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for each server:

Name Full application server name.
Hostname Name of application server host.
Type Service name.
IP Application server host IP address.
Num Services Service port number.

Interval

Recommended minimum is5 minutes.

SAP Active Users

Thiscounter returnsall SAP users connected to either a specific SAP R/3 instance or system-wide.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. Enter an instance name asastringin
the format:

<Syst em nane>- <Appl i cation server nane>-<R/ 3 system nunber>-<dient nunber>
For example:

Cl1- sapappserver-01-001

SAP User Count

Maximum number of serverson which to report data. The default is10. The value can range between
00 and 100.

Leve

The monitoring level. This parameter is pre-defined and single-selectable. Possible values are:

Selected instance only (default) Only usersin theinstance specified by the SAP
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Instance parameter are reported.
All instancesin the system All users of any instance available through the
specified instance are reported.

Data Point

Primary Data Point

The primary data point (PDP) isthe current queue depth as a percentage of the defined maximum. The
Level parameter impactsthe number of serversthat will be scanned. If an error isencountered during
data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) displaysthe following information:

Syshame Full application server name.
TerminallD Terminal identification.
Client User’'slogon client number.
Username Name of the user.
Report/Tcode Name of tcode or report currently used by
user.
Terminal Terminal name.
Time Dialog time.
Sessions Number of user sessions.
Interval

Recommended minimum is5 minutes.

SAP Alerts

Thiscounter returns a description of all the SAP alerts for the specified severity level.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Monitor Set

Name of the monitor set. You can specify one or more sets. In any combination, select values from the
discovered list, or enter values manually.

Monitor

Name of the monitor within the selected monitor set. You can specify one or more monitors. In any
combination, select values from the discovered list, or enter values manually.
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Severity

Alert severity level you want to monitor. This parameter is pre-defined and multi-selectable. Possible
values are:

Error - Red (default)

Warning - Yellow

Pattern

Pattern to search for in result. The default isall (* wildcard). You can either accept the default or enter a
string. Wildcard characters cannot beincluded in the string.

Show Alert Text

Soecify whether to show the alert'stext. Thisparameter ispre-defined and single-selectable. Possible
values are:

Yes

No (default)

Alert Type

Select whether datareturned presentsonly current alert activity or presents a history of activity. This
parameter is pre-defined and multi-selectable. Possible values are:

Active alerts (default)

Alert history

Show last minutes

Number of minutes of data history to return.
Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
number of alerts of the specified type. If an error isencountered during data collection, the counter
returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information:

Color Red for errorsand yellow for warnings

Severity Severity of alert

Date/Time Alert timestamp

Alert Unique ID Alert ID

Status Satus (for example: active, cone, auto
completed)

System MTE system name
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Context MTE context

Object MTE object

Short Name MTE short name

Alert Text Alert text, if any.
Interval

Recommended minimum is5 minutes.

SAP Buffer Statistic
This counter returns statistics for the specified SAP R/3 buffers.

The primary data point returnsthe buffer hit ratio, which isan indicator of how efficiently the buffer is
being used. For a frequently accessed buffer, the hit ratio should exceed 95%.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Buffer Name

Name of the SAP R/3 buffer you want to monitor. You can specify one or more buffers. In any
combination, select values from the discovered list, or enter values manually.

Satistic Name

The SAP R/3 buffer statistic to be used for the primary data point. This parameter is predefined and
single-selectable. Possible values are:

% of active objects

% of free objects

Free Size (%)

Free Size (KB)

Hit rate SAP buffer (%) (default)
Maximum no. of objects

No. of active objects

No. of database accesses

No. of free objects

No. of objects swapped

Size of allocated address space (KB)

Storage space available (KB)
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Used size (%)

Used size (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The primary data point is
the value for the statistic specified in the Satistic Name parameter. If an error isencountered during
data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) liststhe valuesreturned for all statistics.

Interval

Recommended minimum is5 minutes.

SAP CCMSMonitoring

The Computer Center Management System (CCMS) Monitoring counter returnsthe value of the R/I3 CCMS
Monitoring Tree Element (MTE) asin R/3 transaction RZ20. The performance, status and log attributes are
distinguished. Each MTEin CCMSisrepresented using four elements: system name, context, object and
name. For example, CW2\ Database\ Tablespaces\ ...\ PSAPTABD.

The counter ignores any relationshipswithin RZ20’stree for the monitor set-monitor pair. Instead, it
allowsyou to select each of these four elementsusing the parameter dependency feature. That is, after a
monitor set is selected, the monitor list has only monitorsbelonging to that monitor set. After the monitor
is selected, the system name parameter only hasvaluesthat belong to the combination of monitor set-
monitor, etc.

Performance attributes show a numeric value asthe primary datapoint and any other messages as an
extended datapoint.

Satusand log attributes show their status value — green, yellow, red and white (normal, warning, critical
and no datareported, respectively). The primary datapoint isshown as 1, 2, 3 and 0 respectively. The
intelligent datapoint isavailable as explanation of returned status.

This counter enables monitoring of any parts of R/3 of SAP modules, which supply datato CCMS
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Monitor Set

Name of the monitor set. You can specify one or more sets. In any combination, select values from the
discovered list, or enter values manually.

Monitor

Name of the monitor within the selected monitor set. You can specify one or more monitors. In any
combination, select values from the discovered list, or enter values manually.
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System ID
The system ID (or system name) of the monitoring system. You can specify one or more systems. In
any combination, select values from the discovered list, or enter values manually.

Context
The monitored context within the system ID. You can specify one or more contexts. In any
combination, select values from the discovered list, or enter values manually.

Object
The monitored object within the specified context. You can specify one or more objects. In any
combination, select valuesfrom the discovered list, or enter values manually.

Name

Name of MTE from R/3's RZ20 transaction. You can specify one or more names. In any combination,
select values from the discovered list, or enter values manually.

Sat Type
Select what type of dataisreturned. Thisparameter ispre-defined and single-selectable. Possible values
are:
Active alerts returns number of alerts
Alert history returns number of alerts
Value (default) returns MTE value

Show last minutes

Number of minutes of data history to return.
Data Point

Primary Data Point
A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
MTE value or number of alerts, depending on the selection in the Sat type parameter. If an error is
encountered during data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) providesthe following information:
I MTE status
I Timestamp

! MTE Name

Interval

Not applicable.

SAP Connection Test (SM59)

Thiscounter teststhe connection to the selected remote system, asdescribed in R/3. Thisisthe same
connection test asthe R/3 transaction SM59.
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Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Connection Name

Name of the connection described in SM59. Enter a string. There isno default value.
Data Point

Primary Data Point
The primary data point (PDP) is one of the following values:
I 0ifthe test fails
I 1ifthe testis successful

I 999 if the counter experiences an error during data collection

Intelligent Data Point
Theintelligent data point (IDP) returnsone of the following messages:
I Failure reason if the test failed
I "Connection tested OK” message if the test succeeded

! Error message if the counter encounters an error during data collection

Interval

Recommended minimum is5 minutes.

SAP CPU Consumption

This counter monitors CPU consumption for the specific users or transactions.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

User Name

The user name to monitor. The default isall (* wildcard). You can either accept the default or enter a
specific name. Wildcard characters cannot beincluded in the name.

TCode/Program

The user transaction code or report code to monitor. The default isall (* wildcard). You can either
accept the default or enter a specific name. Wildcard characters cannot be included in the name.

Data Point
Primary Data Point
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A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
percentage of SAP CPU consumption. If an error isencountered during data collection, the counter
returns 999.

If you do not specify values for the User Name or TCODE/Program parameters, the value returned is
always 100%.
Intelligent Data Point

The intelligent data point (IDP) providesthe following information:

Username Name of the user.
Tcode/ Program Name of transaction code or report.
CPU (mys) Current CPU consumption in milliseconds.
CPU (%) Current CPU consumption in percentage.
WP-Type Number of user sessions.

Interval

Recommended minimum is5 minutes.

SAP Itemized Active Users

This counter returnsthe SAP users connected to the specified SAP instance and application servers. It is
similar to the SAP active users counter, with the addition of the Application Server Name parameter (multi-
selectable and wildcard enabled).

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count
Maximum number of serverson which to report data. The default is10. The instance number can
range between 00 and 100.

Apply Operation

The monitoring level. This parameter is pre-defined and single-selectable. Possible values are:

None A primary data point isreturned for each server specified in the Application
Server parameter.

Sum The primary data point isa sum for all servers specified in the Application
Server parameter.

Application Server

Name of the application server you want to monitor. You can specify one or more names. In any
combination, select values from the discovered list, or enter values manually.

78



Conductor

Data Point

Primary Data Point

The primary data point (PDP) isthe current queue depth as a percentage of the defined maximum. The
Apply Operation parameter determines whether the counter returnsa summary data point or
individual data points. If an error isencountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information:

Syshame Full application server name.
TerminallD Terminal identification.
Client User’slogon client number.
Username Name of the user.
Report/Tcode Name of tcode or report currently used by
user.
Terminal Terminal name.
Time Dialog time.
Sessions Number of user sessions.
Interval

Recommended minimum is5 minutes.

SAP Itemized Job Status

This counter reportsthe status of jobsthat meet the specified criteria. It issimilar to the SAP Job Satus
counter, with the addition of the Apply Operation parameter and the all (* wildcard) default setting for the
Job Satus parameter.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Job Name

Thejob nameto monitor. The default isall. You can either accept the default or enter aname.

User Name

The user name to monitor. The default isall. You can either accept the default or enter a name.

Job Satus

The statusesyou want to monitor. This parameter is predefined and multi-selectable. Possible values
are:
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* (all - default)
Active
Canceled
Finished
Ready
Released

Scheduled

Event Name

Name of a SAP job event. If you specify an event name for this parameter, this counter returns batch
jobsrelated to that event only. The default isto monitor all events. You can either accept the default or
enter aname.

Sart Time

Number of minutes back from the current time you want thiscounter to monitor job entries. Secify a
value from -999999 to 0 (in minutes). The default valueis -60.

End Time

Number of minutes forward from the current time you want this counter to monitor job entries.
Soecify avalue from 0 to 999999 (in minutes). The default value is 60.

Apply Operation

The monitoring level. This parameter is predefined single-selectable. Possible values are:

None A primary data point isreturned for each statustype specified in the Job
Satus parameter.
Sum (default) The primary data point isa sum for all statustypes specified in the Job
Satus parameter.
Data Point

Primary Data Point

The primary data point (PDP) isthe number of jobs. The Apply Operation parameter determines
whether the counter returnsa summary data point or individual data points. If an error is encountered
during data collection, the counter returns 999.

Intelligent Data Point
The intelligent data point (IDP) liststhe following information for each job status:
I Total jobs found
I Scheduled
! Released
! Ready

I Active
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! Finished
! Cancelled

The IDP also includes atable with the following information, organized by job status:

Jobname Name of the job.

Job-count Internal job ID.

Status Job status.

Log Short log messages.
Interval

Recommended minimum is5 minutes.

SAP Itemized Spool Queue

Thiscounter returnsthe current number of entriesin the SAP spool queue that match the specified criteria.
It issimilar to the SAP ool Queue counter, with the addition of the Apply Operation parameter and the
all default setting for the Request Satus parameter.

Parameter

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Request Satus

Request statusthat you want to monitor. This parameter is predefined and multi-selectable. Possible
values are:

* (all - default)
Problem
Processing
Succeeded

Without

Apply Operation

The monitoring level. This parameter is predefined and single-selectable. Possible values are:

None A primary data point isreturned for each statustype specified in the
Request Status parameter.

Sum (default) The primary data point isasum for all statustypes specified in the Request
Satus parameter.

Data Point
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Primary Data Point

The primary data point (PDP) isthe number of current entriesin the SAP spool queue. The Apply
Operation parameter determines whether the counter returnsa summary data point or individual data
points. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) is the number of entries in the spool queue for each request status.

Interval

Recommended minimum is5 minutes.

SAP Job Status

This counter reportsthe number of jobsthat are selected that meet the criteria you specify.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Job Name

Thejob nameto monitor. The default isall. You can either accept the default or enter aname.

User Name

The user name to monitor. The default isall. You can either accept the default or enter a name.

Job Satus

Thejob statusyou want to monitor. This parameter is predefined and single-selectable. Possible values
are:

* (all)
Active
Canceled
Finished
Ready
Released

Scheduled (default)

Event Name

Name of a SAP job event. If you specify an event name for this parameter, this counter returns batch
jobsrelated to that event only. The default isto monitor all events. You can either accept the default or
enter aname.

Sart Time

82



Conductor

Number of minutes back from the current time you want thiscounter to monitor job entries. ecify a
value from -999999 to 0 (in minutes). The default valueis -60.

End Time

Number of minutes forward from the current time you want this counter to monitor job entries.
Soecify avalue from 0 to 999999 (in minutes). The default value is 60.

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The number returned is
the number of jobs. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) liststhe following information:
I Total jobs found
I Scheduled
! Released
I Ready
I Active
! Finished
I Cancelled

TheIDP also includes atable with the following information, organized by job status:

Jobname Name of the job.

Job-count Internal job ID.

Status Job status.

Log Short log messages.
Interval

Recommended minimum is5 minutes.

SAP Memory Usage

This counter returnsthe total memory usage for the specified number of SAP usersin the SAP system.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count
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Maximum number of usersfor which the counter isto report memory utilization values. Secify a
value from 0 to 100. The default is10. Thisnumber isthe number rows of information that isreported
in thelIntelligent Data Point (IDP) table (described below).

Metrics

Unitsin which you want memory usage returned. This parameter is predefined and single-selectable.
Possible values are:

bytes
KB
MB

Data Point

Primary Data Point
The primary data point (PDP) isthe total memory utilization. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) isatable with the following information, organized by user:

Client Client number.

User User name or owner of the job.

TransCode Transaction code name.

Roll Area Sze of roll area.

Page Area Sze of page area.

Shared Memory Sze of shared memory.

Heap Memory Sze of heap memory.

Summary Memory Summary of all types of memory.

TerminallD Terminal identification number.
Interval

Recommended minimum is5 minutes.

SAP Number of Dumps

This counter returnsthe number of dumps generated by the target system in the current day (since
midnight on the SAP system).

Parameters

SAP Instance
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Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Expression

Pattern to use to match dump’sshort text. The default is all
Data Point

Primary Data Point

The primary data point (PDP) isthe number dumps. If an error is encountered during data collection, the
counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) liststhe following information for each dump:

Time Time dump was created.

Application Host Application host name.

User User name.

Client Client number.

Short Text Dump description.
Interval

Recommended minimum is 15 minutes.

SAP Page/ Roll Area

Thiscounter monitorsthe page or roll area statistics.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Return Value Metrics
The page and roll area metrics. This parameter is pre-defined and multi-selectable. Possible values are:

Maximum Paging Area Used (%)
Maximum Paging Area Used (KB)
Maximum Roll Area Used (%)
Maximum Roll Area Used (KB)
Size of the Paging Area (KB)

Size of the Paging Area in the Shared Memory (KB)
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Size of the Paging File (KB)

Size of the Roll Area (KB)

Size of the Roll Areain the Shared Memory (KB)
Size of the Roll File (KB)

Size of the Work Process-Local Paging Buffer (KB)
(default)

Used Paging Area (%)
Used Paging Area (KB)
Used Roll Area (%)

Used Roll Area (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The valuereturned isthe
value of the specified metric (KB or %). The counter returns 999 if it encountersan error during data
collection.

Intelligent Data Point

Theintelligent data point (IDP) liststhe statistics for all page and roll metrics.

Interval

Recommended minimum is5 minutes.

SAP Page/ Roll Area Max

Thiscounter returnsthe maximum page or roll area statistics for the specified task interval.

Determining a Satistic's Maximum Value

A Remote Function Call (RFC) ismade at each task interval to get the data. It searchestheinternal cache
for the previously stored value of the same metric with atimestamp within thetime range specified with
the “Period in min” parameter.

If avalueisfound for the specified metric, it iscompared with the current value. The SAP Page/Roll Area
Max counter returnsthe greater of the two values and storesit in the cache with current timestamp.

If astored valueisnot found for the specified metric, the cache iscleared and the current valueis stored in
it. The counter returnsthisvalue.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Return Value Metrics
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The page and roll area metrics. This parameter is predefined multi-selectable. Possible values are:
Maximum Paging Area Used (%)
Maximum Paging Area Used (KB)
Maximum Roll Area Used (%)
Maximum Roll Area Used (KB)
Size of the Paging Area (KB)
Size of the Paging Areain the Shared Memory (KB)
Size of the Paging File (KB)
Size of the Roll Area (KB)
Size of the Roll Areain the Shared Memory (KB)
Size of the Roll File (KB)

Size of the Work Process-Local Paging Buffer (KB)
(default)

Used Paging Area (%)
Used Paging Area (KB)
Used Roll Area (%)
Used Roll Area (KB)
Period in min
Soecify amaximum duration of timein minutes. The default is 60.

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned is
the maximum value of the specified metric (KB or %), determined by the method described in
Determining a statistic's maximum value. The counter returns 999 if it encountersan error during
data collection.

Intelligent Data Point

The intelligent data point (IDP) lists, for the period, the maximum values for all statistics.

Interval

Recommended minimum is5 minutes.

SAP Process Monitoring

This counter returns CPU utilization or memory usage for selected processes. These processes must be set
up to be monitored by the SAP Operation System Collector.
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To gather thisdata from the target R/3 instances, you must set up SAP OS Collector (saposcol) to gather
information about system processes. Completeinstructions are described in the document called
“Operation System Collector SAPOSCOL: Propertied, Operation and Installation”. It isavailable from the
SAP web site.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable
from the discovered list.

Process Pattern or User Pattern

Process or user to monitor. This parameter is single-selectable from the dynamically discovered list.

Metrics
Usage metrics for monitoring. This parameter is predefined and multi-selectable. Possible values are:
CPU Utilization (%)
Process Count (default)
Resident Size (KB)

VM Size (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The returned valueisthe
value of the selected metric. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) displaysthe following information for each metric:

Last SapOsCol sample wastaken at: <date><time>
SapOsCol collection interval: <number_of_seconds> sec.

Interval

Recommended minimum is5 minutes.

SAP Spool Queue

Thiscounter returnsthe current number of SAP spool queue entriesthat match the specified criteria.
Parameter

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.
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Request Satus

Request statusthat you want to monitor. This parameter is predefined and single-selectable. Possible
values are:

Problem
Processing (default)
Succeeded

Without

Data Point

Primary Data Point

The primary data point (PDP) for this counter isthe number of current SAP spool queue entriesthat
match the specified criteria. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) is the number of entries in the spool queue for each request status.

Interval

Recommended minimum is5 minutes.

SAP System Log Entries

This counter returns, for the selected time period, the entriesthat match the specified expression.
Param eters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Time Period (Minutes)
Number of minutes back from the current time you want thiscounter to monitor job entries. ecify a
value from 5 to 180 (in minutes). The default value is 60.

Expression
Pattern to useto match the message text in the SAP system log . The default isall. You can either
accept the default or enter a string.

Data Point

Primary Data Point

The primary data point (PDP) isthe number of entriesin the SAP system log that match the selection
criteria.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for each message:
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Severity M essage severity level: Error, Warning, or
Normal.

Time Message time.

Type Work processtype and number.

PID System processidentifier of the work
process.

Client Client number.

User User name.

Tcode Transaction code.

Mno M essage number.

Text M essage text.

Interval

Recommended minimum is 10 minutes.

SAP Top CPU Utilization

Thiscounter returnsthe highest CPU utilization, by process, for the top 40 processeson the SAPR/3
application server.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Data Point

Primary Data Point

The primary data point (PDP) isthe highest CPU utilization value. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for the top 40 processes:

PID System process identifier.
Instance Name of SAP R/3 instance.
Command System process hame.
CPU Util[%)] CPU utilization value.
CPU Time[g] CPU time value.
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Working Set[KB] Top physical memory that isassigned to the process.

Private Pages[KB] Total of the entire memory (physical and virtual)
that isassigned to the process (Windows systems
only, thisvalueis 0 on UNIX).

Prior Process priority.

Interval

Recommended minimum is5 minutes.

SAP Top Load

This counter returnsa maximum workload statistic for the SAP system.
Param eters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count

Maximum number of active servers monitored for workload information. Valid entriesare from 0 to
100. The default is 10.

Sorting Parameter

Workload characteristic you want to monitor. This parameter is predefined and multi-selectable.
Possible values are:

CPU Time

DB Time

Response Time (default)
Transfer Size

Wait Time

Time Metrics

Unitsfor monitoring CPU Time, DB Time, and Response Time, and Wait Time. This parameter is
predefined and single-selectable. Possible values are:

MilliSeconds (default)

Seconds

Sze Metrics

Unit of space for monitoring Transfer Sze. This parameter is predefined and single selectable. Possible
values are:

Bytes
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KiloBytes (default)

MegaBytes

Data Point

Primary Data Point
A primary data point (PDP) isreturned for each combination of parameters. The returned valueisthe
top workload, in time or size. If an error is encountered during data collection, the counter returns 999.
Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for each transaction:

User User name.

Transaction Transaction code name.

Report Report name.

Background Job Name Name of background job, if valid.

Task Type Type of the task.

Response Time Response name.

CPU Time CPU time.

Wait Time Wait time.

DB Time Database time.

Transfer Size Number of transferred bytes.
Interval

Recommended minimum is 10 minutes.

SAP User Function Call
This counter callsany R/3 RFC-enabled function when it isdesigned according the following
ServerVantage rules. This counter enablesyou to create and implement your own custom SAP R/3 counters.

ServerVantage User Function Call Guidelines
I The function name can be any character string.

I The function should have one import, one export, and one table parameter.

Import parameter: SY_PARAMETERS s a character string that serves for passing data from
ServerVantage to R/3 function. You define how thisstringis parsed in R/3 function.

Export parameter: SY_VALUE must be float type and serves for passing data point valuesfrom R/3
function to the Java Agent.

Table parameter: SY_EXTENDED_ DPisan optional parameter that serves for passing intelligent
(extended) data points from R/3 function to Java Agent. It can be any character string. To pass
intelligent data points, you need to include the table header.
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! Parameter names cannot be changed.

Exceptions: You can define any number of exceptions. In the case of an exception within RFM, the
Monitoring tree displays—1 in the primary data Point (PDP) and an exception message in Intelligent
Data Point (IDP).

! In the body of the function, you may use any manipulationsto retrieve data from R/3 and set
SV_VALUE and SV_EXTENDED_DP.

I Thefunction MUST NOT have any GUI or screen output statements, or any statementsrequiring
dialog, interaction, or additional answers.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Function Name

R/3 Remote Function Module (RFM) name.

Parameters

Parametersto passto the function.
Data Point

Primary Data Point

The primary data point (PDP) is the value returned by the R/3 RFM. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) isreturned by the R/3 RFM.

Interval

Not applicable.

SAP Work Processes

This counter returnsthe number of work processesrunning on a SAPinstance according to the specified
criteria.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Process Type

Type of work process. This parameter is predefined and multi-selectable. Possible values are;

BDG Background
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DIA (default) Dialog

ENQ Enqueue

SPO Soool

up2 Update 2

UPD Update
Process Sate

Process state to monitor. Thiscounter is predefined and multi-selectable. Possible values are:
Completed
Running
Stopped

Waiting (default)

Data Point

Primary Data Point
A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
number of work processes. If an error is encountered during data collection, the counter returns 999.
Intelligent Data Point
Theintelligent data point (IDP) liststhe following processinformation:
I Total Work Processes
I Work Processes - Waiting State
I Work Processes - Running State
I Work Processes - Stopped State
I Work Processes - Completed State

The IDP also includes atable with the following information, for each process:

Number Process sequential number.

Type Process type.

Process ID Process system ID.

Status Process status.

Reason Work processiswaiting.

Semaphore Semaphore for which the work processiswaiting.
Restart Restart work process after dump.

Dumps Number of dumps.
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CPU CPU time.

Elapsed Time Previous execution time of request (elapsed).

Client Client number.

User User that isusing the process.

Report Report or tcode name used by the process.

Action What the processisdoing.

Table Database table last accessed by the work process.
Interval

Recommended minimum is 10 minutes.

SAP Workload Statistic

This counter returns selected ST03 workload statistics for selected task types.

Parameters

SAP Instance

Conductor

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Task Type

The task type you want to monitor. This parameter is predefined and multi-selectable. Possible values

are:

ALE
AUTOABA (default)
BCKGRD
BUF.SYN
DIALOG
ENQUEUE
FTP
HTTP
HTTPS
NNTP
RFC
SMTP
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SPOOL
UPDATE
UPDATEZ2

Satistic Name

The workload statistic. This parameter is predefined and multi-selectable. Possible values are:
CPU time avg (ms)

CPU time total(s)

Database calls

Database requests

Database requests. Changes
Database requests: Direct reads
Database requests: Sequential reads
DB timeavg (ms)

DB time total(s)

Dialog Steps (default)

Dialog steps/s

Frontend net time avg (ms)
Frontend net time total(s)

GUI time avg (ms)

GUI time total(s)

Requested kBytes

Response time avg(ms)
Response time total(s)

Roll in time

Roll ins

Roll out time

Roll outs

Roll wait time

Time per DB request

Time per DB request: Changes and commits

Time per DB request: Direct reads
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Time per DB request: Sequential reads
Wait time avg (ms)

Wait time total(s)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
selected workload statistic. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) displays alist of theremaining statistics, for example:
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4} -- web Page Dialog x|
Selected Data Point H
Server: qacsapdb

Workload Statistic (SAP Instance: "C62-gacsapdb-01-000", Task

Counter: Type: "DIALOG", Statistic Name: "Dialog Steps™)
Task: workload

Cateqory: SAP B3 Remote Extended

Task Collection Frequency: 5 minutes

Time /17,2004 4:15:56 PM

Value 569

Description Dialog Steps

Workload for the task type DIALOG:

Instance:
SAP System C&2 Date 17 Bap Z004
Instance no. oL

Server gacszapdb

CPT time 108.& = Databaze calls 43,048
Elapsed Time 15, 624.0 = Database regquests Qi 408
= Direct reads 653, E55
Dialoyg steps 1] - Segquential reads 26,419
Dimlog steps / = .o = Changes 1,734
Av. CPU timea 190, % m=
Av. RBFC4#CPIC time 1l2.5 ms Time per DB request 3.0 as
- Direct reads 1.5 ms
Av. response time 1,504, 2 ms = Sequential reads 5.6 ms
- Aw. walt Time 196, 7 ms - Changes and coumits 15.7 ms
= ar. load time d05. 1 m=
- Aw. roll it+w time 135.2 ms Boll-in time 0.& =
= Av. DB reg. tins 475, 0 m= Fall=aout tins 1.8 =
- Av. engueue Time 4.4 ms Boll walt times 6.3 =5
Ball=ins 1,399
bv. bytes reg. 425, 4 ms Boll-outs 1,388
Frontend:
Av. net time BEZ.Z m= Av. GUOL time 133.5 a=

Currenkt Position ; 1 Total ;1

This is the first datapoint,

Close | Freyigus NERE I

Interval

Recommended minimum is 60 minutes.

SNMP Counters

SNMP Counters

SNMP Remote Monitoring usesthe SNMP service to provide network and system counters. SNMP counters
can beretrieved from any machinethat isrunning an SNMP server. QALoad usesthe default SNMP port.
Although SNMP does not require auser name and password, the SNMP agent must be configured to allow

98



Conductor

read-only access from the Conductor machine. SNMP countersthat are supported by QALoad Remote
Monitoring are categorized below.

ICMP

icmplnMsgs/sec: the rate at which ICMP messages are received

icmplnErrors: the number of ICMP messages received having ICMP errors
IcmplnDestUnreachs: the number of ICMP Destination Unreachable messages received
IcmplnTimeExcds: the number of ICMP Time Exceeded messages received
IcmplnParmProbs: the number of ICMP Parameter Problem messages received

IcmplnSrcQuenchs: the number of ICMP Source Quench messages received
icmplnRedirects/sec: the rate at which ICMP Redirect messages are received
icmplnEchos/sec: therate at which ICMP Echo messages are received
icmplnEchoReps/sec: therate at which ICMP Echo Reply messages are received
icmplnTimestamps/sec: the rate at which ICMP Timestamp messages are received
icmplnTimestampReps/ sec: therate at which ICMP Timestamp Reply messages are received
icmplnAddrMasks: the number of ICMP Address Mask Request messages received
icmplnAddrMaskReps: the number of ICMP Address Mask Reply messages received
icmpOutMsgs/ sec: therate at which ICMP messages are sent

icmpOutMsgs/ sec: the number of ICMP messages not sent dueto ICMP errors
icmpOutDestUnreachs: the number of ICMP Destination Unreachable messages sent
icmpOutTimeExcds: the number of ICMP Time Exceeded messages sent
icmpOutParmProbs: the number of ICMP Parameter Problem messages sent
icmpOutSrcQuenchs; the number of ICMP Source Quench messages sent
icmpOutRedirects/ sec: the number of ICMP Redirect messages sent
icmpOutEchos/sec: the number of ICMP Echo messages sent
icmpOutEchoReps/sec: the number of ICMP Echo Reply messages sent
icmpOutTimestam ps/sec: the number of ICMP Timestamp messages sent
icmpOutTimestam pReps/ sec: the number of ICMP Timestamp Reply messages sent
icmpOutAddrMasks: the number of ICMP Address Mask Request messages sent
icmpOutAddrMaskReps: the number of ICMP Address Mask Reply messages sent

IP

ipForwarding: the indication of whether thisentity isacting asan IP router in respect to the forwarding of
datagramsreceived by, but not addressed to, this entity.

ipDefaultTTL: the default value inserted into the Time-To-Live field of the IP header of datagrams
originated at thisentity, whenever a TTL value isnot supplied by the transport layer protocol.
iplnReceives/sec: the rate of input datagramsreceived from interfaces, including those received in error.
iplnHdrErrors: the number of input datagrams discarded due to errorsin their IP headers, including bad
checksums, version number mismatch, other format errors, time-to-live exceeded, errors discovered in
processing their IP options, and so on.

iplnAddrErrors: the number of input datagrams discarded because the IP addressin their IP header's
destination field was not avalid addressto be received at thisentity.

ipForwDatagram s/ sec: therate of input datagrams for which thisentity wasnot their final IP destination,
asaresult of which an attempt was made to find aroute to forward them to that final destination.
iplnUnknownProtos: the number of locally-addressed datagrams receive successfully but discarded
because of an unknown or unsupported protocol.

iplnDiscards: the number of input IP datagrams for which no problemswere encountered to prevent their
continued processing, but which were discarded (for example, for lack of buffer space).

iplnDelivers/ sec: the rate of input datagrams successfully delivered to IP user-protocols (including ICMP).
ipOutRequests: the number of IP datagramswhich local IP user-protocols (including ICMP) supplied to IP
in requests for transmission.

ipOutDiscards: the number of output IP datagrams for which no problem was encountered to prevent
their transmission to their destination, but which were discarded (for example, for lack of buffer space).
ipOutNoRoutes: the number of IP datagrams discarded because no route could be found to transmit them
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to their destination.

ipReasm Timeout: the maximum number of secondswhich received fragmentsare held while they are
awaiting reassembling at this entity.

ipReasm Reqds: the number of IP fragments received which needed to be reassembled at this entity.
ipReasm OKs: the number of IP datagrams successfully re-assembled.

ipReasm Fails: the number of failures detected by the IP re-assembly algorithm (for whatever reason: timed
out, errors, etc).

ipFragOKs: the number of IP datagramsthat have been successfully fragmented at this entity.

ipFragFails: the number of IP datagramsthat have been discarded because they needed to be fragmented at
thisentity but could not be, for example, because their Don't Fragment flag was set.

ipFragCreates/ sec: the rate of IP datagram fragmentsthat have been generated as a result of fragmentation
at thisentity.

ipRoutingDiscards: the number of routing entrieswhich were chosen to be discarded even though they
arevalid.

NMP

snmplnPkts/sec: the rate of messages delivered to the SNMP entity from the transport service.
snmpOutPkts/ sec: the rate at which SNMP M essages were passed from the SNMP protocol entity to the
transport service.

snmplnBadVersions: the number of SNMP messages which were delivered to the SNMP entity and were
for an unsupported SNMP version.

snmplnBadCommunityNames: the number of SNMP messages delivered to the SNMP entity which used a
SNMP community name not known to said entity.

snmplnBadCommunityUses: the number of SNMP messages delivered to the SNMP entity which
represented an SNMP operation which was not allowed by the SNMP community named in the message.
snmplnASNParseErrs: the number of ASN.1 or BER errors encountered by the SNMP entity when decoding
received SNM P messages.

snmplnTooBigs: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield istooBig.

snmplnNoSuchNames: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and
for which the value of the error-statusfield isnoSuchName.

snmplnBadValues: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield is badValue.

snmplnReadOnlys: the number valid SNMP PDUs which were delivered to the SNMP protocol entity and
for which the value of the error-statusfield isreadOnly.

snmplnGenErrs: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield is genErr.

snmplnTotalReqVars/sec: the rate of MIB objects which have been retrieved successfully by the SNMP
protocol entity asthe result of receiving valid SNMP Get-Request and Get-Next PDUs.
snmplnTotalSetVars/sec: the rate of MIB objectswhich have been altered successfully by the SNMP
protocol entity asthe result of receiving valid SNMP Set-Request PDUs.

snmplnGetRequests/ sec: the rate of SNMP Get-Request PDUs which have been accepted and processed by
the SNMP protocol entity.

snmplnGetNexts/sec: the rate of SNMP Get-Next PDUswhich have been accepted and processed by the
SNMP protocol entity.

snmplnSetRequests/ sec: the rate of SNMP Get-Response PDUswhich have been accepted and processed
by the SNMP protocol entity.

snmplnGetResponses/sec: the rate of SNMP Set-Request PDUswhich have been accepted and processed
by the SNMP protocol entity.

snmplnTraps: the number of SNMP Trap PDUs which have been accepted and processed by the SNMP
protocol entity.

snmpOutTooBigs: the number of SNMP PDUswhich were generated by the SNMP protocol entity and for
which the value of the error-statusfield istooBig.

snmpOutNoSuchNames: the number of SNMP PDUswhich were generated by the SNMP protocol entity
and for which the value of the error-statusisnoSuchName.
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snmpOutBadValues: the number of SNMP PDUswhich were generated by the SNMP protocol entity and
for which the value of the error-statusfield is badValue.

snmpOutGenErrs: the number of SNMP PDUswhich were generated by the SNMP protocol entity and for
which the value of the error-statusfield is genErr.

snmpOutGetRequests/ sec: the rate of SNMP Get-Request PDUswhich have been generated by the SNMP
protocol entity.

snmpOutGetNexts/sec: the rate of SNMP Get-Next PDUswhich have been generated by the SNMP
protocol entity.

snmpOutSetRequests/sec: the rate of SNMP Set-Request PDUs which have been generated by the SNMP
protocol entity.

snmpOutGetResponses/ sec: the rate of SNMP Get-Response PDUs which have been generated by the
SNMP protocol entity.

snmpOutTraps: the number of SNMP Trap PDUswhich have been generated by the SNMP protocol entity.
snmpOutTraps: indicates whether the SNMP entity is permitted to generate authenticationFailure traps.

TCP

tcpRtoAlgorithm: the algorithm used to determine the timeout value used for retransmitting
unacknowledged octets.

tcpRtoMin: theminimum value permitted by a TCPimplementation for the retransmission timeout.
tcpRtoMax: the maximum value permitted by a TCPimplementation for the retransmission timeout.
tcpMaxConn: thelimit on the total number of TCP connectionsthe entity can support.
tcpActiveOpens: the number of times TCP connections have made a direct transition to the SYN-SENT
state from the CLOSED state.

tcpAttem ptFails: the number of times TCP connections have made a direct transition to the SYN-RCVD
state from the LISTEN state.

tcpEstabResets: the number of times TCP connectionshave made a direct transition to the CLOSED state
from either the ESTABLISHED state or the CLOSE-WAIT state.

tcpCurrEstab: the number of TCP connections for which the current state is either ESTABLISHED or
CLOSE-WAIT.

tcplnSegs/ sec: the rate at which segments are received, including those received in error.
tcpOutSegs/sec: therate at which segments are sent, including those on current connections but
excluding those containing only retransmitted octets.

tcpRetransSegs/ sec: the rate at which segments are retransmitted.

tepinErrs/sec: therate at which segments are received in error.

tcpOutRsts/ sec: the rate at which segments containing the RST flag are sent.

tcpPassiveOpens: the total number of times TCP connections have made a direct transition to the SYN-
RCVD state from the LISTEN state.

UbP

udplnDatagrams/ sec: the rate of UDP datagrams being delivered to UDP users.

udpNoPorts/ sec: therate of received UDP datagrams for which there was no application at the destination
port.

udplnErrors: the number of received UDP datagramsthat could not be delivered for reasons other than
thelack of an application at the destination port.

udpOutDatagrams/sec: therate at which UDP datagrams are sent.

Solaris: Sun System

Collisions/sec: therate of output collisions.

CpuUser%: the percentage of non-idle processor time that is spent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that is spent in system mode.
Cpuldle%: the percentage of idle processor time.

IfInPackets/ sec: the rate of input packets.

IfOutPackets/ sec: therate of output packets.
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IfInErrors: the total number of input errors.

IfOutErrors: the total number of output errors.

Interrupts/sec: the rate of system interrupts.

Pagesln KBytes/ sec: the rate of pagesread in from disk.

PagesOut KBytes/sec: the rate of pageswritten to disk.

Swapln KBytes/sec: the rate at which pages are being swapped in.
SwapOut KBytes/sec: therate at which pages are being swapped out.

HP-UX: HP System

AvgJobsl: the average number of jobsin thelast minute * 100.

AvgJobs5: the average number of jobsin thelast 5 minutes* 100.

AvgJobsl5: the average number of jobsin thelast 15 minutes* 100.

CpuUser%: the percentage of non-idle processor time that isspent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that is spent in system mode.
Cpuldle%: the percentage of idle processor time.

FreeMemory KBytes: the amount of idle memory.

FreeSwap KBytes: the amount of free swap space on the system.

MaxProc: the maximum number of processes allowed.

MaxUserMem KBytes: the amount of maximum user memory on the system.
PhysMemory KBytes: the amount of physical memory on the system.

Users: the number of userslogged on to the machine.

LINUX Memory

AvailableSwvap KBytes: the available swap on the system.
Buffered KBytes: the amount of memory used as buffers.

Cached KBytes: the amount of memory cached.

FreeMemory KBytes: the amount of idle memory.

Shared KBytes: the amount of memory shared.

TotalMemory KBytes: the total amount of memory on the system.
TotalSwap KBytes: the total swap size for the system.

LINUX System

CpuUser%: the percentage of non-idle processor time that is spent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that isspent in system mode.
Cpuldle%: the percentage of idle processor time.

Windows HTTP Server

httpTotalFilesSent: the total number of files sent by thisHTTP server.

httpTotalFilesReceived: the total number of filesreceived by thisHTTP server.
httpCurrentAnonymousUsers: the number of anonymous users currently connected to thisHTTP server.
httpCurrentNonAnonymousUsers: the number of non-anonymous users currently connected to this
HTTP server.

httpTotalAnonymousUsers: the total number of anonymous usersthat have ever connected to thisHTTP
server.

httpTotalINonAnonymousUsers: the total number of non-anonymous usersthat have ever connected to
thisHTTP server.

httpMaximumAnonymousUsers: the maximum number of anonymous users simultaneously connected
to thisHTTP server.

httpMaximumNonAnonymousUsers: the maximum number of non-anonymous users simultaneously
connected to thisHTTP server.

httpCurrentConnections: the current number of connectionsto the HTTP server.
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httpMaximum Connections: the maximum number of simultaneous connectionsto the HTTP server.
httpConnectionAttempts: the total number of connection attemptsto the HTTP server.
httpLogonAttempts: the total number of logon attemptsto the HTTP server.

httpTotalOptions: the total number of requests made to thisHTTP server using the OPTIONSmethod.
httpTotalGets: the total number of requests made to thisHTTP server using the GET method.
httpTotalPosts: the total number of requests made to thisHTTP server using the POST method.
httpTotalHeads: the total number of requests made to thisHTTP server using the HEAD method.
httpTotalPuts: the total number of requests made to thisHTTP server using the PUT method.
httpTotalDeletes: the total number of requests made to thisHTTP server using the DELETE method.
httpTotal Traces: the total number of requests made to thisHTTP server using the TRACE method.
httpTotalMove: the total number of requests made to thisHTTP server using the MOVE method.
httpTotalCopy: the total number of requests made to thisHTTP server using the COPY method.
httpTotalMkcol: the total number of requests made to thisHTTP server using the MKCOL method.
httpTotalPropfind: the total number of requests made to thisHTTP server using the PROPFIND method.
httpTotalProppatch: the total number of requests made to this HTTP server using the PROPPATCH
method.

httpTotalSearch: the total number of requests made to thisHTTP server using the MSSEARCH method.
httpTotalLock: the total number of requests made to thisHTTP server using the LOCK method.
httpTotalUnlock: the total number of requests made to thisHTTP server using the UNLOCK method.
httpTotalOthers: the total number of requests made to thisHTTP server not using the OPTIONS, GET,
HEAD, POST, PUT, DELETE, TRACE, MOVE, MKCOL, PROPFIND, PROPPATCH, MSSEARCH, LOCK or
UNLOCK methods.

httpCurrentCGIRequests: the number of Common Gateway Interface requests currently being serviced by
thisHTTP server.

httpCurrentBGIRequests: the number of Binary Gateway Interface requests currently being serviced by
thisHTTP server.

httpTotal CGIRequests: the total number of Common Gateway Interface requests made to thisHTTP
server.

httpTotalBGIRequests: the total number Binary Gateway Interface requests made to this HTTP server.
httpMaximum CGIRequests: the maximum number of Common Gateway Interface requests
simultaneously processed by thisHTTP server.

httpMaximumBGIRequests: the maximum number of Binary Gateway Interface requests simultaneously
processed by thisHTTP server.

httpCurrentBlockedRequests: the current number of requests being temporarily blocked by thisHTTP
server.

httpTotalBlockedRequests: the total number of requeststhat have been temporarily blocked by thisHTTP
server.

httpTotalRejectedRequests: the total number of requeststhat have been rejected by thisHTTP server.

Windows FTP Server

ftpTotalFilesSent: the total number of files sent by this FTP server.

ftpTotalFilesReceived: the total number of filesreceived by this FTP server.
ftpCurrentAnonymousUsers. the number of anonymous users currently connected to this FTP server.
ftpCurrentNonAnonymousUsers: the number of non-anonymous users currently connected to this FTP
server.

ftpTotalAnonymousUsers: the total number of anonymoususersthat have ever connected to this FTP
server.

ftpTotaINonAnonymousUsers: the total number of non-anonymous usersthat have ever connected to
this FTP server.

ftpMaximumAnonymousUsers: the maximum number of anonymous users simultaneously connected to
this FTP server.

ftpMaximumNonAnonymousUsers: the maximum number of non-anonymous users simultaneously
connected to this FTP server.

ftpCurrentConnections: the current number of connectionsto the FTP server.

ftpMaximum Connections: the maximum number of simultaneous connectionsto the FTP server.
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ftpConnectionAttem pts: the total number of connection attemptsto the FTP server.
ftpLogonAttem pts: the total number of logon attemptsto the FTP server.

WebLogic Counters

WebLogic Remote Extended Counters

The following dynamically discovered WebLogic remote extended counter categories are provided in
QALoad. Each category provides countersthat extend the monitoring of your WebLogic system. The
categories, counter names, and parameters are all dynamically discovered by processing the set of MBeans

availablein the WebLogic M X Server.

WebLogic Application Runtime
WebLogic Connector Service Runtime
WebLogic Deployer Runtime

WebLogic Domain Log Handler Runtime
WebLogic Domain Runtime

WebLogic EB Cache Runtime

WebLogic EB Component Runtime
WeblLogic EB Locking Runtime
WebLogic EB Pool Runtime

WebLogic EB Transaction Runtime
WebLogic Entity EJB Runtime

WebLogic Execute Queue Runtime
WebLogic IDBC Connection Pool Runtime
WebLogic MSConnection Runtime
WebLogic MSConsumer Runtime
WeblLogic MSDestination Runtime
WebLogic MSRuntime

WeblLogic M S Server Runtime

WebLogic Application Runtime

WebLogic M S Session Runtime
WebLogic JTA Recovery Runtime
WebLogic JTA Runtime

WebLogic WM Runtime

WebLogic Log Broadcaster Runtime
WebLogic Message Driven EJB Runtime

WebLogic Migratable Service Coordinator
Runtime

WebLogic Server Life Cycle Runtime
WebLogic Server Runtime

WebLogic Server Security Runtime
WebLogic Servlet Runtime

WeblLogic Sateful EB Runtime
WebLogic Sateless EB Runtime
WebLogic Time Service Runtime
WebLogic Transaction Resource Runtime
WebLogic Web App Component Runtime
WeblLogic Web Server Runtime

The WebLogic Application Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how

WebLogic is configured.

Counters

Description

CachingDisabled .
proxies.

Private property that disables caching in

Boolean Yes Yes
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Returnsfalse if the MBean represented by

this object has been unregistered Boolean Yes Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Data Point

For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values and wildcard patterns, a PDP and IDP are returned for each discovered
combination of parameters.

Datapoint Details b

Server: secotdwvZ, Time: 8192003 6:15:56 PH. Value: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=e=0)

ApplicationBuntime Cachingli=abl=ed

Frivate property that di=sables caching in proEies.

Attribute wvaluss for MBesan:

ApplicationName = wl management internall
Cachingli=zabled = trues
Fegistered = fal=se

il v Lz

Interval

Recommended minimum is5 minutes.
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WebLogic Connector Service Runtime

The WebLogic Connector Service Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

CORREES _ pewipion ‘

Private property that disables caching
in proxies.

CachingDisabled Boolean | Yes | Yes

Returnsthe number of currently

ConnectionPoolCurrentCount .
deployed connection pools.

Integer Yes | Yes

Returnsthetotal number of deployed
ConnectionPoolsTotalCount connection poolsinstantiated since Integer Yes | Yes
the Server startup.

Returnsfalse if the MBean
Registered represented by this object has been Boolean | Yes | Yes
unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Service

Name of the connector service runtime MBean. You can specify one or more names for monitoring. In
any combination, select values from the discovered list, or enter values manually.
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SatType
This parameter appliesonly to the countersthat are returning a count or total
(ConnectionPoolCurrentCount isone examplein this counter category). Possible values are:
ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details g |
Server: secotdwvZ, Time: 8192003 6:15:56 PH. Value: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=e=0)

ApplicationBuntime Cachingli=abl=ed

Frivate property that di=sables caching in proEies.

Attribute wvaluses for MBsan:

ApplicationName = wl management internall
Cachingli=abled trus
Fegistered = fal=se

il v Lz

Interval

Recommended minimum is5 minutes.

WebLogic Deployer Runtime

The WebLogic Deployer Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

M Description

Private property that disables caching in

. Boolean Yes Yes
proxies.

CachingDisabled

Returnsfalseif the MBean represented by

this object has been unregistered. Boolean ves ves

Registered
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Deployer

Name of the deployer runtime MBean. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details £ |
Serwver: secotdvZ. Time: 8-19-2003 6:14:56 FM., Values: 1.00000 ;J
Value : 1 {(Boolean) (True=1, Fal=se=0)

DepleverBuntine CachinglDizabkled

Frivate property that di=sable=s caching in proxies.

Attribute wvalue=s for MBean:

Cachingli=abled = true
Fegistered = fal=se

4 By

Interval

Recommended minimum is5 minutes.

WeblLogic Domain Log Handler Runtime

The WebLogic Domain Log Handler Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
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counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

Description
i i ing i Boolean
CachingDisabled Prlvqte property that disables caching in Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Name
The name of the domain log handler to be monitored. You can specify one or more names for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Data Point

For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Server: secotdvZ, Time: 8-19-2003 6:18:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

DomainlogHandlerBuntime CachingDi=abled

Private property that disables caching in proxies.

Attribute wvaluss for MBean:

Fegistered = fal=e
Cachingli=zabled = trus

il v oz

Interval

Recommended minimum is5 minutes.

WebLogic Domain Runtime

The WebLogic Domain Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters ‘ % UYiRe ‘

Private property that disables
cachingin proxies.

CachingDisabled Boolean | Yes | Yes

Setsthe timeout valuein
milliseconds of the current
deployment to acluster. Thisis
set at the beginning of the
deployment to acluster and is
reset after the deployment.

CurrentClusterDeploymentTimeout Long No Yes

Returnsfalse if the MBean
Registered represented by this object has Boolean | Yes | Yes
been unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.
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Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Data Point

For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

1.00000 2|

Datapoint Details
Eerver: secotdw?, Time: 3-19-2003 6:18:56 FH, Value
Valuse : 1 (Boolean) (Trus=1. Fal===0)

DomainFuntime CachingDizabled

Private property that disables caching in prozies.

Attribute waluss for MBsan:

CachinglDi=zabled = trues
Fegiztered = false
ActivationTime = Mondaw., Augu=st 13, 2003 3:01:35 FH EDT

A v 4

Interval

Recommended minimum is5 minutes.

WeblLogic EJB Cache Runtime

The WebLogic EB Cache Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

COUREES _ oesipton

ActivationCount Returnsthe total number of timesthe Long ves | Yes

EJB was activated.

CacheAccessCount Returnsthet(_)tal number of times EB Long ves | Yes
was accessed in the cache.

CachedBeansCurrentCount E%:rnsthe current number of cached Integer Yes | Yes

. Returnsthe total number of timesthe
CacheHitCount EB was hit in the cache. Long Yes | Yes

CacheMissCount Returnsthetotal number of times an

Long No Yes
attempt to access a bean from the cache
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failed.

Private property that disables caching in

CachingDisabled .
proxies.

Boolean Yes | Yes

A Returnsthetotal number of timesthe
PassivationCount . Long Yes | Yes
EB was passivated.

Returnsfalse if the MBean represented

by this object has been unregistered. Boolean ves | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ActivationCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
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task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Eerver: secotdw?, Time: 8-19-2003 6:20:56 PM, ¥Walue=: 0.00000 :J
Valus : 0 [(Long)

EJBCacheFuntime ActiwvationCount

Feturn=s the total number of bean=s from thi= EJB Home that hawve been
actiwvated.

Attribute walus=s for MBesan:

CacheiccessCount = 0
CachedBeansCurrentCount = [
CachinglDi=zabled = trues
Fegiztered = false
CacheHitCount = 0
ActivationCount = 0O
Fas=ivationCount = 0

il 2

Interval

Recommended minimum is5 minutes.

WebLogic EJB Component Runtime

The WebLogic EBB Component Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters  pesripion |

CachingDisabled Prlva}te property that disables cachingin Boolean Yes Yes
proxies.

DeploymentState Returnscurrent deployment state of the Integer No Yes
module.

Registered Re.turn.sfalse if theM Bean_represented by Boolean Yes Yes
this object has been unregistered.

113



Conductor

Returnsthe deployment's status. The set of
statusisdefined in the EJB Deployment
interface (DEPLOYED, UNDEPLOYED,
ERROR).

Satus Integer Yes Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.

EBName
Theremainder of the EBB component name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

Data Point

For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Serwver: secotdv?, Time: 8192003 6:20:56 PH, ¥alus: 1. 00000 :J
Value : 1 (Boolean) (Trus=1. Fal=ss=0)

EJBComponentRuntime CachingDizabled

Frivate property that disables caching in prozies.

Attribute valuse=s for HBesan:

Statuz = 0
DeplovmentHame = adminszserver app=dir =31b20 _homemsethods ear e1b20_homemsethod= . jar
Fegistered = false

Cachingli=zakbled = trus

A A

Interval

Recommended minimum is5 minutes.

WeblLogic EJB Locking Runtime

The WebLogic EB Locking Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Private property that disables caching in

. Boolean Yes | No
proxies.

CachingDisabled

Returnsthe number of current EB lock

LockEntriesCurrentCount . Integer Yes | No
entries.

LockM anager AccessCount Returnsthe number of accessesto the Long ves | No
lock manager.

Registered Returnsfalse if the MBean represented Boolean ves | No

by this object has been unregistered.

Returnsthe number of objectstimed out

while waiting on the lock. Long Yes | No

TimeoutTotalCount

Returnsthe number of objects waiting

on the lock. Long Yes | No

WaiterTotalCount

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
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parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (LockEntriesCurrentCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details k|
Eerver: secotdw?, Time: 8-19-2003 6:21:56 BHM, ¥Valus: 1. 00000 x|
Value : 1 (Boolean) (Trus=1, Fal=se=0)

EJBLockingRuntimne Cachingli=zabl=ed

Frivate property that dimables caching in proEies.

Attribute valuses for MBsan:

LockEntriesCurrentCount = 0
Fegistered = fal=e=
WaiterTotalCount = 0O
Cachingli=abled = trues
TimeoutTotalCount = 0
LoclkManagericcessCount = 0

il 2

Interval

Recommended minimum is5 minutes.

WebLogic EJB Pool Runtime

The WebLogic EB Pool Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description

Returnsthetotal number of times
AccessTotalCount an attempt was made to get an Long No Yes
instance from the free pool.

Returnsthe number of beans

. Integer Yes Yes
currently in use.

BeansinUseCount

Returnsthe number of bean
BeansinUseCurrentCount instances currently in use from Integer No Yes
the free pool.

Private property that disables

. . . Boolean Yes Yes
caching in proxies.

CachingDisabled

Returnsthetotal number of times
abean instance from this pool
DestroyedTotalCount was destroyed due to anon- Long No Yes
application Exception being
thrown from it.

Returnsthe number of idle beans

in this EB. Integer Yes Yes

IdleBeansCount

Returnsthetotal number of times Long NoO Yes

MissTotalCount X
afailed attempt was made to get
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an instance from the free pool.
An attempt to get a bean from
the pool failsif thereare no

availableinstancesin the pool.

Returnsthe current number of
PooledBeansCurrentCount available bean instancesin the Integer No Yes
free pool.

Returnsfalse if the M Bean
Registered represented by this object has Boolean Yes Yes
been unregistered.

TimeoutTotalCount Returnsthetotal nlumber of Long Yes Yes
timed out transactions.

Returnsthe current number of
WaiterCurrentCount available bean instancesin the Integer No Yes
free pool.

WaiterTotalCount Returnsthe r_1L_|mber of EBs Long Yes Yes
currently waiting.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name

Theremainder of the EB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.
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SatType
This parameter is available for countersthat are returning a count or total (BeansinUseCount isone

examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details §§ |
Server: =szecotdw?. Time: 8-19-2003 6:21:56 P, Values: 0. 00000 :J
Valus : 0 (Integer)

EJEPoolEuntime BeansInlUssCount
Feturh=s the total number of bean instances currently in use from the

free pool.

Attribute wvaluses for MB=san:

Fegiztered = false
TimeoutTotalCount = 0
Bean=InlUs=eCount = 0
Cachingli=abled = trues

IdleBean=Count = 0
WaiterTotalCount = 0

kil vz

Interval

Recommended minimum is5 minutes.

WeblLogic EJB Transaction Runtime

The WebLogic EB Transaction Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

_ cowmes Description | Type

Private property that disables
cachingin proxies.

CachingDisabled Boolean | Yes | Yes

Returnsfalseif the MBean Boolean | Yes | Yes

Registered
g represented by this object has
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been unregistered.

Returnsthe total number of EB
TransactionsCommittedTotalCount | transactionsthat were Long Yes | Yes
committed.

TransactionsRolledBackTotalCount Returns.thetotal number of EB Long Yes | Yes
transactionsrolled back.

TransactionsTimedOutTotalCount Returns.thetotal n.umber of EB Long Yes | Yes
transactionsthat timed out.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total
(TransactionsCommittedTotalCount isone example in thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.
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Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Server: secotdwZ, Time: 8192003 6:18:56 PH. Value: 1. 00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=e=0)

EJBTranzactionFuntime CachingDi=ssbled

Frivate property that disables caching in proEies.

Attribute wvalus=s for MB=an:

Fegiztered = false

TransactionsRol ledBackTotalCount =
TransactionsTimedOutTotalCount = 0
Cachingli=zabled = trus
TransactionsCommittedTotalCount = 0

il v 4

Interval

0

Recommended minimum is5 minutes.

WebLogic Entity EJB Runtime

The WebLogic Entity EIB Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters .
Description

CachingDisabled Prlvgte property that disables caching in Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web

Console Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Application

The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component

The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details 5 A
Server: secotdvZ, Time: B8-19-2003 6:19:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

EntitwEIBRuntime CachingDi=zabled

Private property that disables caching in proxies.

Attribute walues for MBean:

EJBHam= = beanManaged
Cachingli=zabled = trus
Eegiztered = fal=d

il v

Interval

Recommended minimum is5 minutes.

WebLogic Execute Queue Runtime

The WebLogic Execute Queue Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
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counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

Description

Private property that disables

CachingDisabled S .
caching in proxies.

Boolean Yes | Yes

ExecuteThreadCurrentldleCount Ret.urnsthe number of idle threads Integer Yes | Yes
assigned to the queue.

Returnsthe total number of
ExecuteThreadTotalCount execute threads assigned to the Integer No Yes
queue.

Returnsthe number of waiting

PendingRequestCurrentCount requests in the queue.

Integer Yes | Yes

Returnsthetimethat the longest
PendingRequestOldestTime waiting request was placed in the Long Yes | Yes
queue.

Returnsfalse if the MBean
Registered represented by this object has been Boolean | Yes | Yes
unregistered.

Returnsthe number of requests
ServicedRequestTotalCount that have been processed by this Integer Yes | Yes
queue.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Queue
The execution queue name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.
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SatType
This parameter is available for countersthat are returning a count or total (ExecuteThreadTotalCount is
one examplein thiscounter category). Possible values are:
ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.
The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details 5 |
Server: secotdvZ, Time: 8192003 6:20:56 PH. Walue: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=e=0)

ExecutefususFuntine CachinglDi=abled

Frivate property that disables caching in proEies.

Attribute valuses for MBsan:

PendingRequestCurrentCount = 0

ServicedEequestTotalCount = 0

Cachingli=zabled = trus

Fegistered = falss

ExecuteThreadCurrent IdleCount = 2

PendingRequestlldestTime = Tussday, August 19, 2003 &6:21:37 PHM EDT

4 H oz

Interval

Recommended minimum is5 minutes.

WebLogic JDBC Connection Pool Runtime

The WebLogic DBC Connection Pool Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

WL

Counters Type ‘ 7 %

Description

Returnsthe running average

of active connectionsin the
ActiveConnectionsAverageCount thisMBean. The count starts Integer No Yes

at zero each timethe MBean is

instantiated.
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ActiveConnectionsCurrentCount

Returnsthe current number of
active connections.

Integer

Yes

Yes

ActiveConnectionsHighCount

Returnsthe highest number of
active current connections.
The count starts at zero each
timethe
JDBCConnectionPoolRuntime
MBean isinstantiated.

Integer

Yes

Yes

CachingDisabled

Private property that disables
caching in proxies.

Boolean

Yes

Yes

ConnectionDelayTime

Returnsthe number of
millisecondsit takesto get a
physical connection from
database. It is calculated as
summary timeto connect,
divided by summary number
of connections.

Integer

Yes

Yes

ConnectionLeakProfileCount

Returnsthe current number of
connection leak profilesin the
profile storage.

Integer

Yes

Yes

ConnectionsTotalCount

Returnsthe total number of
JOBC connectionsin this
JDBCConnectionPoolRuntime
MBean since the pool was
instantiated.

Integer

Yes

Yes

FailuresToReconnectCount

Returnsthe count of attempts
to refresh aconnection to a
database that failed. Failure
may happen because of
database unavailability or a
broken connection to the
database.

Integer

Yes

Yes

HighestNumAvailable

Returnsthe highest number of
available connectionsin this
pool.

Integer

No

Yes

HighestNumUnavailable

Returnsthe highest number of
unavailable connectionsin
thispool.

Integer

No

Yes

LeakedConnectionCount

Returnsthe number of
connectionsthat were
checked out from the
connection pool but were not
returned to the pool by calling
close ().

Integer

Yes

Yes

MaxCapacity

Returnsthe maximum
capacity of thisconnection

Integer

Yes

Yes
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pool.

NumAvailable

Returnsthe number of
available connectionsin this
pool.

Integer

No

Yes

NumUnavailable

Returnsthe number of
unavailable connectionsin
thispool.

Integer

No

Yes

PoolSate

Returnstrueif the pool is
enabled, false if the pool is
disabled.

Boolean

Yes

Yes

PreparedSatementCacheProfileCount

Returnsthe number of
prepared statement cache
profiling stores cache
snapshotsthat arein external
storage.

Integer

Yes

Yes

PrepSmtCacheHitCount

Returnsthe cumulative,
running count of the use of
each cached statement.

Integer

Yes

Yes

PrepSmtCacheMissCount

Returns a count of the cases
when the cache doesnot have
a cached statement to satisfy a
request.

Integer

Yes

Yes

Registered

Returnsfalse if the MBean
represented by thisobject has
been unregistered.

Boolean

Yes

Yes

SatementProfileCount

Returnsthe number of
statement profiling storesin
external storage.

Integer

Yes

Yes

WaitingForConnectionCurrentCount

Returnsthe current number of
requests waiting for a
connection.

Integer

Yes

Yes

WaitingForConnectionHighCount

Returnsthe highest number of
requests waiting for a
connection. The count starts
at zero each timethe
JDBCConnectionPoolRuntime
MBean isinstantiated.

Integer

Yes

Yes

WaitSecondsHighCount

Returnsthe highest number of
seconds a connection waited.

Integer

Yes

Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
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between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Pool

The connection pool name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ConnectionsTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

127



Conductor

Datapoint Details

Eerver: secotdw?, Time: 8-19-2003 6:20:56 PFM, Values: 1. 00000
Valus : 1 (Integer)

JDBCConnectionFoolRuntine ActiveConnections=CurrentCount
Counter description not defined in MBean metadata.

> b

Attribute walues for MBean:

ActiveConnectionsHighCount = 2
Fegiztered = false
LealkedConnectionCount = 0
FrepStmtCacheli=z=Count = 3
WaitingForConnectionHighCount = 0
FreparedStatemnentCacheProfileCount = 0
FailuresToReconnectCount = 0
WaitSecond=sHighCount = 0
StatemnentProfileCount = 0
ConnectionlelayTime = 71
FrepStmtCacheHitCount = 0

PoolState = true

VerzionJDECDriver = com.pointbass. jdbc . jdbcllniverszallriver
ConnecticnsTotalCount = 2

MaxCapacity = 10
ConnectionleakProfileCount = 0
WaitingForConnectionCurrentCount = 0
ActiveConnectionsCurrentCount = 1
Cachingli=abled = trus

il vz

Interval

Recommended minimum is5 minutes.

WebLogic IMS Connection Runtime

The WebLogic MSConnection Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

CORREES _ Dewrpion |

CachingDisabled Prlva}te property that disables cachingin Boolean ves | Yes
proxies.

Registered Re.turn.sfalself theMBean_represented by Boolean ves | Yes
thisobject has been unregistered.

SessionsCurrentCount Re.turnsthec_:urrent number of sessions for Long Yes Yes
thisconnection.

SessionsHighCount Re.turnsthe peak _number of sessions for Long Yes Yes
thisconnection since the last reset.

SessionsTotalCount Returns_then_umber of sessionson this Long Yes Yes
connection since the last reset.
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Connection
The M Sconnection name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (SessionsTotalCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details : |
Server: secotdvZ, Time: 8192003 6:19:56 PH., Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=e=0]}

JMSConnectionFuntime CachingDissbled

Frivate property that disables caching in proies.

Attribute wvalus= for HBesan:

Cachingli=abled = true
Fegizstered = fal=e

Sezzion=HighCount = 8
Sesz=zionsCurrent Count
SezsionsTotalCount =

A 2

Interval

= 8
g

Recommended minimum is5 minutes.

WeblLogic IMSConsumer Runtime

The WebLogic M SConsumer Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

COLECE Description

Determinesif the consumer is active.
Determineswhether the consumer has a
message listener set up or a synchronous
receive in progress.

Active Boolean Yes | Yes

Returnsthe number of bytes pending
BytesPendingCount (uncommitted and unacknowledged) by Long Yes | Yes
thisconsumer.

Returnsthe number of bytes received by

BytesReceivedCount this consumer since the last reset. Long Yes | Yes

CachingDisabled Prlvqte property that disables caching in Boolean ves | Yes
proxies.

Durable Determineswhether the consumer is Boolean ves | Yes

durable.

Returnsthe number of messages pending
MessagesPendingCount | (uncommitted and unacknowledged) by Long Yes | Yes
thisconsumer.

Returnsthe number of messages received

by this consumer since the last reset. Long Yes | Yes

M essagesReceivedCount
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Returnsfalseif the MBean represented by

thisobject has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Consumer
The M Sconsumer name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (MessagesReceivedCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Server: secotdvZ, Time: 8-19-2003 6:19:56 PH. Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=e==0]}

JMSConsumerFuntime Active

Determines if the consumer active. Determines whether the consumsr has

a mezzage listener set up or a synchronous receive 1n progress.

Attribute walues for MBean:

Fegizstered = fal=e

MeszzagesFPendingCount = 0

Durable = false

Active = true

BvtesReceivedCount = 0

De=tinationHame = sxamplelususSsnd

MeszzagesReceivedCount = 0

BrtesPendingCount = 0

CachinglDi=zabled = trues =

A A

Interval

Recommended minimum is5 minutes.

WebLogic IMSDestination Runtime

The WebLogic MSDestination Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

counters Description
Returnsthe current number of bytes
BytesCurrentCount stored in the destination. Thisdoes not Long Yes | Yes
include the pending bytes.
. Returnsthe peak number of bytes stored
BytesHighCount in the destination since the last reset. Long Yes | Yes
Returnsthe number of pending bytes
BytesPendingCount stored in the destination. Pending bytes Long ves | Yes
are over and above the current number
of bytes.
) Returnsthe number of bytesreceived in
BytesReceivedCount thisdestination since the last reset. Long Yes | Yes
. Returnsthe amount of timein the
BytesThresholdTime threshold condition since the last reset. Long Yes | Yes
CachingDisabled Prlva}te property that disables cachingin Boolean ves | Yes
proxies.
ConsumersCurrentCount | Returnsthe current number of Long Yes | Yes
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consumers accessing thisdestination.

Returnsthe peak number of consumers
ConsumersHighCount accessing thisdestination since the last Long Yes | Yes
reset.

Returnsthe total number of consumers
ConsumersTotalCount accessing thisdestination since the last Long Yes | Yes
reset.

Returnsthe current number of messages
M essagesCurrentCount in the destination. Thisdoesnot include Long Yes | Yes
the pending messages.

Returnsthe peak number of messagesin

M essagesHighCount the destination since the last reset.

Long Yes | Yes

Returnsthe number of pending messages
in the destination. Pending messages are
over and abovethe current number of

M essagesPendingCount messages. A pending message isone that Long Yes | Yes
haseither been sent in atransaction and
not committed, or that has been received
and not committed or acknowledged.

Returnsthe number of messages received

M essagesReceivedCount in thisdestination since that reset. Long ves | Yes
. Returnsthe amount of timein the
MessagesThresholdTime threshold condition since the last reset. Long ves | Yes
Registered Re.turn.sfalsenc theMBean_represented by Boolean ves | Yes
thisobject has been unregistered.
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Destination
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The name of the M Sdestination. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (MessagesReceivedCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details BE:: |
Eerver: secotdw?, Time: 3-19-2003 6:20:56 PM, Value=: 0.00000 :J
Valus : 0 [(Long)

JHMSDestinationFuntime BytesCurrentCount

Feturn= the current number of bytes s=tored in the destination. Thi=

dos=s not include the pending byte=.

Attribute walus=s for MBesan:

MeszzagesCurrentCount = 0
MessagesReceivedCount = 0
BvrtesReceivedCount = 0
Bvte=ThresholdTime = 0
ByrtesCurrentCount = 0
MeszzagesHighCount = 0
ConsunersHighCount = 0
BrtesPendingCount = 0
Mezzage=ThresholdTime
Consumers_urrentCount
BrtesHighCount = 0
ConzumersTotalCount =
CachinglDi=zabled = trues
MeszzagesFendingCount = 0
DesztinationTvpe = Dusus
Fegizstered = fal=e

il 2

Interval

=]

Recommended minimum is5 minutes.

WebLogic IMSRuntime

The WebLogic M SRuntime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
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Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

DGR Description

Private property that disables caching in
proxies.

CachingDisabled Boolean Yes | Yes

. Returnsthe current number of
ConnectionsCurrentCount connections to this WebLogic Server. Long Yes | Yes

Returnsthe peak number of connections
ConnectionsHighCount to thisWebLogic Server sincethe last Long Yes | Yes
reset.

Returnsthe total number of connections
ConnectionsTotalCount made to thisWebLogic Server since the Long Yes | Yes
last reset.

Returnsthe current number of MS
IM SServersCurrentCount serversthat are deployed on this Long Yes | Yes
WebLogic Server instance.

Returnsthe peak number of MSservers
that were deployed on thisWebLogic
Server instance since the server was
started.

IM SServersHighCount Long Yes | Yes

Returnsthe number of MSserversthat
JM SServersTotalCount were deployed on this WebLogic Server Long Yes | Yes
instance since the server was started.

Returnsfalseif the MBean represented

by this object has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.
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M SSrver

The M Sserver name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ConnectionsTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

1.00000 |

Datapoint Details

Eerver: secotdw?. Time: 8-19-2003 6:19:56 PH. Valu=:
Value : 1 (Boolean) (Trus=1, Fal===0)

JHSFEuntime CachingDissbled

Frivate property that disables caching in proxies.

Attribute waluss for MBsan:

ConnectionsCurrentCount = 0
Fegiztered = false
JHSServersCurrentCount = 0
JHSServersHighCount = 0
JHSServersTotalCount = 0
ConnectionsHighCount = 0
ConnectionsTotalCount = 0
Cachingli=zabled = trus

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic IMS Server Runtime

The WebLogic M S Server Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters .
Description
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BytesCurrentCount

Returnsthe current number of bytes
stored on this M Sserver. This does not
include the pending bytes.

Long

Yes

Yes

BytesHighCount

Returnsthe peak number of bytes stored
in the MSserver since the last reset.

Long

Yes

Yes

BytesPendingCount

Returnsthe current number of bytes
pending (unacknowledged or
uncommitted) stored on this M Sserver.
Pending bytes are over and above the
current number of bytes.

Long

Yes

Yes

BytesReceivedCount

Returnsthe number of bytes received on
thisIMSserver since the last reset.

Long

Yes

Yes

BytesThresholdTime

Returnsthe amount of timein the
threshold condition since the last reset.

Long

Yes

Yes

CachingDisabled

Private property that disables caching in
proxies.

Boolean

Yes

Yes

DestinationsCurrentCount

Returnsthe current number of
destinations for this MM Sserver.

Long

Yes

Yes

DestinationsHighCount

Returnsthe peak number of destinations
on thisM Sserver since the last reset.

Long

Yes

Yes

DestinationsTotalCount

Returnsthe number of destinations
instantiated on this M Sserver since the
last reset.

Long

Yes

Yes

MessagesCurrentCount

Returnsthe current number of messages
stored on this M Sserver. Thisdoes not
include the pending messages.

Long

Yes

Yes

M essagesHighCount

Returnsthe peak number of messages
stored in the M Sserver since the last
reset.

Long

Yes

Yes

M essagesPendingCount

Returnsthe current number of messages
pending (unacknowledged or
uncommitted) stored on this M Sserver.
Pending messages are over and above
the current number of messages.

Long

Yes

Yes
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Returnsthe number of messages
M essagesReceivedCount received on thisdestination since the Long Yes Yes
last reset.

Returnsthe amount of timein the

MessagesThresholdTime threshold condition since the last reset.

Long Yes Yes

Returnsfalse if the MBean represented

by this object has been unregistered. Boolean Yes | Yes

Registered

. Returnsthe current number of session
SessionPoolsCurrentCount poolsinstantiated on this M S server. Long Yes Yes

Returnsthe peak number of session
SessionPoolsHighCount poolsinstantiated on this M Sserver Long Yes Yes
sincethelast reset.

Returnsthe number of session pools
SessionPoolsTotalCount instantiated on thisMSserver since the Long Yes Yes
last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

M SSrver

The M Sserver name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (SessionPoolsTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.
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Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details : k|
Eerver: secotdw?, Time: 8-19-2003 6:20 56 PH, Value: 0. 00000 :J
Value : 0 {Long)

JHSServerFuntime BvtesCurrentCount

Feturn=s the current number of bytes stored on thi= JHS =erver. This
doez not i1nclude the pending bytes.

Attribute wvaluss for MBean:

MessagesPendingCount = (0
HeszzagesHighCount = 0
Mes=agesThresholdTine = 0
DeztinationsTotalCount = 5
BvteszsHighCount = 0

SeszzionFPoolsHighCount = 0

SezzionPoolsCurrentCount = 0
HeszzagesCurrentCount = 0
MessagesEeceivedCount = [

Fegiztered = false
Cachingli=abled = trues
BytesPendingCount = [
Bvte=ThresholdTime = 0
BrtesFeceivedCount = I
BytesCurrentCount = [
Sez=zionFPool=TotalCount = (0
DeztinaticonsCurrentCount =
De=ztinationsHighCount = 5

il 2

Interval

5

Recommended minimum is5 minutes.

WebLogic IMS Session Runtime

The WebLogic M S Session Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how

WebLogic is configured.

Counters

Description

Returnsthe number of bytes pending
BytesPendingCount (uncommitted and unacknowledged) for Long Yes | Yes
this session.
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BytesReceivedCount Re_turns_the n_umber of bytes received by Long Yes | Yes
thissession since the last reset.

BytesSentCount RetL_lrnst_he number of bytes sent by this Long ves | Yes
session sincethe last reset.

CachingDisabled angte property that disables cachingin Boolean ves | Yes
proxies.

ConsumersCurrentCount Returnsthecurre_nt ”“T“ber of Long Yes | Yes
consumersfor this session.

ConsumersHighCount Returnsthe_peak_ number of consumers Long ves | Yes
for this session since the last reset.
Returnsthe number of consumers

ConsumersTotalCount instantiated by this session since the last Long Yes | Yes
reset.
Returnsthe number of messages pending

M essagesPendingCount (uncommitted and unacknowledged) for Long Yes | Yes
this session.

M essagesReceivedCount Re_turns_the n_umber of messages sent by Long Yes | Yes
thissession since the last reset.

M essagesSentCount RetL_lrnst_he number of bytes sent by this Long ves | Yes
session since the last reset.

ProducersCurrentCount Returnsthe_current number of producers Long ves | Yes
for this session.

ProducersHighCount Returnsthe_peak_ number of producers Long Yes | Yes
for this session since the last reset.

ProducersTotal Count RetL_lrnst_he number of producers for this Long ves | Yes
session since the last reset.

Registered Re_turn_sfalse|f theMBean_represented by Boolean ves | Yes
this object has been unregistered.

Transacted Returnswhether the session is Boolean ves | Yes
transacted.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Session

The M Ssession name. You can select avalue from the discovered list.

SatType

This parameter is available for countersthat are returning a count or total (ConsumersTotalCount is

one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last

task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Eerver: secotdw?, Time: 8-19-2003 6:21:56 PM, Valus=: 0. 00000 _:J
Valus : 0 (Long)

JMSSes=zionBEuntime BvtesPendingCount

Feturn= the number of bytes pending (uncommitted and unaclknowledged)
for thi=s ses=ion.

Attribute waluss for MBesan:

HezzagesReceivedCount = 0
ConsunersHighCount = 1
Tranzacted = false
ByteszSentCount = 0
AcknowledgeMode = Auto
BvtesPendingCount = 0
FroducerzHighCount = 1
HessagesSentCount = ([
Froducers=TotalCount = [
MessagesFPendingCount = 0
ByrtesReceivedCount = [
FroducersCurrentCount =
Consumers_urrentCount =
Cachingli=zabled = trus
Fegistered = fals=
ConsumnersTotalCount = 1

4 2y

0
1
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Interval

Recommended minimum is5 minutes.

WebLogic JTA Recovery Runtime

The WebLogic JTA Recovery Runtime category includesthe counterslisted in the following table. Some of

the counterslisted in the table may not be available on your system. WebLogic counter categories, counter

names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X

Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters e | TP

Returnswhether the
Transaction Recovery

Active o Boolean | Yes | Yes
Service is currently
activated on this server.
Private property that

CachingDisabled disables cachingin Boolean | Yes | Yes

proxies.

Returnsthe total number
of transactionsthat are
recovered from the
Transaction Log initially.

InitialRecoveredTransaction TotalCount Integer Yes | Yes

Returnsthe percentage of
theinitially recovered
transactionsthat are
completed.

RecoveredTransactionCompletionPercent Integer Yes | Yes

Returnsfalse if the MBean
Registered represented by this object Boolean | Yes | Yes
has been unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
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WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

SatType

This parameter is available for countersthat are returning a count or total
(InitialRecoveredTransaction TotalCount isone example in this counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Server: secotdvZ, Time: 8-19-2003 6:20:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

JTARecovervEuntine Active

Feturn= whether the Transaction Recowvery Service 1= currently activated

on thi=z =server.

Attribute waluss for MBesan:

Active = trues
Cachingli=abled = trues

InitialPecoveredTransactionTotalCount = 0
FecoveredTransactionConpletionPercent = 0
Fegistered = false =
Al M 4

Interval

Recommended minimum is5 minutes.

WebLogic JTA Runtime

The WebLogic JTA Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

WL

Counters Type
— Description _YPe 7
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ActiveTransactionsTotalCount

Returnsthe number of
active transactionson the
Server.

Integer

Yes

Yes

CachingDisabled

Private property that

disables caching in proxies.

Boolean

Yes

Yes

Registered

Returnsfalse if the M Bean
represented by this object
has been unregistered.

Boolean

Yes

Yes

SecondsActiveTotalCount

Returnsthe total number
of seconds for all
committed transactions

Long

Yes

Yes

TransactionAbandonedTotalCount

Returnsthe number of
transactionsthat were
abandoned.

Long

Yes

Yes

TransactionCommittedTotalCount

Returnsthe number of
committed transactions.

Long

Yes

Yes

TransactionHeuristicsTotalCount

Returnsthe number of
transactionsthat
completed with a heuristic
status.

Long

Yes

Yes

TransactionRolledBackAppTotalCount

Returnsthe number of
transactionsthat were
rolled back dueto an
application error.

Long

Yes

Yes

TransactionRolledBackResourceTotalCount

Returnsthe number of
transactionsthat were
rolled back dueto a
resource error.

Long

Yes

Yes

TransactionRolledBackSystem TotalCount

Returnsthe number of
transactionsthat were
rolled back due to an
internal system error.

Long

Yes

Yes

TransactionRolledBack TimeoutTotalCount

Returnsthe number of
transactionsthat were
rolled back dueto a
timeout expiration.

Long

Yes

Yes

TransactionRolledBackTotalCount

Returnsthe number of
transactionsthat were
rolled back.

Long

Yes

Yes

TransactionTotalCount

Returnsthe total number
of transactions processed.
Thistotal includes all

Long

Yes

Yes

144




Conductor

committed, rolled back
and heuristic transaction
completions.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values

manually.
JTA
The JTA MBean name. You can specify one or more names for monitoring. In any combination, select

values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (TransactionTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Server: =ecotdw?, Time: 8192003 6:19:56 PHM, Walue: 0.00000 :J
Value : 0 {Integexr)

JTARuntime Actiwelranzactions=TotalCount

Feturn= the number of active tran=zactionz on the =erver.

Attribute wvalus=s for MB=an:

Second=sActiveTotalCount = 0
Transactionkol ledBackTotalCount = 0
TranzactionHeuristicsTotalCount = 0

Fegistered = fals=

Tran=sactionkol ledBackSy=temTotalCount = 0
TranzactionBRolledBackippTotalCount = 0
TranzactionAbandonedTotalCount = 0

TransactionTotalCount = 0
TransactionBol ledBackTimeout TotalCount = 0
ActiweTransactionsTotalCount = 0

TranzactionCommittedTotalCount = 0
Cachingli=abled = trues
Tran=sactionkol ledBackREesourceTotalCount = 0

il 2

Interval

Recommended minimum is5 minutes.

WebLogic WM Runtime

The WebLogic WM Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

ColiniEs Description

CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.
Returnsthe current amount of free memory

HeapFreeCurrent (in bytes) in the M heap. Long Yes Yes

HeapSizeCurrent Returnsthe current size (in bytes) of the Long Yes Yes
VM heap.

. Returnsfalse if the MBean represented by
Registered this object has been unregistered. Boolean ves Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.
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The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

]

Datapoint Details g

Eerver: zecotdv?, Time: 8192003 6:19:56 PH., Valu=: 1. 00000 :J
Value : 1 (Boolean) (True=1. Fal=e=0)

JVHEuntime_Cachingli=sabled

Frivate property that disables caching in proxies.

Attribute wvalue=s for MBean:

HeapFresCurrent 14234392
JavaVer=zion = 1.3.1_06
HeapSizeCurrent 43488448
JawvaVendor = Sun Microsystems Inc.
Fegistered = false

DSHame = Sun0s

0SVersion = 5.4

Cachingli=abled = true

nooan

kil ay

Interval

Recommended minimum is5 minutes.

WeblLogic Log Broadcaster Runtime

The WebLogic Log Broadcaster Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

M Description
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CachingDisabled Prlvate property that disables cachingin Boolean Yes Yes
proxies.
Returnsthetotal number of log messages

M essagesLogged generated by thisinstance of the WebLogic Long Yes Yes
server.

. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Name
The name of the log broadcaster. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

SatType
This parameter is available for countersthat are returning a count or total (MessagesLogged in this
counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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1.00000 4

Datapoint Details =
Server: =zecotdwZ, Time: 8-19-2003 6:20:56 FH, Value:
Value : 1 (Boolean) (Trus=1, Fal===0)
LogBroadcasterFuntime CachingDi=ssbled

Private property that disables caching in proxies.

Attribute waluss for MBsan:

Fegistered = fal==
Heszzageslogged = 270
Cachingli=abled = trus

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Message Driven EJB Runtime

The WebLogic Message Driven EJB Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

Counters

Description

CachingDisabled Prlvqte property that disables cachingin Boolean Yes Yes
proxies.

JMSConnectionAlive Returns.thestate of the EX's MS Boolean Yes Yes
connection.

Registered Re_turn_sfalse if the MBean .represented by Boolean Yes Yes
thisobject has been unregistered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web

Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
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WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Application

The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select valuesfrom the discovered list, or enter values manually.

Component

The EB component prefix of the EB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
1.00000 x|

Datapoint Dekails 3
Server: secotdw?, Time: 8-19-2003 6:19:56 FH. Value:
Value : 1 {(Boolean) {(Trus=1, Fal=se=0)
Mes=sagelrivenElBRuntime CachingDi=abled

Frivate property that di=mables caching in proEies.

Attribute wvaluses for MBsan:

EJEBHame = jmsMessageformat
CachinglDi=zabled = trug
Fegiztered = false
JHSConnectiondlive = trus

il v 4

Interval

Recommended minimum is5 minutes.

WeblLogic Migratable Service Coordinator Runtime

The WebLogic Migratable Service Coordinator Runtime category includesthe counterslisted in the
following table. Some of the counterslisted in the table may not be available on your system. WebLogic
counter categories, counter names, and parameters are dynamically discovered by processing the set of
MBeansin the WebLogic IM X Server. Which counters are discovered isdetermined by the WebLogic
version you arerunning and how WebLogic is configured.

M Description
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CachingDisabled Prlvate property that disables cachingin Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Service
The name of the migratable service coordinator. You can specify one or more names for monitoring. In
any combination, select values from the discovered list, or enter values manually.

Data Point

For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.

I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details B |
Server: secotdwZ, Time: B-19-2003 6:21:56 PH. Value: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0]}
MigratableServiceCoordinatorBuntime Cachingli=sabled

Frivate property that disables caching in proEies.

Attribute wvalus= for MBsan:

Cachingli=abled = trus
Fegi=stered = fal=e

il 2y

Interval

Recommended minimum is5 minutes.
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WebLogic Server Life Cycle Runtime

The WebLogic Server Life Cycle Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

M Description

CachingDisabled Prlvqte property that disables caching in Boolean Yes Yes
proxies.

Registered Re_turn_sfalse if the MBean _represented by Boolean Yes Yes
thisobject has been unregistered.
Returnsan integer that identifiesthe

SateVal current state of the server. Valuesrange Integer Yes Yes
from O to 8.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Name

The application server name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.

I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.
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The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

E]

Datapoint Details i
1. 00000 :l

Eerver: secotdw?, Time: 8-19-2003 6:20:56 FH. Value:
Value : 1 {(Boolean) {(Trus=1, Fal=se=0]}
ServerlifeCvcleFuntime CachingDi=ssbled

Frivate property that disables caching in proEies.

Attribute wvaluse=s for MBsan:

Cachingli=abled = trus
Fegi=stered = fal=e
State = RUHHIHG
StateVal = 2

A 2y

Interval

Recommended minimum is5 minutes.

WebLogic Server Runtime

The WebLogic Server Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how

WebLogic is configured.

Counters . Type
-_ Description

Returnsthetime when the server was

ActivationTime started. Long Yes | Yes
Returnsthe administration port on

AdministrationPort which thisserver islistening for Integer Yes | Yes
connections.
Returnswhether the

AdministrationPortEnabled AdministrationPort isenabled on the Boolean | Yes | Yes
Server.

AdminServer Checksif the server isan administrator Boolean | Yes | Yes
server.

AdminServerListenPort Return.sthe pqrt on which admln Integer Yes | Yes
server islistening for connections.
Returnsthe secureType on which

AdminServerListenPortSecure | admin server islistening for Boolean | Yes | Yes

connections.
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Private property that disables caching

CachingDisabled . ) Boolean Yes | Yes
in proxies.

ListenPort _Ret_urns_the port on wh_|ch this server Integer ves | Yes
islistening for connections.

Listen PortEnabled Returnswhetherthe default ListenPort Boolean ves | Yes
isenabled on the server.

OAMVersion RetgrnstheOAM version |r_1fo. Integer Yes | Yes
Indicates release level of this server.
Returnsthe current number sockets

OpenSocketsCurrentCount registered for socket muxing on this Integer Yes | Yes
server.

. Returnsfalse if the MBean represented

Registered by this object has been unregistered. Boolean | Yes | Yes
Returnsthe total number of restarts

RestartsTotalCount for thisserver since the cluster waslast | Integer Yes | Yes
activated.
Returnsthetotal number of

SocketsOpenedTotalCount registrations for socket muxing on this | Long Yes | Yes
Server.

<9 Listen Port .Ret.urns.the port on which _th|s server Integer ves | Yes
islistening for SSL connections

<9 Listen PortEnabled Returnsif the default ISSListenPort is Boolean ves | Yes
enabled on the server.

Integer
SateVal Returnscurrent state of the server. Yes | Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select

between the multiple parametersand always end up with avalid combination of parameters. This

parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location
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WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

SatType

This parameter is available for countersthat are returning a count or total (SocketsOpenedTotalCount
isone examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i

Eerver: secotdw?, Time: 2-19-2003 6:19:56 PH. Valus: 1061233688576
Value : 10r1233658384 (Long)

ServerBuntime ActiwvationTimes

Feturn the time when the ssrver was =tarted.

B

Attribute valuse= for HE=san:

SocketzlpenedTotal Count = 2
ActivationTime = Mondaw, August 18, 2003 2:07:383 PH EDT
WeblogicVersion = Weblogic Serwver 7.0 SPZ2 Sun Jan 26 23:09:32 PST 2003 234192

JVHMID = 35456500233173095 secotdv2-null mull-<168041316-7-7005-7005-7200670067005.~700
CachingDi=zabled = true

LiztenAddress = secotdwd-10 4 27 100
State = RUHNHIHG

LiztenPort = 7005

FeztartsTotalCount = [

Fegizstered = fal=e
DpenSocketsCurrentCount = 2
AdninServerHo=st = =scotdwi
SSLLiztenAddress = zecotdvZ-10 4 27 100
AdminServerlistenFort = 7001

AdminServer = fal=e

AdminServerlistenPortSecure = falss

AdministrationPort = 3002

AdminiztrationFortEnabled = falss

CurrentDirectory = ~opt-bea??l2-uszer projects-testdomain~ .
LiztenPortEnabled = true

OAMVerszion = 2
SSLLiztenFort = 700&
SS5LLiztenFPortEnabled = trus
StateWal = 2

a| | al [

Interval

Recommended minimum is5 minutes.
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WebLogic Server Security Runtime

The WebLogic Server Security Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

o Coenpien | e

Private property that
disables caching in proxies.

CachingDisabled Boolean | Yes | Yes

Returnsthe cumulative
InvalidLoginAttemptsTotalCount number of invalid logins Long Yes | Yes
attempted on this server.

Returnsthe highest number
of userswith outstanding
invalid login attemptsfor
this server.

InvalidLoginUsersHighCount Long Yes | Yes

Returnsthe number of
LockedUsersCurrentCount currently locked users on Long Yes | Yes
this server.

Returnsthe cumulative
number of invalid logins
attempted on this server
while the user was locked.

LoginAttemptswWhileLockedTotalCount Long Yes | Yes

Returnsfalse if the MBean
Registered represented by this object Boolean | Yes | Yes
has been unregistered.

Returnsthe number of times
UnlockedUsersTotalCount a user was unlocked on this Long Yes | Yes
server.

Returnsthe cumulative
UserLockoutTotalCount number of user lockouts Long Yes | Yes
done on this server.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

SatType
This parameter is available for countersthat are returning a count or total
(InvalidLoginAttemptsTotalCount isone examplein this counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

|

Datapoint Details
Eerver: =secotdw?, Time: 8-19-2003 6:21-:56 PM, Valus: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

ServerSecurltyFuntime CachingDi=sasbled

Private property that disables caching in proxies.

Attribute walues for MBean:

Logindttenpt=WhilelockedTotalCount = 0
TzerlockoutTotalCount = 0
MlockedlUzersTotalCount = 0

Fegistered = fal=se
InvalidloginAttemptsTotalCount = 0
Invalidloginl=zersHighCount = 0
Cachingli=zabled = trus
LockedUzer=CurrentCount = 0

il v 4

Interval

Recommended minimum is5 minutes.

WebLogic Servliet Runtime

The WebLogic Application Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
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Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

counters Description

Private property that disables caching in

. Boolean Yes | Yes
proxies.

CachingDisabled

Returnsthe average amount of time all
ExecutionTimeAverage | invocations of the servlet have executed Integer Yes | Yes
since it was created.

Returnsthe amount of timethe single
ExecutionTimeHigh longest invocation of the servlet has Integer Yes | Yes
executed since it was created.

Returnsthe amount of timethe single
shortest invocation of the servlet has
ExecutionTimelLow executed since it was created. Note: For Integer Yes | Yes
the CounterMonitor, the difference
option must be used.

Returnsthe amount of time all
ExecutionTimeTotal invocations of the servlet has executed Integer Yes | Yes
since it was created.

Internal Servlet geert\lljlrer;swhether thisisan Internal Boolean No Yes

InvocationTotalCount Returnsthetotal_number of timesthe Integer Yes | Yes
servlet has been invoked.

Returnsthe maximum capacity of this

PoolMaxCapacity servlet for single thread model servlets.

Integer Yes | Yes

Returnsfalseif the MBean represented by

this object has been unregistered Boolean Yes | Yes

Registered

ReloadTotal Count Returnsthe total number of timesthe Integer ves | Yes
servlet has been reloaded.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.
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Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Application

The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Serviet

The serviet name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (InvocationTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I The primary data point (PDP) is the value returned for that counter.
I The intelligent data point (IDP) is the set of values returned for all counters in the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details : A
Eerver: =secotdw?, Time: 8-19-2003 6:21-:56 PM, Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

ServletFuntime Cachinglisabled

Private property that disables caching in proxies.

Attribute walues for MBean:

FoolMaxCapacity = 0
Fegiztered = false
ExecuticnTimelow = 0
FeloadTotalCount 0
ExecutionTimeHigh = 0

ServletFath = <domain<HTE=alm. j=p

ExecutionTimeTotal = 0

InvocationTotalCount = 0

ExecutionTimedverags = [

URL = HTTE:-~secotdwv?:?00]l-console -domain-HTRealmn.jsp

ServletHanse = weblogic managemsnt console webapp . _domain.  ntrealn
Cachingli=zabled = trues

ContextFPath = “console

il 2
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Interval

Recommended minimum is5 minutes.

WebLogic Stateful EJB Runtime

The WebLogic Sateful EJB Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description
CachingDisabled Prlvqte property that disables caching in Boolean Yes No
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered. Boolean ves No
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.
Application
The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.
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Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details s 1 k|
Server: secotdwv?, Time: 8192003 6:20:56 FM. Value: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0)

Stateful EJBERuntime CachinglDi=zabl=ed

Frivate property that dimables caching in proEies.

Attribute wvalus=s for MB=an:

EJBHame = =statefulSse=s=s=ion
Cachingli=abled = trus
Fegiztered = false

il 2

Interval

Recommended minimum is5 minutes.

WebLogic Stateless EJB Runtime

The WebLogic Sateless EB Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how

WebLogic is configured.

ColiniEs Description

CachingDisabled _anate_property that disables caching Boolean Yes Yes
in proxies.
. Returnsfalseif the MBean represented
Registered by this object has been unregistered. Boolean Yes Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Application

The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component

The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
Theremainder of the EIB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details H K|
Eerver: secotdw?, Time: 8-19-2003 6:1%-S5¢ PH, ¥Valus: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal=se=0)

Statelez=EJBFuntime CachingDi=abled

Frivate property that dimables caching in proEies.

Attribute wvalus=s for HB=an:

Fegiztered = false
CachinglDi=zabled = trues
EJEBName = receivelnT=

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Time Service Runtime

The WebLogic Time Service Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
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Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

CachingDisabled Prlva}te property that disables cachingin Boolean ves | Yes
proxies.
Returnsthe total number of exceptions

ExceptionCount thrown while executing scheduled Integer Yes | Yes
triggers.

ExecutionCount Returnsthetotal number of triggers Integer ves | Yes
executed.

ExecutionsPerMinute Returnsthe average number of triggers Integer Yes | Yes
executed per minute.

Registered Re.turn.sfalse if the MBean _represented by Boolean ves | Yes
thisobject has been unregistered.

ScheduledTriggerCount Returnsthe U“mbef of currently active Integer Yes | Yes
scheduled triggers.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Name
The name of the time service. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (ExecutionCount isone
examplein thiscounter category). Possible values are:
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ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details : |
Serwver: secotdvZ, Time: 8192003 6:1%:56 PM. Walue: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=se=0)

TimeServiceRuntine Cachingli=abl=ed

Frivate property that dimables caching in proEies.

Attribute valuss for MBsan:

Fegiztered = false
ExceptionCount = 0
CachingDi=abled = trus
ExecutionsPerMinute = 21
ExecutionCount = 34696
ScheduledTriggerCount = 11

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Transaction Resource Runtime

The WebLogic Transaction Resource Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

oL omrpuon ||

Private property that
disables caching in proxies.

CachingDisabled Boolean | Yes | Yes

Returnsfalse if the M Bean
Registered represented by this object Boolean | Yes | Yes
has been unregistered.

Returnsthe number of

committed transactions. Long Yes | Yes

TransactionCommittedTotalCount
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Returnsthe number of
TransactionHeuristicCommitTotalCount transactions for which this Long Yes | Yes
resource hasreturned a

heuristic commit decision.

Returnsthe number of
TransactionHeuristicHazardTotalCount transactions for which this Long Yes | Yes
resource hasreported a

heuristic hazard decision.

Returnsthe number of
TransactionHeuristicMixedTotalCount transactions for which this Long Yes | Yes
resource hasreported a

heuristic mixed decision.

Returnsthe number of
TransactionHeuristicRollbackTotalCount transactions for which this Long Yes | Yes
resource hasreturned a

heuristic rollback decision.

Returnsthe number of
TransactionHeuristicsTotalCount transactlons'Fhat . Long Yes | Yes
completed with a heuristic

status.

Returnsthe number of
TransactionRolledBackTotalCount transactionsthat were Long Yes | Yes
rolled back.

Returnsthe total number
of transactions processed.
. Thistotal includes all
TransactionTotalCount committed, rolled back and Long Yes | Yes
heuristic transaction

completions.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
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Transaction Runtime

The JTA runtime name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Component

The JTA component name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total
(TransactionCommittedTotalCount isone examplein this counter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

|

Datapoint Details
Server: secotdvZ, Time: 8-19-2003 6:20:5 PH, Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1., Fal===0)

TransactionREesourceRuntime CachingDisabled

Private property that disables caching in proxies.

Attribute walues for MBsan:

TranzactionTotalCount = 1
TransactionBEol ledBackTotalCount = 0

TransactionHeuristicHazardTotalCount = 0
TransactionHeuristic=TotalCount = 0
Cachingli=zabled = trus
TransactionHeuristicCommitTotalCount = 0

Fegistered = fal=se
TransactionCommittedTotal Count = 1
TransactionHeuristicHizedTotalCount = 0
Fezourcelamnse = weblogic. jdbc. jt=s . Connection
TransactionHeuristicRol lbackTotalCount = 0

il 2y

Interval

Recommended minimum is5 minutes.

WebLogic Web App Component Runtime

The WebLogic Web App Component Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
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counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

CachingDisabled

Description

Private property that disables
caching in proxies.

Boolean

Yes

DeploymentSate

Returnsthe current deployment
state of the module.

Integer

No

Yes

IndexDirectoryDisabled

Returnsthe directory indexing
indicator configured in
weblogic.xml.

Boolean

No

Yes

JSPDebug

Returnsthe JSP'sdebug/line
numbers parameter values
configured in weblogic.xml.

Boolean

No

Yes

JSPKeepGenerated

Returnsthe JSP's KeepGenerated
parameter value configured in
weblogic.xml.

Boolean

No

Yes

JSPPageCheckSecs

Returnsthe JSP's PageCheckSecs
value configured in weblogic.xml.

Long

No

Yes

JSPVerbose

Returnsthe JSP's Verbose parameter
value configured in weblogic.xml.

Boolean

No

Yes

Open SessionsCurrentCount

Returnsthe current total number of
open sessionsin thiscomponent.

Integer

Yes

Yes

Open SessionsHighCount

Returnsthe highest of the total
number of open sessionsin this
server. The count starts at zero each
timethe server isactivated. Note
that thisisan optimization method
for ahighly useful statistic that
could beimplemented less

efficiently using change notification.

Integer

Yes

Yes

Registered

Returnsfalse if the MBean
represented by this object has been
unregistered.

Boolean

Yes

Yes

ServletReloadCheckSatus

Returnsthe servlet reload check

seconds configured in weblogic.xml.

Integer

No

Yes
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Returnsthe session's cookie max age

configured for http sessions. Integer No ves

SessionCookieM acAgentSecs

SessionlnvalidationInterval Secs Returnsthe|_nvalldat|on check t_|mer Integer No Yes
interval configured for http sessions.

Returnsthe session monitoring
SessionMonitoringEnabled indicator configured in Boolean | No Yes
weblogic.xml.

Returnsthe total number of sessions

SessionsOpenedTotalCount ) )
opened in thisserver.

Integer Yes | Yes

Returnsthetimeout configured for

Session TimeoutSecs -
http sessions.

Integer No Yes

Returnsthe single threaded servlet
SngleThreadServletPoolSze pool size configured in Integer No Yes
weblogic.xml.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

SatType

This parameter is available for countersthat are returning a count or total (OpenSessionsCurrentCount
isone examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.
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Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details s |
Server: secotdwv?, Time: 8192003 6:20:56 FM. WValue: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0])

WebAppComponentBuntime CachingDi=ssbled

Frivate property that dimables caching in proEies.

Attribute wvaluses for MBsan:

OpenSe=z=ionsHighCount = 0
Fegistered = false
SezsionslpenedTotal Count
DpenSesz=zionsCurrentCount
Sourcelnfo = exanpleslsbipp
Statuz = DEPLOYED
Cachingli=abled = trus
ConponentHame = ezamnplesiisbipp

0
0

ContextBEoot = ~ezampleslisebipp =
Kl b 4
Interval

Recommended minimum is5 minutes.

WeblLogic Web Server Runtime

The WebLogic Web Server Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters ..
Description

CachingDisabled Prlvgte property that disables caching in Boolean Yes Yes
proxies.
DefaultW ebServer Returpswhether it isthe defaultWebServer Boolean No Yes
or aVirtualHost.
. Returnsfalse if the MBean represented by
Registered this object has been unregistered. Boolean ves ves
Parameters
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The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values

manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details 2 |
Server: =s=ecotdw?, Time: 8192003 6:20:56 FM, Values: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal=e=0)

WebServerRuntime Cachinglisabled

Friwvate property that disables caching in proEies.

Attribute walues for MBsan:

CachinglDi=zabled = trus
Fegiztered = false
WebServerHame = sxamnplesssrver

il 2

Interval

Recommended minimum is5 minutes.

WebSphere Counters

WebSphere Remote Extended Counters

The following dynamically discovered WebSphere remote extended counter categories are provided in
QALoad. Each category provides countersthat extend the monitoring of your WebSphere system. The
categories, counter names, and parameters are all dynamically discovered by processing data available from
the WebSphere Performance Monitoring Infrastructure.

Remote monitoring supports WebSphere versions: 4.0+, 5.0, and 6.0. The counters supported vary by
version.
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WebSphere Alarm Manager Counters WebSphere ORB Perf Module
WebSphere Bean Module WebSphere Scheduler Module
WebShere Cache Module WebShere Servlet Sessions Module
WebSphere Connection Pool Module WebShere System Module
WebSphere DCS Sack Counters WebSphere Thread Pool Module
WebShere High Availability Manager Counters WebSphere Transaction Module
WebSphere 2C Module WebSphere Web App Module
WebSphere VM Runtime Module WebSphere Web Services Counters

WebSphere Alarm Manager Counters

The counters discovered for the WebSphere Alarm Manger category are determined by the level of metrics
you set in WebSphere. The WebSphere Alarm Manager data counters may include the following counters:;

Counter Name (6.0 Counter Name Descrintion WebSphere
and greater) (5.0 or earlier) P Version
Total number of
alarms created by all 50 and
AlarmsCreatedCount asynchronous scopes ) High Long
. above
for this
.WorkManager.
Number of alarms 50 and
AlarmsCancelledCount cancelled by the ) High Long
L above
application.
AlarmsFredCount Number of alarms 5.0 and High Long
fired. above
AlarmLatencyDuration !_atency of alarmsfired | 5.0 and High Load
in milliseconds. above
AlarmsPendingSze Nu'm' ber of glarms 5.0and High Load
waiting to fire. above
AlarmRate l\_lgmber of alarms 5.0and High Load
firing per second. above

Parameters

The following parameters are valid for this counter category:

Node Name
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Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more serversfor monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of
available instances. The default valueisthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

WebSphere Bean Module Counters

The counters discovered for the WebSphere Bean category are determined by the level of metricsyou set in
WebSphere. The WebShere Bean data counters may include the following counters;

Counter Name (6.0 and Counter Name (5.0 . WebSpher SET
: Description . of
greater) or earlier) e Version Metrics

Number of
. 3.5.5and
CreateCount creates times beans Low Long
above
were created.
Number of
times beans 3.5.5and
RemoveCount removes Low Long
were above
removed.
Number of
times beans
PassivateCount passivates were 3.5.5and Low Long
passivated above
(entity and
stateful).
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ActivateCount

activates

Number of
times beans
were
activated
(entity and
stateful).

3.5.5 and
above

Low

Long

LoadCount

persistence loads

Number of
times bean
datawas
loaded from
persistent
storage
(entity).

3.5.5 and
above

Low

Long

SoreCount

persistence stores

Number of
times bean
datawas
stored in
persistent
storage
(entity).

3.5.5 and
above

Low

Long

InstantiateCount

instantiations

Number of
times bean
objects were
instantiated.

3.5.5 and
above

Low

Long

FreedCount

destroys

Number of
times bean
objects were
freed.

3.5.5 and
above

Low

Long

Ready Count

Num Ready Beans

Number of
concurrently
ready beans
(entity and
session). This
counter was
called
concurrent
activein
Versions
3.5.5+ and
4.0.

3.5.5 and
above

High

Load

LiveCount

concurrent live

Number of
concurrently
live beans.

3.5.5 and
above

High

Load

MethodResponseTime

avg method rsp time

Average
response
timein
milliseconds
on the bean

3.5.5 and
above

High

Long
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methods
(home,
remote,
local).

CreateTime

avg method rsp time
for create

Averagetime
in
milliseconds
a bean create
call takes,
including
thetime for
theload, if
any.

5.0

Mediu

Long

LoadTime

avg method rsp time
for load

Average time
in
milliseconds
for loading
the bean
data from
persistent
storage
(entity).

5.0

Mediu

Long

SoreTime

avg method rsp time
for store

Average time
in
milliseconds
for storing
the bean
datato
persistent
storage
(entity).

5.0

Mediu

Long

RemoveTime

avg method rsp time
for remove

Averagetime
in
milliseconds
abean entry
call takes,
including
thetime at
the database,
if any.

5.0

Mediu

Long

MethodCallCount

total method calls

Total
number of
method
calls.

3.5.5 and
above

High

Long

174




Conductor

ActivationTime

avg method rsp time
for activation

Average time
in
milliseconds
a
beanActivate
call takes,
including
thetime at
the database,
if any.

5.0

Mediu

Long

PassivationTime

avg method rsp time
for passivation

Average time
in
milliseconds
a

bean Passivat
e call takes,
including
thetime at
the database,
if any.

5.0

Mediu

Long

ActiveMethodCount

active methods

Number of
concurrently
active
methods -
number of
methods
called at the
sametime.

3.5.5 and
above

High

Long

RetrieveFromPoolCount

Per method
invocations

Number of
callsto the
bean
methods
(home,
remote,
local).

3.5.5 and
above

Long

RetrieveFrom PoolSuccessCoun
t

Per method rsp time

Average
response
timein
milliseconds
on the bean
methods
(home,
remote,
local).

3.5.5 and
above

M ax

Long

ReturnsToPoolCount

Per method
concurrent
invocations

Number of
concurrent
invocations
tocall a
method.

5.0

M ax

Load
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RetrieveFromPoolCount

getsFrom Pool

Number of
calls
retrieving an
object from
the pool
(entity and
stateless).

3.5.5 and
above

Low

Long

RetrieveFrom Pool SuccessCoun
t

getsFound

Number of
timesa
retrieve
found an
object
availablein
the pool
(entity and
stateless).

3.5.5 and
above

Low

Long

ReturnsToPoolCount

returnsToPool

Number of
calls
returning an
object to the
pool (entity
and
stateless).

3.5.5 and
above

Low

Long

ReturnsDiscardCount

returnsDiscarded

Number of
timesthe
returning
object was
discarded
because the
pool was full
(entity and
stateless).

3.5.5 and
above

Low

Long

DrainsFromPoolCount

drainsFrom Pool

Number of
timesthe
daemon
found the
pool wasidle
and
attempted to
clean it
(entity and
stateless).

3.5.5 and
above

Low

Long

DrainSze

avgDrainSze

Average
number of
objects
discarded in
each drain
(entity and
stateless).

3.5.5 and
above

Mediu

Long
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PooledCount

avgPoolSze

Number of
objectsin
the pool
(entity and
stateless).

3.5.5 and
above

High

Load

MessageCount

messageCount

Number of
m essages
delivered to
the bean on
M essage
method
(message
driven
beans).

5.0

Low

Long

M essageBackoutCount

m essageBackoutCoun
t

Number of
m essages
failed to be
delivered to
the bean on
M essage
method
(message
driven
beans).

5.0

Low

Long

WaitTime

serverSessionWait

Average time
to obtain a
Server
Session from
the pool
(message
drive bean).

5.0

Mediu

Long

ServerSessionPoolUsage

serverSessionUsage

Percentage of
Server
Session pool
in use
(message
driven).

5.0

High

Load

Parameters

The following parameters are valid for this counter category:

Enterprise Beans (WebSphere Versions 3 and 4)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
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Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Container
Name of bean container to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Bean
Name of Enterprise JavaBeans (EJB) to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Enterprise Beans (WebSphere Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Jar File
Name of jar fileto monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

EB Type
Type of Enterprise JavaBeans (EJB) to monitor.
You can specify one or more typesfor monitoring. In any combination, select values from the
discovered list, or enter values manually.

Bean
Name of Enterprise JavaBeans (EJB) to monitor.
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You can specify one or more names for monitoring. In any combination, select valuesfrom the

discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere

IDPs (Intelligent Data Points): Long or Load.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:

Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

WebSphere Cache Module Counters

Conductor

The countersdiscovered for the Cache category are determined by the level of metricsyou set in
WebShere. The Cache data countersmay include the following counters:

Counter Name (6.0 and
greater)

Counter Name (5.0 or

earlier)

Description

WebSph
ere
Version

Maximum
MaxInMemoryCacheEntryCo maxinMemoryCacheSize number of in- | 5.0 and Low Lon
unt memory above g
cache entries.
Current
InMemoryCacheEntryCount inMemoryCacheSze number of in- | 5.0 and Low Lon
memory above g
cache entries.
Aggregate of
TimeoutlnvalidationCount totalTimeoutinvalidation tgmplate 5.0and Low Lon
timeoutsand above g
disk timeouts.
Requests for
this cacheable 50 and Lon
HitsstnMemoryCount hitssnMemory object served ) Low
above g
from
memory.
Requests for
HitsOnDiskCount hitsOnDisk th|'s cacheable | 5.0 and Low Lon
object served above g
from disk.
ExplicitinvalidationCount explicitinvalidations Total explicit 5.0 and Low Lon
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invalidation
issued for this
template.

above

LrulnvalidationCount

lrulnvalidations

Cache entries
evicted from
memory by a
Least
Recently Used
algorithm.
These entries
are passivated
to disk if disk
overflow is
enabled.

5.0 and
above

Low

Lon

TimeoutlnvalidationCount??

timeoutlnvalidations

Cache entries
evicted from
memory
and/or disk
because their
timeout has
expired.

5.0 and
above

Low

Lon

InMemoryAndDiskCacheEntr
yCount

Entries

Current
number of
cache entries
created from
thistemplate.
Refersto the
per-template
equivalent of
totalCacheSz
e.

5.0 and
above

Low

Lon

MissCount

Misses

Requests for
this cacheable
object that
were not
found in the
cache.

5.0 and
above

Low

Lon

ClientRequestCount

RequestFrom Client

Requests for
this cacheable
object
generated by
applications
running on
the
application
server.

5.0 and
above

Low

Lon

DistributedRequestCount

requestsfFfom VM

Requests for
this cacheable
object
generated by

5.0 and
above

Low

Lon
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cooperating
cachesin this
cluster.

Explicit
invalidations
resulting in
ExplicitMemorylnvalidation explicitinvalidationsFrom an entry 5.0 and Lon
. Low
Count Memory being above g
removed
from

memory.

Explicit
invalidations
ExplicitDiskInvalidationCou . o resulting in
nt explicitinvalidationsFrom

Disk

5.0 and Lon

an entry Low
. above g

being

removed

from disk.

Explicit

invalidations
received for 50 and Lon
ExplicitinvalidationCount explicitinvalidationsNoOp thistemplate ) Low
whereno above 9
correspondin
g entry exists.

Explicit

invalidations

generated

explicitinvalidationsLocal locally, either 5.0and Low Lon
i above g

programmatic

ally or by a

cache policy.

LocalExplicitinvalidationCou
nt

Explicit

invalidations
RemoteExplicitinvalidationC explicitinvalidationsRemot | received from 5.0 and Low Lon
ount e acooperating | above g
MM in this

cluster.

Entries
received from 50 and Lon
RemoteCreationCount remoteCreations cooperating ) Low

: above g
dynamic

caches.

Parameters

The following parameters are valid for this counter category:

Dynamic Cache (WebSphere Version 5)
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Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default valueisthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from thelist of
available instances. The default value isthefirst instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere Connection Pool Module Counters

The counters discovered for the DBC Connection Pool category are determined by the level of metrics you
set in WebSphere. The IDBC Connection Pool data countersmay include the following listed counters.

Performance Monitoring Infrastructure (PM1) collects performance data for 4.0 and 5.0 JDBC data sources.
For a 4.0 data source, the data source name isused. For a 5.0 data source, the Java Naming and Directory
Interface (INDI) nameisused.

Counter Name (6.0 and e ONIEn _ WebSphere | Level of S———
Description —_———— | ==
greater) : Version Metrics ———
or earlier)

Total number 3.55 and
CreateCount Creates of connections o Low Long
above
created.
Bounded
PoolSze Avg Pool Sze Average pool 3.5.5 and High Range
size. above A
Satistic
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FreePoolSze

Free Pool Sze

Average free
pool size.

5.0

High

Bounded
Range
Satistic

AllocateCount

Allocates

Total number
of connections
allocated.

3.5.5 and
above

Low

Long

ReturnCount

Returns

Total number
of connections
returned.

4.0 and
above

Low

Long

WaitingThreadCount

Avg Waiting
Threads

Number of

threadsthat
are currently
waiting for a
connection.

3.5.5 and
above

High

Sat

FaultCount

Connection
Pool Faults

Total number
of faults, such
as, timeouts, in
connection
pool.

3.5.5 and
above

Low

Long

CloseCount

Destroys

Number of
times bean
objects were
freed.

3.5.5 and
above

Low

Long

WaitTime

Avg Wait
Time

Average
waiting timein
milliseconds
until a
connection is
granted.

5.0

Medium

Long

UseTime

Avg Timein
Use

Averagetime a
connection is
used.

5.0

Medium

Long

PercentUsed

Percent Used

Average
percent of the
pool that isin
use.

3.5.5 and
above

High

Sat

PercentMaxed

Percent
M axed

Average
percent of the
timethat all
connections
arein use

3.5.5 and
above

High

Sat

PrepSmtCacheDiscardCount

Satement
Cache discard
count

Total number
of statements
discarded by
the LRU
algorithm of

4.0 and
above

Low

Long

183



Conductor

the statement
cache.

Number of
Number M an aced
ManagedConnectionCount Managed ged 5.0 Low Long
. Connection
Connections . .
objectsin use.
Current
ConnectionHandleCount Number. numberlof 5.0 Low Long
Connections connection
objectsin use
Amount of
timein
JDBC milliseconds
JDBCTime Operation spent 5.0 Medium | Long
Timer executingin
the JDBC
driver.
Concurrent
Waiters
Parameters

The following parameters are valid for this counter category:

JDBC Connection Pools (Versions 3 and 4)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of

available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, enter values manually, or enter wildcard patterns.

Data Source

Name of data source.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

JDBC Connection Pools (Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.
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You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default valueisthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Provider
Name of data source provider to monitor.
You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Data Source
Name of data source to monitor.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Sat, or Bounded Range Satistic.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

WebSphere DCS Stack Counters

The counters discovered for the WebSphere DCS Sack category are determined by the level of metrics you
set in WebSphere. The WebSphere DCS Sack data counters may include the following counters:

Counter Name
(6.0 and Counter Name Description ‘ WebSpher Level of Bt Bl Toae
greater) (5.0 or earlier) Version Metrics

Number of
message buffer
reallocationsdue
to inadequate

Number of buffer size. If this | & 5 404 '
message buffer number islarger | jp o Medium | Long
reallocations than 20 percent

of the number of
sent messages,
you may want to
contact IBM
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Support.

Minimal,
maximal, and
average size (in

Outgomg_ bytes) of the 6.0 and High (AverageQtatistic)
message size messages that above
were sent
through the DCS
stack.
Number of
Number of sent m essages sent 6.0 and High Lon
m essages through the DCS | above 9 9
stack.
Minimal,
maximal and
. average size (in
Incommg_ bytes) of the 6.0 and High (AverageStatistic)
message size above
messages that
were received by
the DCSstack.
Number of Number of
received messages 6.0 and High Lon
1 6SSA0ES received by the above 9 9
9 DCSstack.
Amount of time ﬁ‘g:egzgttgf time
needed for the
L guarantee that 6.0 and .
synchronization . High Sat
rocedure to all view above
<F:)om lete members are
P synchronized.
Number of
Number of messages that
were
messages . o
retransmitted retransmitted 6.0 and . (AverageStatistic)
during the view ’ High
by local above

member during
the view change

changeto ensure
synchronization
with other
members.
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Number of
timesthat the

Number of times
that the

synchronization synchronization 6.0 and Medium | Long
; above
procedure procedure timed
timed out out.
Number of Number of times
timesthat a .
) : that ahigh
high severity ;
; severity
congestion . 6.0 and .
congestion event Medium | Long
event for : above
. for outgoing
outgoing
messages was
messages was .
. raised.
raised
Measuresthe
amount of time 6.0 and Sat
Coalesce Time it actually takes ) Medium
above
to coalesce a
view.
Measuresthe
timetodoa
Join View merge view 6.0 and Hieh Sat
Change Time change. The DCS | above 9
stack is blocked
during thistime.
Measuresthe
timeto do a split
Remove View view change. 6.0 and High Sat
Change Time DCSstack is above 9
blocked during
thistime.
Measuresthe
number of times
Number of that the local 6.0 and .
Y High Long
suspicions mem ber above
suspected other
members.
Number of times
Number of view that thismember | 6.0 and .
. Medium | Long
changes underwent view above
changes.
Measuresthe size
View group size of the group the 6.0 and Medium | (AverageSatistic)
local member above

belongsto.

Parameters

The following parameters are valid for this counter category:
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Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default valueisthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of
available instances. The default value isthefirst instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

WebSphere High Availability Manager Counters

The countersdiscovered for the WebSphere High Availability Manager category are determined by the level
of metricsyou set in WebSphere. The WebSphere High Availability Manager data counters may include the
following counters:

Counter Name (6.0 Counter Name Descrintion WebSphere
and greater) (5.0 or earlier) P Version

Number of local Total number of local | 6.0 and

High Load
groups groups. above

Time taken in
millisecondsto
rebuild the global
group state. During
Group state rebuild the rebuild time, no 6.0 and
time fail-over can happen. | above
If thistimeistoo
high and is
unacceptable for the
desired availability,

High Sat
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you may want to
increase the number
of coordinators. For
proper operation of
this counter, you
must host the active
coordinator in an
application server
other than the
deployment
manager.

Number of bulletin-
board subjects

Total number of
subjects managed.

6.0 and
above

High

Load

Number of bulletin-
board subscriptions

Total number of
bulletin-board
subscriptions.

6.0 and
above

High

Load

Bulletin-board
rebuild time

Time taken in
millisecondsto
rebuild the global
state of the bulletin-
board. During this
time no messages
will be received by
the subscribers. If
thistimeistoo high,
and isunacceptable,
you may want to
increase the number
of coordinators. For
proper operation of
thiscounter, you
must host the active
coordinator in an
application server
other than the
deployment

man ager.

6.0 and
above

High

Sat

Number of local
bulletin-board
subjects

Total number of
subjects being posted
to locally. The
number includesthe
proxy postings (if
any) done by the
core group bridge
service on behalf of
servers belonging to
different WebSphere
cells.

6.0 and
above

High

Load
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Total number of local
subject subscriptions.
The number includes

the proxy
Number of local subscriptions (if any) 6.0 and
bulletin-board done by the core above High Sat
subscriptions group bridge service

on behalf of servers
belonging to
different WebSphere
cells.

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of
available instances. The default valueisthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

WebSphere J2C Connection Pool Module Counters

The countersdiscovered for the 2C Connection Pool category are determined by the level of metricsyou
set in WebShere. The 22C Connection Pool data counters may include the following counters:

Point

Counter Name (6.0 and Counter Description WebSphere Level off Data
Metrics

greater) Name (5.0 Version
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or earlier)

Conductor

Number Number of Managed
. . . . 5.0 and
ManagedConnectionCount | managed Connection objectsin above Low Long
connections | use.
_ Number Current_numbgr of_ 50 and
ConnectionHandleCount . connection objectsin Low Long
connections use above
Number
CreateCount manage(_j Total num ber of 5.0 and Low Long
connections | connections created. above
created
Number Total number of
managed . 5.0 and
CloseCount : connections Low Long
connections destroved above
destroyed yed.
Number Total number of
managed . 5.0 and
AllocateCount : connections Low Long
connections above
allocated.
allocated
Number
FreedCount manage(_j Total num ber of 5.0 and Low Long
connections | connectionsfreed. above
freed
Number of faults, 50 and
FaultCount faults such astimeouts, in ) Low Long
. above
the connection pool.
free pool Number of free 50 and
FreePoolSze reep connectionsin the ) High Sat
size above
pool.
. . 5.0 and .
PoolSize pool size Pool size. above High Sat
Average number of
WaitingThreadCount concurrent thr.egds concurrently 5.0 and High Load
waiters waiting for a above
connection.
Percent Average percent of 50 and
PercentUsed the pool that isin ) High Load
used above
use.
Average percent of
PercentM axed Percent thetlme_that aII_ 5.0 and High Load
maxed connectionsarein above
use.
WaitTime Average Averag_e waiting tim_e 5.0 and Medium | Long
in milliseconds until a
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wait time connection isgranted. | above

Averagetimein

. Average use | millisecondsthat 5.0 and .
UseTime ) . ) Medium | Long
time connectionsarein above
use.
Parameters

The following parameters are valid for this counter category:
J2C Connection Pools (WebSphere Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from thelist of
available instances. The default value isthefirst instancein the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere Java Virtual Machine (VM) Runtime Module Counters

The countersdiscovered for the Java Virtual Machine (VM) category are determined by the level of metrics
you set in WebSphere. The WM data counters may include the following counters:

Counter P Level Data
Description
Counter Name (6.0 Name p WebSphere of Point
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and greater) (5.0 or Version Metrics
earlier)
FreeMemory Free Free memory in VM run time. 3.5.5 and Low Long
memory above
UsedMemory Used Used memory in VM run time. 3.5.5 and Low Long
memory above
HeapSze Total Total memory in VM run time. 3.5.5 and High Long
memory above
UpTime Up time Thea}mountoftlmetheJVM is | 5.0 and Low Long
running. above
Number of garbage collection
Naurlt”)nab(;r calls. Thiscounter isnot 4.0 and
GCCount g 9 available unless - ) M ax Long
collection ) . . . above
calls Xrunpmi Jvnpi Profil er isset
when starting the VM.
A Average garbage collection in
ti\rfne;age seconds between two garbage
GClnterval Time between coll_ectlon. Thiscounter isnot 4.0 and M ax Long
available unless - above
garbage . . . .
collection Xrunpmi Jvnpi Profil er isset
when starting the WM.
A Average duration of a garbage
g/r(;r:g: collection. This counter isnot 4.0 and
GCTime g 9 available unless - ) M ax Long
collection . . . . above
duration Xrunpm Jvipi Profil er isset
when starting the WM.
Number of timesthat athread
num waits for alock.This counter is 4.0 and
WaitsForLockCount waits for not available unless - ) M ax Long
. . . . above
alock Xrunpmi Jvnpi Profil er isset
when starting the WM.
Average time that athread
avgtime waits for alock. This counter is 4.0 and
WaitForLockTime waiting not available unless - ) M ax Long
. . . . above
for lock Xrunpmi Jvnpi Profil er isset
when starting the VM.
Number of objects allocated in
Number heap. This counter isnot 4.0 and
ObjectAllocateCount | of objects | available unless - ) M ax Long
. . . . above
allocated Xrunpm Jvipi Profil er isset
when starting the VM.
ObjectMovedCount
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Number
of objects
found

Number of objectsin heap.
Thiscounter isnot available
unless -

Xrunpmi Jvnpi Profil er isset
when starting the WM.

4.0 and
above

Long

ObjectFreedCount

Number
of objects
freed

Number of objectsfreed in
heap. This counter isnot
available unless -

Xrunpmi Jvnpi Profil er isset
when starting the WM.

4.0 and
above

Long

ThreadSartedCount

Number of threads started. This
counter isnot available unless
the -XrunpmidmpiProfiler
option isset when starting the
NVM.

4.0 and
above

ThreadEndedCount

Number of failed threads. This
counter isnot available unless
the -XrunpmidvmpiProfiler
option isset when starting the
NM.

4.0 and
above

Parameters

The following parameters are valid for this counter category:

JVM Runtime (WebSphere All Versions)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default value isthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Sarver Name

Application server to monitor. Select the server name that you want to monitor from the list of

available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere

IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.
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Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

WebSphere Object Pool Counters

The countersdiscovered for the WebSphere Object Pool category are determined by the level of metrics
you set in WebSphere. The WebSphere Object Pool data counters may include the following counters:

Counter Name (6.0 Counter Name Description WebSpher
and greater) (5.0 or earlier) P Version

. Total number of 5.0 and
ObjectsCreatedCoun objects created. above High Long
Number of objects 50 and
ObjectsAllocatedCount requested from the ) High Long
above
pool.
Number of objects 50 and
ObjectsReturnedCount returned to the ) High Long
above
pool.
Average number of 50 and
IdleObjectsSze idle object instances ) High Load
. above
in the pool.
Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default valueisthe first application server in thelist.

You can specify one or more serversfor monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of
available instances. The default valueisthefirst instancein thelist.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
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Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

WebSphere ORB Perf Module Counters

The countersdiscovered for the Object Request Broker (ORB) category are determined by the level of
metricsyou set in WebSphere. The ORB data counters may include the following counters:

Counter Name (6.0 and Counter Name (5.0 _ WebSphere Level of
. Description . .
greater) or earlier) Version Metrics

Thetime (in
milliseconds)
to look up an
object 5.0 and
reference above
before method
dispatch can
be carried out.

LookupTime referenceLookupTime Medium | Long

The total
number of 5.0 and
RequestCount num Request requests sent above Low Long

to the ORB.

The number
of requests
that are 5.0 and
concurrently above
processed by
the ORB.

ConcurrentRequestCount | concurrentRequests High Load

Thetime (in
milliseconds)
it takesa 50 and
ProcessingTime processingTime registered ) Medium | Long
above
portable
interceptor to
run.

Parameters

The following parameters are valid for this counter category:
Object Request Broker (WebSphere Version 5)

Node Name
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Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of
available instances. The default valueisthe first instancein thelist.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere Scheduler Module Counters

The countersdiscovered for the WebSphere Scheduler category are determined by the level of metrics you
set in WebSphere. The WebSphere Scheduler data counters may include the following counters:

Counter Name (6.0 Counter Name Description WebSphere
and greater) (5.0 or earlier) P Version

. Number of tasksthat 5.0 and
TaskFailureCount failed to run. above High Long
. Number of tasks that 5.0 and
TaskFinishCount ran successfully. above High Long
Number of poll
PollCount cycles completed for Zbo and High Long
ove
all daemon threads.
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TaskFinishRate Number of tasks run 5.0 and High Load
per second. above
Number of collisions
encountered per 50 and
TaskCollisionRate second between ) High Load
. above
competing poll
daemons.
Sart timein
. milliseconds for each 5.0 and .
PollQueryDuration poll daemon thread's | above High Load
database poll query.

. Timein milliseconds | 5.0 and .
RunDuration taken to run atask.. above High Load
TaskExpirationRate Number of tasksin a 5.0 and High Load

poll query. above
Period of timein 50 and
TaskDelayDuration secondsthat the task ; High Load
. above
isdelayed.
PollDuration Number of seconds 5.0 and High Load
between poll cycles. above
Number of tasks run
by each poll daemon
thread. (Multiply this
by the number of 5.0 and .
TaskRunRate poll daemon threads above High Load
to get the tasksrun
per effective poll
cycle.)
Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Server Name
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Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from thelist of
available instances. The default valueisthefirst instancein thelist.

You can specify one or more instances for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere Servlet Sessions Module Counters

The countersdiscovered for the Servlet Sessions category are determined by the level of metricsyou set in
WebSphere. The Servlet Sessions data counters may include the following counters:

Counter Name (6.0 and Counter Name (5.0 - WebSphe
; Description re
greater) or earlier) -

CreateCount createdSessions Nur_nber of 3.5.5 and Low Long
sessions created. above
Number of

. . . . . 3.5.5and

InvalidateCount invalidatedSessions sessions Low Long
. . above
invalidated.

LifeTime sessionLifeTime Aver_age session 3.5.5 and Mediu Long
lifetime. above m
Number of
concurrently
active sessions. A
session isactive if 355 and

ActiveCount activeSessions WebSphereis abdve High Load
currently
processing a
request that uses
that session.
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LiveCount

liveSession

Number of
sessionsthat are
currently cached
in memory.

5.0 and
above

High

Load

NoRoomForNewSessionCo
unt

NoRoom ForNew Sessi
on

Appliesonly to
session in memory
with
AllowOverflow=fal
se. The number of
timesthat a
request for anew
session cannot be
handled because it
would exceed the
maximum session
count.

5.0

Low

Long

CacheDiscardCount

cacheDiscards

Number of session
objectsthat have
been forced out of
the cache. (An
LRU algorithm
removesold
entriesto make
room for new
sessions and cache
misses). Applicable
only for persistent
sessions.

5.0

Low

Long

ExternalReadTime

externalReadTime

Time (in
milliseconds)
taken in reading
the session data
from persistent
store. For multi-
row sessions, the
metrics are for the
attribute; for
single-row
sessions, the
metrics are for the
whole session.
Applicable only
for persistent
sessions. When
usingaJVs
persistent store,
you havethe
choice of whether
to serializethe
data being
replicated. If you
choose not to

504

Mediu

Long
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serialize the data,
the counter isnot
available.

ExternalReadSze

externalReadSze

Sze of session data
read from
persistent store.
Applicable only
for (serialized)
persistent sessions;
similar to
externalReadTime
above.

5.0

Mediu

Lon

ExternalWriteTime

externalWriteTime

Time
(milliseconds)
taken to write the
session data from
the persistent
store. Applicable
only for
(serialized)
persistent sessions.
Smilar to
externalReadTime
described above.

5.0

Mediu

Lon

ExternalWriteSze

externalWriteSze

Sze of session data
written to
persistent store.
Applicable only
for (serialized)
persistent sessions.
Smilar to
externalReadTime
described above.

5.0

Mediu

Lon

AffinityBreakCount

affinityBreaks

The number of
requests received
for sessionsthat
were last accessed
from another Web
application. This
can indicate
failover processing
or acorrupt plug-
in configuration.

5.0

Low

Long

SessionObjectSze

serializableSessObjSiz
e

The size in bytes
of (the attributes
that can be
serialized) in-
memory sessions.
Only count
session objects
that contain at

5.0

M ax

Long
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least one attribute
object that can be
serialized. Note
that a session may
contain some
attributesthat can
be serialized and
some that are not.
Thesizein bytesis
at asession level.

TimeSncelLastActivated

timeSnceLastActivat
ed

Thetime
differencein
milliseconds
between previous
and current access
time stamps. Does
not include
session time out.

5.0

Mediu

Long

TimeoutlnvalidationCount

invalidatedViaTimeo
ut

The number of
requests for a
session that no
CountSatistic
exists, presumably
because the
session timed out.

5.0

Low

Long

ActivateNonExistSessionCo
unt

attemptToActivateN
ot ExistentSession

Number of
requests for a
session that no
longer exists,
presumably
because the
session timed out.
Use thiscounter to
help determine if
thetimeout istoo
short.

5.0

Low

Long

Parameters

The following parameters are valid for this counter category:

Servlet Sessions (WebSphere Versions 3 and 4)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Server Name
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Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Servlet Sessions (WebSphere Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default valueisthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

War File
Name of war fileto monitor.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere System Module Counters

The countersdiscovered for the System category are determined by the level of metricsyou set in
WebShere. The System data counters may include the following counters:
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CPUUsageSncelLastM easuremen
t

percentCpuUsage

Average system
CPU utilization
taken over the
timeinterval
since the last
reading. Because
thefirst call is
required to
perform
initialization, an
invalid value
such asOis
returned. All
subsequent calls
return the
expected value.
On SMP
machines, the
valuereturned is
the utilization
averaged over all
CPUs.

5.0

Low

Lon

FreeMemory

freeMemory

The amount of
real free memory
available on the
system. Real
memory that is
not allocated is
only alower
bound on
available real
memory, since
many operating
systemstake
some of the
otherwise
unallocated
memory and use
it for additional
1/0O buffering.
The exact
amount of buffer
memory that can
be freed up is
dependent on
both the
platform and the
application(s)
running on it.

5.0

Low

Lon

CPUUsageSnceServerSarted

avgCpuUtilizatio
n

The average
percentCpuUsag
ethat isbusy
after the server is

5.0

Mediu

Lon
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started.

Parameters

The following parameters are valid for this counter category:
System Performance (WebSphere Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthefirst nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere Thread Pool Module Counters

The counters discovered for the Thread Pool category are determined by the level of metricsyou set in
WebShere. The Thread Pool data counters may include the following counters:

Counter (CORITE
Name (6.0 Description WebSpher
(5.0 or - - - Version .
and greater) Metrics

earlier)

CreateCount Thread Total number of threads created. 3.5.5 and Low Long
creates above

DestroyCount Thread Total number of threads destroyed. 3.5.5and Low Long
destroys above

ActiveCount Active Number of concurrently active 3.5.5and High Load
threads threads. above

PoolSze Pool size Average number of threadsin pool. 3.5.5 and High Load
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above
PercentM axed Percent Average per_cent of thetime that all 3.5.5and High Load
maxed threadsarein use. above
Parameters

The following parameters are valid for this counter category:

Thread Pools (WebSphere All Versions)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Pool
Name of thread pool to monitor.

You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere Transaction Module Counters

The countersdiscovered for the Transaction category are determined by the level of metricsyou set in
WebSphere. The Transaction data counters may include the following counters:

Counter Name (6.0 and Counter Name . WebSpher
. Description .
greater) (5.0 or earlier) e Version
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Total number of
Number global lobal 4.0 and
GlobalBegunCount transactions g . y Low Long
transactions above
begun
begun on server.
Total number of
global
Number global transactions 4.0 and
GloballnvolvedCount transactions involved on ) Low Long
. above
involved server (for
example, begun
and imported).
Number local Total number of
. . 4.0 and
LocalBegunCount transactions local transactions Low Long
above
begun begun on server.
Number of
ActiveCount Active g!obal coqcurrently 3.5.5and Low Load
transactions active global above
transactions.
Number of
Local ActiveCount Active Igcal coqcurrently 4.0 and Low Load
transactions active local above
transactions.
Global Average duration .
GlobalTranTime transactions of global 3.5.5 and Mediu Sat
: . above m
duration transactions.
. Local transaction Average duration 4.0 and Mediu
LocalTranTime . of local Sat
duration . above m
transactions.
Average duration
GlobalBeforeCompletionTim Local transactlo_ns of : 4.0 and Mediu
before_completio before_completio Sat
e . above m
ntime n for local
transactions.
Global Q]Zlg)arlﬁ;ci{f;gtrlon 4.0 and Mediu
GlobalCommitTime transaction ) Sat
S global above m
commit time .
transactions.
Global of peparefor | 40and | Medic
GlobalPrepareTime transaction brep ’ Stat
: global above m
preparetime .
transactions.
Local transaction Average duration i
LocalBeforeCompletionTime | before_completio of :b%\?gd medm Sat
ntime before_completio
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n for local
transactions.

Average duration

LocalCommitTime Local t.ran.sact|0n of commit for 4.0 and Mediu Sat
commit time . above m
local transactions.
Number global Total number of
: . global 3.5.5and
CommittedCount transactions . Low Long
. transactions above
committed :
committed.
Number of global Tlootglalnumber of 355 and
RolledbackCount transactions 9 . o Low Long
transactions above
rolled back
rolled back.
Number of global
Number global transactions
. . 4.0 and
OptimizationCount transactions converted to Low Long
o : above
optimized single phase for
optimization.
Number of local Number of local 4.0 and
LocalCommittedCount transactions transactions ) Low Long
X . above
committed committed.
Number of local Number of local 4.0 and
LocalRolledbackCount transactions transactions ) Low Long
above
rolled back rolled back.
Number of global Number of global 4.0 and
GlobalTimeoutCount transactions transactions ) Low Long
. . above
timed out timed out.
Number of local Number of local
. . . 4.0 and
LocalTimeoutCount transactions transactions Low Long
. . above
timed out timed out.

Parameters

The following parameters are valid for this counter category:

Transactions (All Versions)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.
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You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

WebSphere Web App Module Counters

The countersdiscovered for the Web Application category are determined by the level of metricsyou set in

WebSphere. The Web Application data counters may include the following counters:

Counter Name (6.0 Counter Name Description WebSphere Level of
and greater) (5.0 or earlier) P Version Metrics

LoadedServietCount | numLoadedServlets Number of serviets 3.5.5and Low Long
that were loaded. above

ReloadCount num Reloads Number of serviets 3.5.5 and Low Load
that were reloaded. above
Total number of 355 and

RequestCount totalRequests requests a servlet at.)o.ve Low Long
processed.
Number of requests 3.55 and

ConcurrentRequests | concurrentRequests | that are concurrently atl)olve High Sat
processed.
Responsetime, in 3.5.5 and

ServiceTime responseTime milliseconds, of a o Medium | Long

above

servlet request.
Total r'1umber of 355 and

ErrorCount numErrors errorsin aservlet or above Low Long
Java Server Page (JSP).

Parameters

The following parameters are valid for this counter category:

Web Applications (Versions 3 and 4)

Node Name
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Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Srviet
Name of servlet to monitor.
You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Web Applications (Version 5)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of
available nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

War File
Name of war fileto monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Serviet

Name of servlet to monitor.
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You can specify one or more names for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:

Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

WebSphere Web Services Module Counters

The countersdiscovered for the WebSphere Web Service category are determined by the level of metrics

you set in WebSphere. The WebShere Web Service data counters may include the following counters:

Counter
Counter Name (6.0 and Name (5.0 Description WebSphere Level' of
greater) : Version Metrics
or earlier)
LoadedWebServiceCount Number gf loaded 5.02 and Low Long
Web services. above
ReceivedRequestCount Number' of reqqests 5.02 and Low Long
the service received. above
. Number of requests 5.02 and
DispatchedRequestCount the service dispatched. | above Low Long
Number' of requests 502 and
ProcessedRequestCount the service Low Sat
above
successfully processed.
Average response
. time, in milliseconds, 5.02 and .
ResponseTime for asuccessful above High Sat
request.
Average response
RequestResponseTime time, in milliseconds, 5.02 and Medium | Sat
to prepare arequest above
for dispatch.
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Average response

DispatchResponseTime time, in milliseconds, 5.02 and Medium | Sat
. above
to dispatch arequest.
Average response
ReplyResponseTime time, in milliseconds, 5.02 and Medium | sat
to prepare areply after | above
dispatch.
_ Average payload size 502 and _
PayloadSze in bytes of areceived Medium | Sat
above
request or reply.
. Average payload size 5.02 and .
RequestPayloadSze in bytes of a request. above Medium | Sat
' Average payload size 5.02 and .
ReplyPayloadSze in bytes of areply. above Medium | Sat

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of

available nodes. The default value isthe first node in the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of

available servers. The default value isthe first application server in the list.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Instance Name

Instance name to monitor. Select the instance name that you want to monitor from thelist of
available instances. The default value isthefirst instancein the list.

You can specify one or more instances for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Primary Data Point
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The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere IDPs
(Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere MQ Counters

WebSphere MQ Remote Extended Counters

The following extended WebSphere MQ remote countersare provided in QALoad. These counters extend
the monitoring of your WebSphere MQ system:

Channel Events Queue Manager Connections
Channel Satus Queue Manager Events

Error Log Entries Queue Manager Satistics
Percent Queue Depth Queue Manager Up/Down
Performance Events Queue Satistics

Queue Depth

WebSphere MQ Channel Events

This counter reportsthe number of channel events for the current interval.
Parameters

Queue Manager

Queue manager you are monitoring.

Event Name

Soecify the name(s) of the event(s) you want to monitor. All eventson the queue are monitored
unless event name(s) are selected.

Event Name Description

Channel Activated This condition isdetected when achannel that has been
waiting to become active,and for which a Channel Not
Activated event has been generated, isnow able to become
active, because an active slot has been released by another

channel.
Channel Auto- Automatic channel definition failed.
Definition Error
Channel Auto- Automatic channel definition succeeded.

Definition OK
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Channel This condition isdetected when achannel isunableto carry out
Conversion Error data conversion.

Channel Not Thechannel isunable to establish the connection because the
Activated limit on the number of active channels has been reached.
Channel Sarted An instance of achannel has been successfully established
Channel Sopped The channel was stopped.

Channel Sopped The channel has been stopped by the operator.

By User

Primary Data Point

The primary data point is the number of channel events for the specified queue for the current interval.

Intelligent Data Point

Theintelligent data point displaysthe number of channel events, description of individual events
(event name, date & time that the message was put on the event queue, name of the queue manager
that put the message, queue associated with the event, and reason code).

Channel events are reported by channels as aresult of conditions detected during their operation.
For example, when achannel instanceisstopped. Channel eventsare generated:

! By acommand to start or stop achannel
! When achannel instance starts or stops
! When achannel receives a conversion error warning when getting a message.

I When an attempt ismade to create a channel automatically; the event isgenerated whether
the attempt succeeds or fails.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Channel Status

Thiscounter reportstherunning state of achannel. Thiscounter cannot be used for client-connection
channels.

Parameters

Queue Manager

Queue manager you are monitoring.

Channd

Channel you are monitoring.

Primary Data Point

The primary data point is the running state of achannel.
I "1"if thechannel isactive.
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I "0"if thechannel isnot active.
I "1"if an error occurred.

Intelligent Data Point

Theintelligent data point liststhe queue manager, channel name, and status, or if an error occurred.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Error Log Entries

This counter reportsthe number of errorsin the MQ error log file for the current interval. It uses standard
Java file processing API functionsto gather the information.

Note: This counter does not appear in the discovery data if the MQ instance was configured as remote in
the agent manager.

Parameters

Error Number

Soecify All Errors, asingle error number, or an error number range to monitor.

Error Number Range Description
AMQ3500-AM Q3999 WebSphere MQ for Windows
m essages.
AM Q4000-AM Q4999 WebSphere MQ for Windows NT
User Interface messages.
AMQ5000-AM Q5999 Installable services messages.
AMQ6000-AM Q6999 Common services messages.
AMQ7000-AM Q7999 WebSphere MQ product messages.
AMQ8000-AM Q8999 WebSphere MQ administration
m essages.
AMQ9000-AM Q9999 Rem ote messages.

Primary Data Point

The primary data point is the number of errorsin the error log file for the current interval.

Intelligent Data Point

There are three alternatives for what isreturned for the intelligent data point. It dependson what
you selected for the Error Number parameter.

The data point detail lists each error and the number of timesit occurred within theinterval.

One error chosen:
I Number of errorsin interval that match the error number.
I Each error range and count for the range.
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I Total errorsduring theinterval.

Error range chosen:
I Number of errorsin interval that are within chosen range.
I Top 10 errorsin range.
I FError range and count for the range.
I Total errorsduring theinterval.

All errorschosen:
! Number of errorsin interval.
I Top 10 errors.
I Error and count.
I Error range and count for the range.
I Total errorsduring theinterval.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Percent Queue Depth

This counter reportsthe current queue depth as a percentage of the defined maximum.
Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Primary Data Point

The primary data point is the current queue depth as a percentage of the defined maximum.

Intelligent Data Point

Theintelligent data point liststhe queue manager, queue, current queue depth, and percent queue
depth.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Performance Events

This counter reportsthe number of performance events for the current interval.
Parameters

Queue Manager

Queue manager you are monitoring.
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Name of the performance event queue that you are monitoring. The default valueis

SYSTEM.ADMIN.PERFM .EVENT.

Event Name

Conductor

Soecify the name(s) of the event(s) you want to monitor. All eventson the queue are monitored
unless event name(s) are selected.

Event Name

Description

Queue Depth High

Queue depth high limit reached or exceeded.

Queue Depth Low

Queue depth low limit reached or exceeded.

Queue Full

Queue already contains maximum number of
m essages.

Queue Service Interval
High

No successful getsor putshave been detected
within an interval greater than the limit
specified in the Q Service Interval attribute.

Queue Service Interval
OK

A successful get has been detected within an
interval lessthan or equal to the limit specified
in the Q Service Interval attribute.

Primary Data Point

The primary data point is the number of performance events for the specified queue during the current

interval.

Intelligent Data Point

The intelligent data point displaysthe number of performance events, description of individual
events (performance event type, event name, date & time that the message was put on the event
queue, name of the queue manager that put the message, queue associated with the event, time
since reset, high queue depth, message enqueue count, message dequeue count and reason code).

Performance events are notificationsthat athreshold condition has been reached by aresource. The
conditions can affect the performance of applicationsthat use a specified queue. Performance event

types are:

I Queue Depth High
! Queue Depth Low

I Queue Full

I Queue Service Interval High

I Queue Service Interval OK

Performance event statistics are reset when a performance event occurs or a queue manager stops

and restarts.

Interval

Recommended minimum is5 minutes.
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WebSphere MQ Queue Depth

Thiscounter monitorsthe current depth of the specified queue.
Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Primary Data Point

The primary data point is the number of messages on queue.

Intelligent Data Point

Theintelligent data point liststhe queue manager, queue, and queue depth.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Connections

Thiscounter reportsthe current number of connectionsto a queue manager.
Param eters

Queue Manager

Queue manager you are monitoring.

Primary Data Point

The primary data point is the positive integer representing the number of connectionsor "-1" if an
error occurred.

Intelligent Data Point

Theintelligent data point liststhe queue manager, the number of active connections, and the
connection names. If an error occurred, then it displaysthe error number and description.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Events

This counter reportsthe number of queue manager eventsfor the current interval.

Parameters
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Queue manager you are monitoring.

Queue Manager Event Queue

Name of the queue manager event queue you are monitoring. The default valueis
SYSTEM.ADMIN.QMGR.EVENT.

Event Name

Soecify the name(s) of the event(s) to monitor. All eventson the queue are monitored unless event

name(s) are selected.

Event Name

Description

Alias Base Queue Type
Error

The Base Q Name in the alias queue definition resolvesto a queue
that isnot alocal queue, or local definition of aremote queue.

Default Transmission
Queue Type Error

Either alocal definition of the remote queue was specified, or a
gueue-manager aliaswas being resolved, but in either case the
XmitQName attributein thelocal definition is blank.

Default Transmission
Queue Usage Error

The queue defined by the DefXmitQNamequeue-manager attribute
does not have a Usage attribute of MQUS TRANSMISSON.

Get Inhibited

Getsinhibited for the queue.

Not Authorized

The user isnot authorized for access.

Put Inhibited

Put callsinhibited for the queue.

Queue Manager Active

Queue manager created.

Queue Manager Not
Active

Queue manager unavailable.

Queue Type Error

Queuetype not valid.

Remote Queue Name
Error

Remote queue name not valid.

Transmission Queue
Type Error

Transmission queue not local.

Transmission Queue
Usage Error

Transmission queue with wrong usage.

Unknown Alias Base
Queue

The BaseQNamein the alias queue attributesis not recognized as a
queue name.

Unknown Default
Transmission Queue

The XmitQName attribute in the local definition is blank.

Unknown Object
Name

The Object Name in the object descriptor isnot recognized for the
specified object type.

Unknown Remote

An error occurred with the queue-name resolution.
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Queue Manager

Unknown
Transmission Queue

The XmitQName attribute of the definition isnot blank and not
the name of alocally-defined queue.

Primary Data Point

The primary data point is the number of queue manager eventsfor the current interval.

Intelligent Data Point

Theintelligent data point displaysthe number of queue manager events, description of individual
events (queue manager event type, event name, date & time that the message was put on the event

gqueue, name of the queue manager that put the message, and reason code).

Queue manager events are eventsthat arerelated to the definitions of resources within queue
managers. For example, an application attemptsto put a message to a queue that does not exist.

Queue manager event types are: authority, inhibit, local, remote, and start/stop.

Event Type

Reason Code

Authority Events

Not Authorized (type 1)
Not Authorized (type 2)
Not Authorized (type 3)
Not Authorized (type 4)

Inhibit Events

Get Inhibited
Put Inhibited

Local Events

Alias Base Queue Type Error
Unknown Alias Base Queue

Unknown Object Name

Remote Events

Default Transmission Queue Type Error
Default Transmission Queue Usage Error
Queue Type Error

Remote Queue Name Error
Transmission Queue Type Error
Transmission Queue Usage Error
Unknown Default Transmission Queue
Unknown Remote Queue Manager
Unknown Transmission Queue

Sart and Sop
Events

Queue Manager Active
Queue Manager Not Active

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Statistics

This counter reports statistics describing a queue manager.
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Queue Manager

Conductor

Queue manager you are monitoring.

Satistic

Soecify the statisticto use asthe primary data point.:

Authority Events

Reportsthe on/off value of Authority events. Authority eventsindicate
that an authorization violation has been detected.

Automatic
Channel
Definition Events

Reportsthe on/off value of Automatic Channel Definition events.
Automatic channel definition eventsindicate whether an automatic
definition of achannel fails or succeeds.

Inhibit Events

Reportsthe on/off value of Inhibit events. Inhibit eventsindicate that
an MQPUT or MQGET operation has been attempted against a queue,
wherethe queueisinhibited for putsor getsrespectively.

Local Events

Reportsthe on/off value of Local events. Local eventsindicate that an
application (or the queue manager) has not been able to accessalocal
queue, or other local object.

Performance
Events

Reportsthe on/off value of Performance events. Performance eventsare
notificationsthat athreshold condition has been reached by a resource.

Remote Events

Reportsthe on/off value of Remote events. Remote eventsindicate that
an application (or the queue manager) cannot access a (remote) queue
on another queue manager.

Start Stop Events

Reportsthe on/off value of these events. Sart and stop eventsindicate
that a queue manager has been started or has been requested to stop or
quiesce.

Primary Data Point

The primary data point is the one of the following statistics as specified by the Statistics parameter:

I Authority Events

! Automatic Channel Definition Events

! Inhibit Events
! Local Events

! Performance Events

I Authority Events

! Automatic Channel Definition Events

Intelligent Data Point

Theintelligent data point liststhe queue manager and queue manager statistics. Thiscounter
reportsthe current state of the statistics, it does not report the statistics values asthey progress
through time. For dynamic information, monitor with the Queue Manager Event counter. As

appropriate, any of the

following information may be included:

Data

Description
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Authority Events = <integer>

Variable that storesthe on/off value of these events. Authority
eventsindicate that an authorization violation has been detected.

Automatic Channel
Definition Events = <integer>

Variable that storesthe on/off value of these events. Automatic
channel definition eventsindicate whether an automatic
definition of achannel fails or succeeds.

Inhibit Events = <integer>

Variable that storesthe on/off value of these events. Inhibit events
indicatethat an MQPUT or MQGET operation has been attempted
against a queue, wherethe queue isinhibited for puts or gets
respectively.

Local Events = <integer>

Variable that storesthe on/off value of these events. Local events
indicate that an application (or the queue manager) has not been
able to access alocal queue, or other local object.

Performance Events =
<integer>

Variable that storesthe on/off value of these events. Performance
eventsare notificationsthat athreshold condition has been
reached by aresource.

Remote Events = <integer>

Variable that storesthe on/off value of these events. Remote
eventsindicate that an application (or the queue manager) cannot
access a (remote) queue on another queue manager.

Sart Sop Events = <integer>

Variable that storesthe on/off value of these events. Sart and stop
eventsindicate that a queue manager has been started or has been
requested to stop or quiesce.

Cluster Workload Data =
<wstring>

Cluster workload exit data.

Command Level = <integer>

Level of system control commands supported by the queue
manager.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Manager Up/Down

Thiscounter monitorstherunning state of a queue manager.

Parameters

Queue Manager

Queue manager you are monitoring.

Primary Data Point

The primary data point is the running state of queue manager.

I "1"if the queue manager isrunning.

I "0"if the queue manager isnot running.

I "1"if an error occurred.
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Theintelligent data point liststhe queue manager and whether the queue manager isup, down, or

an error occurred.

Interval

Recommended minimum is5 minutes.

WebSphere MQ Queue Statistics

This counter reports statistics describing a queue.

Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Satistic

Soecify the statistic to use asthe primary data point.

Current Depth

Reportsthe current number of messages on queue.

Queue Depth High
Event

Reportsthe on/off value of these events. Queue depth high events
indicate that the queue depth hasincreased to a predefined threshold.

Queue Depth Low
Event

Reportsthe on/off value of these events. Queue depth low events

indicate that the queue depth has decreased to a predefined threshold.

Queue Depth Max
Event

Reportsthe on/off value of these events. Queue depth max events
indicatethat the queue hasreached its maximum depth, that is, the
queue isfull.

Queue Service
Interval Event

Reportsthe on/off value of these events. Queue service interval events
arerelated to whether messages are processed within a user-specified
time interval.

Primary Data Point

The primary data point is the one of the following statistics as specified by the Statistics parameter:

I Current Depth

I Queue Depth High Event

! Queue Depth Low Event

! Queue Depth Max Event

I Queue Service Interval Event

Intelligent Data Point

Theintelligent data point liststhe queue manager, queue, and queue statistics. This counter reportsthe
current state of the statistics, it does not report the statistics values asthey progressthrough time. For
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dynamic information, use the Queue Manger Events counter. Asappropriate, any of the following

information may beincluded:

Data

Description

Inhibit Get = <integer>

Indicates whether get operations are allowed on the queue.

Inhibit Put = <integer>

Indicates whether put operations are allowed on the queue.

Current Queue Depth =
<integer>

Current number of messages on the queue.

Maximum Queue
Depth = <integer>

Maximum number of messages allowed on the queue.

Queue Depth High
Event = <integer>

Variable that storesthe on/off value of these events. Queue depth
high eventsindicate that the queue depth hasincreased to a
predefined threshold.

Queue Depth High
Limit = <integer>

Valuethat triggersan event if it isreached.

Queue Depth Low
Event = <integer>

Variable that storesthe on/off value of these events. Queue depth
low eventsindicate that the queue depth has decreased to a
predefined threshold.

Queue Depth Low Limit
= <integer>

Value that triggers an event if it isreached.

Queue Depth Max
Event = <integer>

Variable that storesthe on/off value of these events. Queue depth
max eventsindicate that the queue hasreached its maximum depth,
that is, the queueisfull.

Queue Service Interval
Event = <integer>

Variable that storesthe on/off value of these events. Queue service
interval eventsarerelated to whether messages are processed within
a user-specified time interval.

Queue Service Interval
= <integer>

Queue service interval time.

Trigger Data =
<wstring>

Free-format datathat iswritten into a trigger message.

Trigger Depth =
<integer>

Number of messagesthat have to be on the queue before a trigger
message is written.

Trigger Control =
<integer>

Controlswhether or not trigger messages are written to an initiation
queue.

Interval

Recommended minimum is5 minutes.
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WMI Counters

WMI Remote Extended Counters

The following extended WMI (Windows Management Instrument) remote counters are provided in
QALoad. To display and use the extended countersin task configuration, you must configure user access
with the MMC (Microsoft Management Console) and configurethe WMI agent using the ServerVantage
Agent Console (Reconfigure Agent). These procedures are described in the topic Configuring WMI in the
ServerVantage Agent Configuration online help. Once configuration iscomplete, and you select WMI
collector asyour Server Type during task configuration on the Select Counters page, ServerVantage
discoversthe Windows registry counters and the extended counters for each WMI-configured server.

These counters extend the monitoring of your WMI system:

WMI WQL WMI Top Ten Counters:

I CPU Utilization % - Top Ten
I Memory Utilization % - Top Ten
I I/O Utilization % - Top Ten

WMI Top Ten Counters
I Top Ten CPU
I Top Ten Memory
! Top Ten I/O

CPU Utilization % - Top Ten

The CPU Utilization % - Top Ten counter provides data for the Load Characterization Report. It returnsa
numeric value for each of the top ten processesthat utilize the most machine CPU or all processes for
which CPU utilization is greater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).

Memory Utilization % - Top Ten

The Memory Utilization % - Top Ten provides data for Load Characterization Report. It returnsanumeric
value for each of the top ten processesthat utilize the most machine Memory or all processes for which
Memory utilization is greater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).

I/O Utilization % - Top Ten
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The I/O Utilization % - Top Ten provides data for Load Characterization Report. It returnsanumeric value
for each of the top ten processesthat utilize the most machine I/O or all processes for which 1/0O utilization
isgreater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).

WMI WQL

The WMI WQL (Windows Query Language) counter monitorsthe object (s) specified by the WQL
statement. Users may select predefined WQL templates.

Parameters

W QL Satement
Enter avalid WQL (WMI Query Language) statement.

Data Point

Primary Data Point

The primary data point returns 0 if the WMI system executed query is successful. If the query fails, the
graph displays DATA_NOT_FOUND asthe data point. If you click on the data point, the actual error is
provided in the error description.

Intelligent Data Point
Theintelligent data point (IDP) istheresponse from the query.

Interval

Recommended minimum interval 5 minutes.

Managing Counters
Adding Countersto a Task Using New Discovery Data

Add countersto amonitoring task by generating the available counter data and selecting the counters and
instancesto add to the task.

To add countersand instancesto a monitoring task:

1. Click Tools>Monitoring>Add counter>Use new discovery data. The Edit Monitoring Machine
W izard appears.

2. Follow theinstructionsfor using the wizard to discover and add countersto the monitoring task.
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Adding Countersto a Task Using Cached Discovery Data

It ispossibleto add countersto monitor for amachine and monitor type using cached discovery data.

Select the counter to add or modify:

1. Select Monitoring>Add counter>Use cached discovery data. ThisAdd/Edit Countersdialog box
appears.

2. From the Available Item s pane, select the Template tab or the Counter tab.

3. To add an item, select atemplate or a counter, and click Add, or double-click the item to display it
in the Selected Items pane. Click Add All to add all theitemson the selected tab to the Selected
Items pane.

4. Toremove an item, double-click the item in the Selected Items pane or select the item and click
Remove. Theitem isreturned to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:

= To select nonadjacent counter items, click a counter item, and then hold down Ctrl and click
each additional counter item.

= To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

5. Click Next. The Choose Instances dialog box displays.

Note: When you select a template, and some of the countersit contains are not present on the machine
you are defining, you receive a message with a list of the counters that will not be added to the task.

Choose the instances of the counter to monitor:

When clicking Next in the previous dialog box. The Choose Instances dialog box appears.

1. Review the countersselected. When ared dot appears next to a counter, select an instance of the
counter.

Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until all instances of the counter that you want to apply to the task are selected.
Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.
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Click Next. The Summary dialog box displays.

Save the task:

When clicking Next in the previous dialog box, the Summary dialog box appears.

1. OntheSummary dialog box, review the monitors and counters selected for the template. Click
Back to return to adialog box and make changesto the information.

2. Click Finish to add the counters.
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Removing a Monitor or a Counter from a Monitoring Task

Remove a monitor or a counter from a monitoring task, by following this procedure.

To remove a counter from a monitoring task:

1. OntheMonitoring Optionstab, select the monitor, counter, or counter family to delete.
2. Click Tools>Monitoring>>Remove monitor/Remove counter.

3. When the verification dialog box displays, click OK.

Note: You cannot remove the last monitor on a machine, the last counter in the family, or the last family of
countersin the task.

Managing Monitoring Templates

Creating a New Template

To accessthe New Monitoring Template wizard:

In Conductor, click Tools>Monitoring>Manage monitoring templatesSNew monitoring template. The
New Monitoring Template wizard appears. Click Next to start the procedure.

Usethe following stepsin the New Monitoring Template wizard to create a new monitoring template:
1. Enter thetemplate properties

Configure the monitor

Counter discovery

Choosethe counters

o M 0N

Choosetheinstances
6. Review, save, and create the template
Using an Existing Template

Usethe following stepsto apply a previously created or pre-defined template.

To apply an existing template:

1. Select Tools>Monitoring>Manage Monitoring Templates>Use existing template. The Select a
Monitor Template File dialog box displays.

2. Double-click atemplate type, then select atemplate and click Open. The template isapplied to the
monitoring task.

Editing Instances for Templates

To edit instancesin atemplate:

1. On the Monitoring Optionstab, select the template to edit.

2. Click Tools>Monitoring>Manage monitoring templates>Edit instances. The Edit Template
Instances Wizard appears.
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To choose the instances of the counter to monitor:

Review the countersyou selected. When ared dot appears next to a counter, you must select an instance
for the counter.

1.
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Double-click the counter group to display the counters.

Select an instance for a counter and click Edit. The Select instance for counter dialog box appears.
To add an instance: In the Available Instance pane, select an instance and click Add.

To remove an instance: In the Selected instances pane, select an instance and click Remove.

Repeat until you select all instances of the counter that you want to apply to the task.

Click Save. You return to the Choose Instances dialog box.

Repeat this process for each designated counter.

Click Next. The Summary dialog box displays.

To save the template:

1.

2.
3.

On the Summary dialog box, review the monitors and countersyou have selected for the template.
Click Back to return to a dialog box and make changesto the information.

Click Back to return to the previous step and edit the instances.

Click Finish to create the template.

Modifying Template Counters for Custom Templates

When you need to add or edit countersin atemplate that you created, you can use the cached counter
discovery datato modify the template.

Note: You cannot modify the countersin pre-defined templates.

Select the counter to add or remove:

1.

4.

Select Monitoring>Manage monitoring templates>Add/Edit counter>Use cached discovery
data. The Edit Template Counterswizard appears with the Add/Edit/Remove Template
Countersdialog box displayed.

From the Available Items pane, select the Template tab or the Counter tab.

To add an item, select atemplate or a counter to monitor for thismachine and monitor type, and
click Add, or double-click theitem to display it in the Selected Items pane. Click Add All to add
all theitemson the selected tab to the Selected Items pane.

To remove an item, select the item in the Selected Items pane and click Remove, or double-click
theitem to return it to the Available Items pane.

El Note: Select multiple counters and templates by doing one of the following:

5.

= To select nonadjacent counter items, click one counter item, and then hold down Ctrl and
click each additional counter item.

= To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

Click Next. The Choose Instances dialog box displays.

El Note: When selecting a template, if some of the countersit contains are not present on the machine you
are defining, a message displays with alist of the countersthat will not be added.
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Choose the instances of the counter to monitor:

1. Review the selected counters. When ared dot appears next to a counter, select an instance of the
counter.

Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.
In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply.

Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.
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Click Next. The Summary dialog box displays.

Save the template:

1. OntheSummary dialog box, review the selected monitors and countersfor the template. Click
Back to return to adialog box and make changesto the information.

2. Click Finish to create the template.
Removing a Counter from a Template

Remove a counter from atemplate by following this procedure.

To remove a counter from atemplate:

1. OntheMonitoring Optionstab, select the counter or counter family to delete.
2. Click Tools>Monitoring>Manage monitoring templates>Remove counter.

3. When the verification dialog box displays, click OK.
Note: You cannot remove the last counter in a family.

Modifying Template Counters Using New Discovery Data

When you want to add or edit countersin acustom template, you can generate the discovery datathat you
add to the template. The Edit Monitoring Template wizard guides you through the process of generating
and applying new discovery data.

To accessthe Edit Monitoring Template wizard:

Click Tools>Monitoring>Manage monitoring templates>Add/Edit Counter>Use new discovery data.
The Edit Monitoring Template wizard appears. Click Next to start the procedure.

Enter properties of the template:

Click Next in the Welcome dialog box. The Enter properties of the template dialog box displays.
1. Typeanameforthetemplatein the Template name field.

2. Click thearrow in the Monitor type field, then select the type of monitor on which data will be
gathered when the test session isrunning.

3. Click thearrow in the Machine (hostname or IP address) field and select the host name or IP
address of the machine on which the monitor will run.
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For SAP, WeblLogic, WebSphere, and WebSphere MQ, in the Java Home field, click Browse... and
select the path for the Java component. For SAP, WebLogic, and WebShere MQ thismay be a
VUN-installed Java Home, for example, C:\ Java\ JDK1. 4, where a SUN DK isinstalled. For

WebShere, thismust be aWebShere-installed Java Home, such as, C:\ Program
Fi | es\ WebSpher e\ AppSer ver\ Java.

Type adescription for the templatein the Description field

Click Next. The Configure Monitor dialog box displays.

Configure the monitor:

1.

2.

Type the configuration datafor the host machine, if necessary. Thisdataisused to connect to the
host machine and to the host database during counter discovery and runtime data collection. The
required configuration data varies depending on the monitor type selected. Click alink below to
view therequired configuration details for your monitor type.

= SGAP
= Server Analysis agent

= ServerVantage

= SNMP
= WebLogic
= WebSphere

= WebSphere MQ
=  Windows Registry
= WMI

Click Next. The counter discovery process begins.

Counter discovery:

When clicking Next in the previous dialog box, the Add the desired countersto thistemplate dialog box
appears.

QALoad automatically performsthe counter discovery. The default maximum time for counter discovery is
300 seconds. When counter discovery iscomplete, the Choose Countersdialog box displays.

Choose the counters:

When the counter discovery process completes, the Add the desired counter to thistemplate dialog box

appears.
1. From the Available Itemspanein the Choose Countersdialog box, select the Template tab or the
Counter tab.
2. To add an item, select atemplate or a counter to monitor in the task for thismachine and monitor
type, and click Add, or double-click theitem to display it in the Selected Items pane. Click Add
All to add all theitemson the selected tab to the Selected Items pane.
3. Toremove an item, double-click theitem in the Selected Items pane or select the item and click

Remove. Theitem isreturned to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:
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= To select nonadjacent counter items, click one counter item, and then hold down CTRL and
click each additional counter item.

= To select adjacent counter items, click the first counter item in the sequence, and then hold
down SHIFT and click the last counter item.

4. Click Next. The Choose Instances dialog box displays.

El Note: When selecting a template, and some of the countersit contains are not present on the machine
you are defining, you receive a message with a list of the counters that will not be added to the task.

Choose the instances of the counter to monitor:

Review the selected counters. When ared dot appears next to a counter, select an instance of the counter.
1. Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply to the task.

Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.
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Click Next. The Summary dialog box displays.

Save the template:

1. OntheSummary dialog box, review the counters and instances you have selected for the template.
Click Back to return to a dialog box and make changesto the information.

2. Click Finish to create the template.

About Monitoring Templates
Using Monitoring Templates

Monitoring templates are designed to facilitate the configuration process. A monitoring templateisa
predefined group of counters not associated with a specific machine. You can create a new template for a
monitoring task, or you can use one of QALoad's pre-defined templates.

When you create a custom template, QALoad's New Monitoring Template wizard guidesyou through the
process of defining the type of template you want to create, configuring the monitor properties, and
adding the countersand instances of countersto the template.

When you use one of QALoad's predefined templates, you select a stored template with the countersyou
want to monitor. The templates have counters grouped by functionality, such as Network Traffic, Response
Time, or System Health. Where appropriate, the templatesinclude the specific instancesto monitor for
each counter.

You can add or edit countersin either custom or pre-defined templates. When you open atemplate to edit
for the first time, Edit Monitoring Template wizard guides you through the process of discovering and
adding new countersto atemplate. When you've just completed the counter discovery process for a
template, either by creating a new template or by opening atemplate for editing, you can select counters
from those already available in memory by using the cached discovery.
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Custom Templates

You can create templates of the monitoring tasksthat you develop so that all of the countersand instances
for the task are saved. You can create new tasks and incorporate the template you created. Templates are
saved as.xml filesin the Templates directory.

You can create atemplate when you define a monitoring task, or you can use the New Monitor Template
wizard to create and store atemplate for future use. Custom templates can be modified using either new
discovery data or cached discovery data.

Pre-defined Templates

About Pre-defined Templates

QALoad provides pre-defined templates for each monitor type. Each template includesthe counters most
commonly used for particular task within each monitor type.

QALoad providesthe templates form the following monitor types:
! SAP
I Server Analysis Agent
! SNMP
I WebLogic
I WebSphere
I WebSphere MQ
I Windows Registry

I WMI
Note: You cannot modify pre-defined templates.

Accessing Pre-defined Templates

QALoad provides pre-defined templates for each monitor type. These include the countersmost commonly
used for particular task.

To access pre-defined templates:

In the Conductor, select Tools>Monitoring>Manage Monitoring Templates>Use existing template.
SAP Templates

QALoad-SAP R3 Remote Availability

Thistemplate monitorsthe availability of an SAP R/3 Instance. The SAP R/3 Availability template returns
critical information about the availability of your SAPinstallation. One metric used to determinethe
availability of an SAP R/3 Instance isthe status of the SAP collector.

The default event action assigned to thistemplate issues an alarm if either the specified R/3 Instance or the
collector goesdown. The default instance isthe first SAP Instance configured for monitoring during
installation.

The SAP R/3 Availability template uses the following SAP R/3 extended counters:

e

Active Servers Returnsthe number of active SAP application servers for
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agiven instance. It detectswhen aremote server is
unavailable.

Rule: IF 'SAP R/3 Remote Extended.Active Servers(SAP
Instance: "**", Server Count: "10")' =0 .

QALoad-SAP R3 Remote Performance
Thistemplate monitorsthe performance of your SAP R/3 Instance.

The default event action for thistemplate raises an event if the number of alerts of critical statusis greater
than O, or if the buffer hit ratio falls below 95%.

All the counters associated with thistemplate require the instance number of your SAP installation. By
default, thistemplate usesthe first instance configured for monitoring during ServerVantage installation. If
you use thetask configuration wizard to change the instance that the template monitors, you must also
changetheinstance specified in the rule accordingly.

The SAP R/3 Performance template uses the following SAP R/3 extended counters:

e

Buffer Satistic Returnsdifferent buffer statistics for selected buffer name. This
counter was chosen because buffering dataisakey to the
performance of SAP.

Rule: IF 'SAP R/3 Remote Extended.Buffer Satistic(SAP Instance:
"**" Buffer Name: "TTAB", Satistic Name: "Hit rate SAP
buffer(%%)")' < 95.

Itemized Spool Queue Return number of entriesin the spool queue that match the
specified criteria.
Rule: IF '"SAP R/3 Remote Extended.Spool Queue(SAP Instance:
" Request Status: "Processing")' > 10.

Memory Usage Returnscurrent memory usage.
Rule: IF 'SAP R/3 Remote Extended.Memory Usage(SAP Instance:
"kt Count: "10", Metrics: "M B")' > 10000.

Page/Roll Area Returns Used Paging Area % statistic. This counter was chosen
because roll memory iscritical for work processes and page
memory iscritical for internal data processing.

Work Processes Counter for monitoring SAP R/3 work processes. Returns number
of stopped work processes.

Rule: IF'SAP R/3 Remote Extended.Work Processes(SAP Instance:
"**" Process Type: "BGDDIAENQSPOUP2UPD", Process Sate:
"Sopped")' > 2.

QALoad-SAP R3 Remote System Errors

Thistemplate monitorsthe errorsand critical situationsthat occur on a SAP R/3 system. Rules and
thresholds are preset to appropriate values for most sites.

The default sampling interval for thistemplateis5 minutes.
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The SAP R/3 Performance template uses the following SAP R/3 Remote extended counters:

e

Alerts

Itemized Spool Queue

Fool Queue

W ork Processes

SNMP Templates

SNMP Templates

Counter for monitoring R/3 alerts. Returns number of alerts
according to the specified criteria. This counter checks all alerts
with error (red) status.

Rule: IF'SAP R/3 Remote Extended.Alerts(SAP Instance; "**",
Monitor Set: "SAP CCMSAdmin Workplace", Monitor:
"Database", Severity: "Error - Red", Pattern: "*", Show Alert Text:
"No")' > 0.

Return number of entriesin the spool queue that match the
specified criteria.

Return number of entriesin the spool queue that match the
specified criteria. This counter checks all spool entrieswith
“Problem” status.

Rule: IF'SAP R/3 Remote Extended.Spool Queue(SAP Instance:
"**" Request Satus: "Problem™)’ > 0.

Counter for monitoring SAP R/3 work processes. Returns number
of work processes according to the specified criteria. This counter
checks stopped work processes.

Rule: IF'SAP R/3 Remote Extended.W ork Processes(SAP Instance:
" Process Type: "BGDDIAENQSPOUP2UPD", Process Sate:
"Sopped")' > 0.

QALoad providesthe following pre-defined SNMP templates:

QALoad-HP Performance

QALoad-Linux Performance
QALoad-SUN Performance

QALoad-HP Performance

Thistemplate includesthe following counters and categories:

o | e o

HP System Cpuldle% CpuSys¥ isthe percentage of idle processor
time.
CpuSys¥ CpuSys¥ isthe percentage of non-idle

processor time that isspent in system mode.

CpuUser% CpuUser% isthe percentage of non-idle

processor timethat isspent in user mode.

FreeMemory KBytes FreeMemory KBytesisthe amount of idle

Conductor
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tcp

udp

FreeSwvap KBytes

MaxUserMem KBytes

Users

tcplnSegs/ sec

tcpOutSegs/sec

udplnDatagrams/sec

udpOutDatagrams/sec

QALoad-Linux Performance

memory.

FreeSvap isthe amount of free swap space on
the system.

MaxUserMem isthe amount of maximum user
memory on the system.

Usersisthe number of userslogged on to the
machine.

tcplnSegs/sec isthe rate at which segments are
received, including those received in error.

tcpOutSegs/secistherate at which segments
are sent, including those on current
connections but excluding those containing
only retransmitted octets.

udplnDatagrams/sec istherate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec isthe rate at which UDP
datagrams are sent.

Thistemplate includesthe following counters and categories:

Linux System

tcp
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Cpuldlie%

CpuSys%

CpuUser%

Interrupts/sec

Pagesin KBytes/ sec

PagesOut KBytes/sec

Swapln KBytes/sec

SwvapOut KBytes/sec

tcplnSegs/ sec

CpuSys¥ isthe percentage of idle processor
time.

CpuSys¥ isthe percentage of non-idle processor
timethat isspent in system mode.

CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

Interrupts/sec istherate of system interrupts.

Pagesin KBytes/sec isthe rate of pagesread in
from disk.

PagesOut KBytes/sec istherate of pages written
to disk.

Swapln KBytes/sec isthe rate at which pages are
being swapped in.

SwvapOut KBytes/sec istherate at which pages
are being swapped out.

tcplnSegs/sec isthe rate at which segments are
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received, including those received in error.

tcpOutSegs/sec tcpOutSegs/secistherate at which segments are
sent, including those on current connections
but excluding those containing only
retransmitted octets.

udp udplnDatagrams/sec udplnDatagrams/sec istherate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec . udpOutDatagrams/sec istherate at which UDP
datagrams are sent.

WebLogic Templates

WebLogic Templates

QALoad providesthe following pre-defined WebLogic templates:
QALoad-WebLogic Availability

QALoad-WebLogic EB Performance

QALoad-WebLogic JDBC Performance

QALoad-WebLogic M S Performance

QALoad-WebLogic Performance

QALoad-WebLogic Server Security

QALoad-WebLogic Servlet Performance

QALoad-WebLogic Availability

Thistemplate monitorsthe availability of a WebLogic server. The WebLogic Availability template returns

critical information about the availability of your WebLogic installation.
The default sampling interval for thistemplateis5 minutes.

The WebLogic Availability template uses the following WebLogic extended counters:

ExecuteQueueRuntime ExecuteQueueRuntime_PendingRequestOldestTime Returnsthetime
that the longest
waiting request
was placed in
the queue.

Rule: The
Application
Server isnot in
running mode if
thiscounter
valueis> 50.
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ServerRuntime

ServerSecurityRuntime

QALoad-WebLogic EB Performance

ServerRuntime_StateVal

ServerSecurityRuntime_LockedUsersCurrentCount

Returnscurrent
state of the
server. This
counter provides
amore detailed
state than
available or not.

Rule: The
Application
Server isnot in
running mode if
thiscounter
valueis<> 2.

Returnsthe
number of
currently locked
userson this
server.

Rule: There are a
high number of
users locked out
if thiscounter
valueis > 5.

Thistemplate monitorsthe EB performance of a WebLogic server. The WebLogic EIB Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplate is5 minutes.

The WebLogic EB Performance template usesthe following WebLogic extended counters:

EJBCacheRuntime
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EBCacheRuntime_ActivationCount

EBCacheRuntime_CacheAccessCount

Returnsthe
total number
of timesthe
EB was
activated.

Rule: Thereis
inefficient
cache access if
the number of
activationsis>
20.

Returnsthe
total number
of attemptsto
access a bean
from the
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cache.

EBCacheRuntime_CachedBeansCurrentCount Returnsthe
total number
of beans from
thiseElB Home
currently in
the EJB cache.

EBCacheRuntime CacheHitCount Returnsthe
total number
of times an
attempt to
access a bean
from the cache
succeeded. The
cacheHitCoun
t value
subtracting the
cache miss
count from
the cache
access count.

EBCacheRuntime_PassivationCount Returnsthe
total number
of beans from
thiselB Home
that have been
passivated.

Rule: Thereis
inefficient
cache access if
the number of
passivationsis
> 20.

EJBLockingRuntime EBLockingRuntime _LockEntriesCurrentCount Returnsthe
number of
currently
locked users
on this server.

EBLockingRuntime TimeoutTotalCount Returnsthe
current
number
Threadsthat
have timed
out waiting for
alock on a
bean.

EBLockingRuntime WaiterTotalCount Returnsthe
number of
objects waiting
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EJBPoolRuntime
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EBPoolRuntime_BeanslnUseCurrentCount

EBPoolRuntime_ldleBeansCount

EBPoolRuntime _TimeoutTotalCount

EBPoolRuntime WaiterTotalCount

on thelock.

Rule: There are
alot of objects
waiting if the

interval value

of thiscounter
is>10.

Returnsthe
number of
bean instances
currently
being used
from the free
pool.

Returnsthe
total number
of available
bean instances
in the free
pool.

Returnsthe
total number
of Threads
that have
timed out
waiting for an
available bean
instance from
the free pool.

Rule: There are
alot of objects
timing out if
theinterval
value of this
counteris >
20.

Returnsthe
total number
of Threads
currently
waiting for an
available bean
instance from
the free pool.

Rule: There are
alot of objects
waiting if the

interval value

of thiscounter
is>10.



EJBTransactionRuntime

MessageDrivenEJBRuntime

EBTransactionRuntime_TransactionsCommittedTotalCount

EBTransactionRuntime_TransactionsRolledBackTotalCount

EBTransactionRuntime_TransactionsTimedOutTotalCount

M essageDriven EBBRuntime_JV SConnectionAlive

Conductor

Returnsthe
total number
of transactions
that have been
committed for
this EB.

Rule: Thereis
high
transaction
overhead if the
interval value
of thiscounter
is> 20.

Returnsthe
total number
of transactions
that have been
rolled back for
this EB.

Rule: Thereis
high
transaction
overhead if the
interval value
of thiscounter
is>20.

Returnsthe
total number
of transactions
that have
timed out for
this EB.

Rule: Thereis
high
transaction
overhead if the
interval value
of thiscounter
is>20.

Returnsa
boolean of the
status of the
connection.
Thiscounter
displaysthe
state of a M S
connection.

Rule: The MS
Connection is
down if this
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QALoad-SUN Performance

Thistemplate includesthe following counters and categories:

Sun System Cpuldle%

CpuSys¥

CpuUser%

Interrupts/sec

Pagesin KBytes/sec

PagesOut KBytes/sec

Swaplin KBytes/sec

SwvapOut KBytes/sec

tcp tepln Segs/sec
tcpOutSegs/sec

udp udplnDatagram s/sec
udpOutDatagrams/sec

QALoad-WebLogic JDBC Performance

CpuSys% isthe percentage of idle processor
time.

CpuSys% isthe percentage of non-idle processor
timethat isspent in system mode.

CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

Interrupts/sec istherate of system interrupts.

Pagesin KBytes/sec isthe rate of pagesread in
from disk.

PagesOut KBytes/sec isthe rate of pages written
to disk.

Swapln KBytes/sec istherate at which pages are
being swapped in.

SwvapOut KBytes/sec istherate at which pages
are being swapped out.

tcplnSegs/sec isthe rate at which segments are
received, including those received in error.

tcpOutSegs/sec istherate at which segments are
sent, including those on current connections
but excluding those containing only
retransmitted octets.

udplnDatagrams/sec isthe rate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec isthe rate at which UDP
datagrams are sent.

counter value
is=0.

Thistemplate monitorsthe JDBC performance of a WebLogic server. The WebLogic JDBC Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.
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The WebLogic DBC Performance template usesthe following WebLogic extended counters:

JDBC Connection Pool ActiveConnectionsCurrentCount Returnsthe current number of active
Runtime connections.
ActiveConnectionsHighCount Returnsthe highest number of active

current connections. The count starts
at zero each timethe
JDBCConnectionPoolRuntimeM Bean
isinstantiated.

ConnectionDelayTime Returnsthe number of milliseconds it
takesto get a physical connection
from the database. It is calculated as
summary timeto connect divided by
summary number of connections.

ConnectionsTotalCount Returnsthe total number of JDBC
connectionsin this
DBCConnectionPoolRuntimeM Bean
since the pool wasinstantiated.

FailuresToReconnectCount Returnsthe number of attemptsto
refresh a connection to a database
that failed. Failure may be due to the
database being unavailable or a
broken connection to the database.

Rule: There are a high number of
connection reconnect failureswhen
thiscounter valueis> 1.

LeakedConnectionCount Returnsthe number of connections
that were checked out from the
connection pool but were not
returned to the pool by calling close

0

Rule: Thereisalot of connection
pool leakage if this counter valueis >
5.

PoolSate Current state of the connection pool.
Returns True if the pool isenabled,
False if the pool isdisabled.

PrepSmtCacheMissCount Returnsacount of the caseswhen
the cache does not have a cached
statement to satisfy a request.

WaitingForConnectionHighCount | The high water mark of waitersfor a
connection in this
JDBCConnectionPoolRuntimeM Bean.
The count starts at zero each timethe
JDBCConnectionPoolRuntimeM Bean
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WaitSecondsHighCount

QALoad-WebLogic M S Performance

isinstantiated.

Returnsthe highest number of
seconds a connection waited.

Rule: Thereisalong wait for the
connection pool if thiscounter value
is >120.

Thistemplate monitorsthe M Sperformance of a WebLogic server. The WebLogic M S Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplate is5 minutes.

The WebLogic M S Performance template usesthe following WebLogic extended counters:

JMSConnectionRuntime SessionsCurrentCount
SessionsTotalCount
JMSRuntime ConnectionsCurrentCount

ConnectionsTotalCount

JM SServerRuntime M essagesPendingCount

M essagesReceivedCount

M SSessionRuntime ConsumersCurrentCount

244

Returnsthe current number of
sessions for thisconnection.

Returnsthe number of sessions
on thisconnection since the last
reset.

Returnsthe current number of
connectionsto thisWebLogic
Server.

Returnsthe total number of
connections made to this
WebLogic Server since the last
reset.

Returnsthe current number of
messages pending
(unacknowledged or
uncommitted) stored on this
M Sserver. Pending messages
are over and above the current
number of messages.

Rule: There are alarge number
of pending messages if this
counter value is > 50.

Returnsthe number of messages
received on thisdestination
since the last reset.

Returnsthe current number of
consumers for this session.



M essagesPendingCount

M essagesReceivedCount

M essagesSentCount

QALoad-WebLogic Performance

Conductor

Returnsthe number of messages
pending (uncommitted and
unacknowledged) for this
session.

Rule: There are alarge number
of pending M S Session
messages if this counter valueis
> 50.

Returnsthe number of messages
received on thisdestination
since the last reset.

Returnsthe number of bytes
sent by thissession since the
last reset.

Thistemplate monitorsthe performance of aWebLogic server. The WebLogic Performance template
returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplate is5 minutes.

The WebLogic Performance template usesthe following WebLogic extended counters:

ConnectorServiceRuntime

ExecuteQueueRuntime

JMSRuntime

ConnectionPoolCurrentCount

ExecuteThreadCurrentldleCount

PendingRequestCurrentCount

ServicedRequestTotalCount

ConnectionsCurrentCount

Returnsthe number of
currently deployed
connection pools.

Returnsthe number of idle
threads assigned to the
gueue.

Returnsthe number of
waiting requestsin the
queue.

Rule: There are alarge
number of pending requests
if thiscounter value is > 50.

Returnsthe number of
requests that have been
processed by this queue.

Returnsthe current number
of connectionsto this
WebLogic Server.

Rule: There are alarge
number of M Sconnections
if thiscounter value is> 20.
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JTARuntime ActiveTransactionsTotalCount

SecondsActiveTotalCount

TransactionRolledBackResourceTotalCount

TransactionTotalCount

JVMRuntime HeapFreeCurrent

TimeServiceRuntime ExceptionCount

ExecutionsPerMinute

QALoad-WebLogic Server Security

Returnsthe number of active
transactionson the server.

Returnsthe total number of
seconds for all committed
transactions.

Returnsthe number of
transactionsthat were rolled
back due to aresource error.

Returnsthe total number of
transactions processed. This
total includesall committed,
rolled back and heuristic
transaction completions.

Returnsthe current amount
of free memory (in bytes) in
the WM heap.

Returnsthe total number of
exceptionsthrown while
executing scheduled triggers.

Rule: There are alarge
number of exceptionsif the
interval value of this counter
is> 20.

Returnsthe average number
of triggers executed per
minute.

Thistemplate monitorsthe security of a WebLogic server. The WebLogic Server Security template returns

critical information about the security status of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Server Security template usesthe following WebLogic extended counters;

ServerSecurityRuntime InvalidLoginAttemptsTotalCount Returnsthe cumulative number of
invalid login attempts made on this

server.

Rule: Multipleinvalid login
attemptshave occurred when the
interval value of thiscounter is> 5.

LockedUsersCurrentCount Returnsthe number of currently
locked userson this server.
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Rule: There are multiple locked
usersif thiscounter valueis> 5.

LoginAttemptswWhileLockedTotalCount Returnsthe cumulative number of
invalid login attempts made on this
server while the user was locked.

UnlockedUsersTotalCount Returnsthe number times users
have been unlocked on this server.

QALoad-WebLogic Servlet Performance

Thistemplate monitorsthe performance of your WebLogic serviet. The WebLogic Servlet Performance
template returnscritical information about the servlet performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Servlet Performance template usesthe following WebLogic extended counters:

ServletRuntime ExecutionTimeAverage Returnsthe average time all invocations of the
servlet that has executed since the task was
created.

Rule: The servlet isaveraging high execution
timesif thiscounter value average is > 10.

ExecutionTimeHigh Returnsthe amount of time the single longest
invocation of the servlet that has executed
since the task was created.

ExecutionTimeTotal Returnsthe total amount of time all
invocations of the servlet that has executed
since the task was created.

Internal Servlet whether thisisan Internal Servlet or not

InvocationTotalCount Returnsthe total number of timesthe servlet
has been invoked. Getsthe
invocationTotalCount attribute of the
ServletRuntimeM Bean object.

ReloadTotalCount Returnsthetotal number of timesthe servlet is

reloaded. GetsthereloadTotalCount attribute
of the ServletRuntimeM Bean object.

WebSphere Templates

WebShere Templates
QALoad providesthe following pre-defined WebSphere templates:
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QALoad-WebSphere 5.0 IDBC Performance
QALoad WebSphere 5.0 Performance
QALoad-WebSphere 5.0 Web Application Performance

QALoad-WebSphere 5.0 IDBC Performance

Thistemplate monitorsthe performance of a WebSphere JDBC server. The WebSphere JDBC Performance
template returnscritical information about the JDBC performance of your WebSphere installation.

The default sampling interval for thistemplate is5 minutes.

The WebShere DBC Performance template usesthe following WebSphere extended counters:

JDBC connectionPoolModule.avgWaitTime Average waiting time in milliseconds until a connecti
Connectio

n Pool

Module

connectionPoolModule.concurrentWaiters WebShere extended counter for monitoring
connectionPoolModule.concurrentWaiters

connectionPoolModule.faults Average waiting time in milliseconds until a connecti

connectionPoolModule.percentMaxed Average percent of thetimethat all connectionsareiil

Rule: IF 'WebShere
connectionPoolModule.connectionPoolM odule.perce
"t Server: "**" Data Source: "all")' > 25.

connectionPoolModule.percentUsed Average percent of the pool that isin use.

QALoad-WebSphere 5.0 Web Application Performance

Thistemplate monitorsthe performance of aWebShere 5.0 Web Application server. The WebSphere 5.0
Web Application Performance template returnscritical information about the Web Application
performance of your WebSphere installation.

The default sampling interval for thistemplateis5 minutes.

The WebSphere 5.0 Web Application Performance template usesthe following WebSphere extended
counters:

WebSphere servlietSessionsModule.activateNonExistSessions Number of requests for a

servletSessionsModule session that no longer exists,
presumably because the
session timed out. This
counter may indicate a high
number of timeout
conditions.

servletSessionsModule.activeSessions The number of concurrently
active sessions. A session is
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active if WebSphereis
currently processing a
request, which usesthat
session. This counter may
indicate high activity.

servletSessionsModule.cacheDiscards Number of session objects
that have been forced out of
the cache. Thiscounter may
indicate aneed for more
memory in the cache.

servletSessionsModule.invalidatedSessions Number of sessions
invalidated. This counter
may indicate a high number
of invalidated sessions.

servlietSessionsModule.invalidatedViaTimeout Number of requests for a
session that no
CountSatistic exists,
presumably because the
session timed out. This
counter may indicate a high
number of timeout

conditions.
WebSphere webAppModule.serviets.concurrentRequests Number of requeststhat are
webAppModule concurrently processed. This

counter may indicate high
activity for an application.

webAppModule.servlets.numErrors Total number of errorsin a
servlet or Java Server Page
(JSP). Thiscounter may
indicate a high number of
error incidents.

webAppModule.serviets.responseTime Responsetime, in
milliseconds, of a servlet
request. Thiscounter may
indicate a slow response
time of arequest.

QALoad WebShere 5.0 Performance

Thistemplate includesthe following counters and categories:

WebSphere jvmRuntimeModule.freeMemory WebSphere extended counter for
jvmRuntimeModul monitoring
e jvmRuntimeModule.freeMemory
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WebSphere
orbPerfModule

WebSphere

system Module

WebSphere
thread PoolModule

jvmRuntimeModule.usedMemory

orbPerfModule.concurrentRequests

orbPerfModule.interceptors.processingTime

orbPerfModule.referenceLookupTime

systemM odule.avgCpuUtilization

systemM odule.freeMemory

hreadPoolModule.activeThreads

WebSphere MQ Templates

WebSphere MQ Templates

QALoad providesthe following pre-defined WebSphere MQ templates:

QALoad-WebSphere MQ Availability
QALoad-WebShere MQ Performance

QALoad-WebSphere MQ Availability

Thistemplate monitorsthe availability of aWebShere MQ server. The WebSohere MQ Availability
template returnscritical information about the availability of your WebSphere MQ installation.

The default sampling interval for thistemplateis5 minutes.

WebShere extended counter for
monitoring
jvmRuntimeModule.usedMemory

WebSphere extended counter for
monitoring
orbPerfModule.concurrentRequests

WebShere extended counter for
monitoring
orbPerfModule.interceptors.processingTime

WebSphere extended counter for
monitoring
orbPerfModule.referenceLookupTime

WebSphere extended counter for
monitoring
systemModule.avgCpuUetilization

WebShere extended counter for
monitoring systemModule.freeMemory

WebShere extended counter for
monitoring
threadPoolM odule.activeThreads

The WebShere MQ Availability template usesthe following WebSphere MQ extended counters:

e e

Channel Events

Queue Manager Events

Queue Manager
Up/Down
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Return the number of channel events for the current

interval.

Reportsthe number of queue manager eventsfor the

current interval.

Monitorstherunning state of a queue manager.
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QALoad-WebSphere MQ Performance

Thistemplate monitorsthe performance of aWebSphere MQ server. The WebShere MQ Performance
template returnscritical information about the performance of your WebShere MQ installation.

The default sampling interval for thistemplateis5 minutes.

The WebShere MQ Performance template usesthe following WebSphere MQ extended counters:

_

Performance Events Thiscounter reportsthe number of
performance eventsfor the current
interval.

WMI Templates

WMI Templates

QALoad providesthe following pre-defined WMI templates:
QALoad-Active Monitoring Availability

QALoad-Citrix IMA Networking

QALoad-Citrix Metaframe All

QALoad-Citrix MetaFrame IMA

QALoad-Citrix MetaFrame Zone

QALoad-Cold Fusion

QALoad-Generic Application Availability and Performance
QALoad-M SIIS Availability

QALoad-M SlISPerformance

QALoad-Active Monitoring Availability

Thistemplate includesthe following counters and categories:

Memory Available M Bytes
Processor % Processor Time
System System Up Time

QALoad-Citrix IMA Networking

Thistemplate includesthe following counters and categories:
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Citrix IMA Networking Bytes Received/sec
Bytes Sent/sec
Network Connections

Network Interface Bytes Total/sec

QALoad-Citrix Metaframe All

Thistemplate includesthe following counters and categories:
Citrix MetaFrame XP Application Enumerations/sec

Application Resolution Time
(ms)

Application Resolutions/sec
Data Sore Connection Failure
DataStore bytes read/sec
DataStore bytes written/sec
DataStore reads/sec

DataStore writes/sec

Dynamic Store bytes read/sec

DynamicSore bytes
written/sec

DynamicStore reads/sec
DynamicSore writes/sec

Filtered Application
Enumerations/sec

LocalHostCache bytes
read/sec

LocalHostCache bytes
written/sec

252



Memory
PhysicalDisk

Processor

LocalHostCache reads/sec
LocalHostCache writes/sec
Zone Elections

Zone Elections Won

Page Reads/sec

% Disk Time

% Processor Time

QALoad-Citrix MetaFrame IMA

Thistemplate includesthe following counters and categories:

Citrix MetaFrame
XP

Terminal Services

Application Enumerations/sec

Application Resolution Time (ms)

Application Resolutions/sec
Data Sore Connection Failure
DataStore bytesread/sec
DataStore byteswritten/sec
DataStore reads/sec

DataStore writes/sec

Fltered Application
Enumerations/sec

LocalHostCache bytesread/sec
LocalHostCache byteswritten/sec
LocalHostCache reads/sec
LocalHostCache writes/sec

Active Sessions

Conductor
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Total Sessions

QALoad-Citrix MetaFrame Zone

Thistemplate includesthe following counters and categories:

Citrix MetaFrame Dynamic Store bytes read/sec
XP

DynamicSore bytes
written/sec

DynamicStore reads/sec
DynamicStore writes/sec
LocalHostCache bytes read/sec

LocalHostCache bytes
written/sec

LocalHostCache reads/sec

Zone Elections

Zone Elections Won
Network Interface Bytes Total/sec

Current Bandwidth
Terminal Services | Active Sessions

Total Sessions

QALoad-Cold Fusion
Thistemplate includesthe following counters and categories:

ColdFusion MX Avg DB Time (msec)
Server

Avg Queue Time (msec)

Avg Req Time (msec)
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BytesIn / Sec

Bytes Out / Sec

DB Hits/ Sec

Page Hits/ Sec

Queued Requests

Running Requests

Timed Out Requests
Memory % Committed BytesIn Use

Available Bytes

Page Faults/sec

Process % Processor Time

QALoad-Generic Application Availability and Performance

Thistemplate includesthe following counters and categories:

Process % Processor Time

System System Up Time

QALoad-M SIS Availability

Thistemplate includesthe following counters and categories:

System System Up Time
Web Service Current Anonymous
Users

Current Connections
Logon Attempts/sec

NonAnonymous
Users/sec

255



Conductor

Not Found Errors/sec
Total Delete Requests
Total Files Sent

Total Get Requests

Total NonAnonymous
Users

Total Not Found Errors

QALoad-M SIS Performance

Thistemplate includesthe following counters and categories:

Internet Current Blocked Async I/O
Information Requests
Services Global

Total Blocked Async I/O
Requests

Total Rejected Async 1/0O
Requests

URI Cache Hushes
URI Cache Hits
URI Cache Hits %

URI Cache Misses

PhysicalDisk % Disk Time
Process % Processor Time
Redirector Current Commands

Network Errors/sec

Server Work Item Shortages
Server Work Queue Length
Queues

Web Service Not Found Errors/sec
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Windows Registry Templates

QALoad providesthe following pre-defined Windows Registry templates:
QALoad-Active Monitoring Availability

QALoad-Citrix IMA Networking

QALoad-Citrix Metaframe all

QALoad-Citrix Metaframe IMA

QALoad-Citrix Metaframe Zone

QALoad-Cold Fusion

QALoad-Generic Application Availability and Performance
QALoad-M SIIS Availability

QALoad-M SlISPerformance

QALoad-Server Health

QALoad-Windows Availability

QALoad-Windows Performance

QALoad-Active Monitoring Availability

Thistemplate includesthe following counters and categories:

Memory Available MBytes | Thiscounter monitorsthe Active
Monitoring client site and notifies
you when it islow on resources,
where Processor time is > 95% for
morethan 3 intervals. The parameter
for thiscounter isinstance. The
default is _Total.

Processor % Processor Time Raise an event when Active
Monitoring client siteislow on
memory resources, where Available
Memory isat or below 1MB for more
than 3 intervals.

System System Up Time This counter teststhe network
connection between two machines
and monitorsthe communication
status of the machine that receives
communication.

Conductor
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QALoad-Citrix IMA Networking

Thistemplate includesthe following counters and categories:

Citrix IMA
Networking

Network Interface

Bytes
Received/sec(*_Total”)

Thiscounter monitorsthe
total bytesreceived per

second.

Bytes
Sent/sec(_Total”)

Network Connections

Thiscounter monitors the
total bytes sent per second.

Thiscounter monitorsthe

network connections.

Bytes Total/sec

Thiscounter monitorsthe

network connection total
bytes/sec.

QALoad-Citrix Metaframe all

Thistemplate includesthe following counters and categories:

Citrix MetaFrame XP

258

Application Enumerations/sec

Application Resolution Time
(ms)

Application Resolutions/sec

Data Sore Connection Failure

DataStore bytesread/sec

DataStore byteswritten/sec

DataSore reads/sec

DataSore writes/ sec

Thiscounter monitors
application enumerations/
Sec.

Thiscounter monitors
application resolution
time.

This counter monitors
application resolutions.

This counter monitors
datastore connection failure.

Thiscounter monitors
datastore bytes reads per
second.

Thiscounter monitors
datastore bytes written per
second.

This counter monitors
datastore reads per second.

This counter monitors
datastore writes per second.



Memory

PhysicalDisk

Processor

Dynamic Sore bytesread/sec

DynamicSore bytes
written/sec

DynamicSore reads/sec

DynamicSore writes/sec

Fltered Application
Enumerations/sec

LocalHostCache bytesread/sec

LocalHostCache bytes
written/sec

LocalHostCache reads/ sec

LocalHostCache writes/sec

Zone Elections

Zone Elections Won

Page Reads/sec

% Disk Time

% Processor Time

Conductor

This counter monitors
DynamicSore bytesread per
second.

Thiscounter monitors
DynamicSore bytes written
per second.

Thiscounter monitors
DynamicSore reads per
second.

This counter monitors
DynamicSore writes per
second.

Thiscounter monitors
Fltered Application
Enumerations per second.

Thiscounter monitors
LoadHostCache bytesread
per second.

Thiscounter monitors
LoadHostCache bytes
written per second.

Thiscounter monitors
LoadHostCache reads per
second.

Thiscounter monitors
LoadHostCache writes per
second.

This counter monitors zone
elections.

This counter monitors zone
electionswon.

This counter monitors page
reads per second.

This counter monitors %
disk time.

This counter monitors %
processor time.

QALoad-Citrix Metaframe IMA

Thistemplate includesthe following counters and categories:
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Citrix MetaFrame
XP

Terminal Services

260

Application Enumerations/sec

Application Resolution Time (ms)

Application Resolutions/sec

Data Sore Connection Failure

DataStore bytes read/sec

DataStore bytes written/sec

DataSore reads/sec

DataSore writes/sec

Filtered Application
Enumerations/sec

LocalHostCache bytes read/sec

LocalHostCache byteswritten/sec

LocalHostCache reads/sec

LocalHostCache writes/sec

Active Sessions

Total Sessions

Thiscounter monitorsthe
application enumeration per
second.

Thiscounter monitorsthe
application resolution time.

Thiscounter monitorsthe
application resolution.

This counter monitorsthe
datastore connection failure.

Thiscounter monitorsthe
datastore bytesread per second.

Thiscounter monitorsthe
datastore byteswritten per second.

This counter monitorsthe
datastore reads per second.

Thiscounter monitorsthe
datastore writes per second.

Thiscounter monitorsfiltered
application enumerations per
second.

Thiscounter monitors
LoadHostCache bytesread per
second.

Thiscounter monitors
LoadHostCache bytes written per
second.

This counter monitors
LoadHostCache reads per second.

This counter monitors
LoadHostCache writes per second.

This counter monitors active
sessions.

This counter monitorstotal
sessions.



QALoad-Citrix Metaframe Zone

Conductor

Thistemplate includesthe following counters and categories:

Citrix MetaFrame
XP

DynamicSore bytes
written/sec

DynamicSore reads/sec

DynamicSore writes/sec

LocalHostCache bytesread/sec

LocalHostCache bytes

written/sec

LocalHostCache reads/ sec

Zone Elections

Zone ElectionsWon
Network Interface Bytes Total/sec
Current Bandwidth

Terminal Services Active Sessions

Total Sessions

QALoad-Cold Fusion

Dynamic Sore bytes read/sec

This counter monitorsthe dynamic
store bytesread / sec.

This counter monitorsthe dynamic
store bytes written / sec.

Thiscounter monitorsthe dynamic
store reads/ sec.

This counter monitorsthe dynamic
store writes/ sec.

Thiscounter monitorsthe
LocalHostCache bytesread / sec.

Thiscounter monitorsthe
LocalHostCache bytes written / sec.

Thiscounter monitorsthe
LocalHostCache reads/ sec.

Thiscounter monitorsthe zone
elections.

Thiscounter monitorsthe zone
electionswon.

Thiscounter monitors network
connection total bytes.

Thiscounter monitors network
connection current bandwidth.

Thiscounter monitors active sessions.

This counter monitorstotal sessions.

Thistemplate includesthe following counters and categories:

ColdFusion M X
Server

Avg DB Time (msec)

Avg Queue Time (msec)

Avg Req Time (msec)

261



Conductor

Memory

Process

BytesIn / Sec

Bytes Out / Sec

DB Hits/ Sec

Page Hits/ Sec
Queued Requests
Running Requests
Timed Out Requests

% Committed BytesIn
Use

Available Bytes
Page Faults/sec

% Processor Time

QALoad-Generic Application Availability and Performance

Thistemplate includesthe following counters and categories:

Process

System
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% Processor Time This counter returnsthe

percentage of elapsed time
that all threads of a process
use the processor to execute
instructions. This process
could include code executed to
handle certain hardware
interrupts or trap conditions.

System Up Time This counter monitors critical

tasks by verifying the existence
of processes. You can monitor
single or multiple tasks
running on the system by
selecting the Processes tab
from the task manager and
then selecting processes that
you want to monitor. You can
also monitor only certain
instances of atask by
specifying a Process ID to
monitor. If you do not specify
a Process ID, thiscounter



QALoad-MSIIS Availability

monitorsall instances of the
task.

Thistemplate includesthe following counters and categories:

System

Web Service

System Up Time

Current Anonymous
Users

Current Connections
Logon Attempts/sec
NonAnonymous Users/sec
Not Found Errors/sec
Total Delete Requests
Total Files Sent

Total Get Requests

Total NonAnonymous
Users

Total Not Found Errors

QALoad-M SIS Performance

Thistemplate includesthe following counters and categories:

T T

Internet
Information
Services Global

Current Blocked Async
I/0 Requests

Total Blocked Async I/O
Requests

Total Rejected Async
I1/0 Requests

URI Cache Fushes

URI Cache Hits

Conductor
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URI Cache Hits %

URI Cache Misses

PhysicalDisk % Disk Time
Process % Processor Time
Redirector Current Commands

Network Errors/sec
Server Work Item Shortages
Server Work Queues Queue Length

Web Service Not Found Errors/sec

QALoad-Server Health

Thistemplate includesthe following counters and categories:

Memory % Committed BytesIn
Use
Pages/sec
PhysicalDisk % Disk Time

Avg. Disk Queue Length
Processor % Processor Time

System Processor Queue Length

QALoad-Windows Availability

Thistemplate monitorsthe availability of the Windows operating system, focusing on:
Logons

Security

Up time

The default sampling interval for thistemplate is5 minutes.

Thistemplate includesthe following counters and categories:
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Server
Errors Granted Access
Errors Logon
Errors System
Logon Total

Server Sessions
Sessions Errored Out
Sessions Forced Off
Sessions Logged Off

Sessions Timed Out

System System Up Time

QALoad-Windows Performance

Errors Access Permissions The Microsoft Windows

Availability template uses these
Server registry countersto
monitor errorsdue to logon
problems.

To enable these counters, you
must configure your Windows
system to audit logon and
logoff events. You can do this
by configuring the Audit Policy
in the User Manager for
Domains program.

The Microsoft Windows
Availability template uses these
Server registry countersto
monitor how well users
sessionsare running.

If thereisalarge number of
session errors, it isusually due
to systemsrebooting often or
network errors.

Thiscounter returnsthe
number of secondsthat a
system was available for use. If
thisnumber continuesto reset
to zero, it meansthat the
system isrebooting often. For a
report that liststhe number of
timesthat the system has
rebooted over a period of time,
see the Microsoft Windows
Availability Report topic.

Thistemplate monitorsthe performance of the Microsoft Windows system, focusing on:

CPU

Disk I1/0
Disk space
Memory

Network

The default sampling interval for thistemplateis5 minutes.

Thistemplate includesthe following counters and categories:
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LogicalDisk % Disk Time Thiscounter monitorsthe
percentage of elapsed time that
the disk servicesread and write
requests, including thetime
that the disk driver waitsin the
disk queue. If thisvalueis
consistently near 100%, the disk
isin very heavy use. You can
determine which processes are
making the majority of the disk
requests by monitoring them
individually.

% Free Space This counter monitors low free-
space situations.

Avg. Disk Queue Length = Thiscounter indicatesthe
number of pending I/O service
requests. If thereturned valueis
greater than 2, thereisadisk
problem. On a multi-disk
subsystem, such asa striped set
or striped with parity, you can
perform a calculation to
determine the presence of a disk
problem. The basic formulais
(Disk Queue Length) - (Number
of Physical Disk Drivesin the
multi-disk configuration).

For example, if you have a
striped set with 3 disk drives
and a queue length of 5, then
you get an acceptable value of 2
(5-3=2).

Memory Available Bytes If the valuereturned by this
counter fallsunder 10 MB,
virtual memory isrunning low.
To resolve this, close some
applicationsor increase the
memory settings. If this counter
isconsistently low after an
application isrunning, it
usually indicates a system
memory leak.

Asthevaluereturned by this
counter decreases, the value
returned by the Committed
Bytes counter increases. This
indicatesthat a processis
allocating memory from the
virtual address space but might
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Cache Faults/sec

Committed Bytes

Page Faults/sec

Page Reads/sec

Pages/sec

Conductor

not be using it. Because the
virtual address spaceisalimited
resource, use these countersto
check for applicationsthat
allocate memory but do not use
it. To resolve this, add more
physical memory. When an
application finishes processing,
notethe last value. If this
counter does not return to the
original value, the application
hasamemory leak or ahidden
processthat hasnot properly
terminated.

The acceptable range for
committed bytes should be less
than the physical RAM. The
default valueis 64 MB.

If the valuereturned by this
counter islessthan the value
returned by the Page faults/sec
counter, the system is paging
too much for anormal system.
To resolve this, add more
physical memory.

This counter returnsthe
amount of virtual memory (in
bytes) that was committed, as
opposed to memory that has
was reserved.

If the valuereturned by this
counter is greater than 5, the
system ispaging too much. Add
more physical memory. A
consistent value of 10 or later
needsimmediate attention.

If thiscounter returnsahigh
peak value, the system is
experiencing alot of paging
activity. A high value also
indicatesthat your system does
not contain enough physical
memory to handle the demands
placed on it by the application.
To resolve this, add more
physical memory. To calculate
the % disk time used for paging,
use the following calculation:
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Transition Faults/sec

Paging File % Usage Peak

PhysicalDisk % Disk Time
Avg. Disk Queue Length
Avg. Disk sec/Transfer
Disk Reads/sec
Disk Writes/sec

Processor % Interrupt Time

% Processor Time

% User Time

Redirector Network Errors/sec

268

(% Disk Time used for paging) =
(Memory, Pages/sec) * (Average
Disk Transfer/sec) * 100

This counter returnsthe
maximum use of your page file.
If the value the counter returns
consistently reaches 90%, the
virtual address space istoo
small. You should increase the
size of your paging file. When
the valuereturned by the
counter exceeds 75%, a
significant system performance
degradation becomes
noticeable.

Thiscounter monitorsthe
percentage of time that the
processor spent receiving and
servicing hardware interrupts
during the sample interval.

On single processor systems, if
the valuereturned by this
counter isconsistently higher
than 90%, the CPU probably
has a bottleneck. You should
examine each processin the
system to determine which one
isusing more of the processor
than it should. The process with
the highest peak isgenerally the
performance bottleneck.

Thiscounter monitorsnon-idle
processor time spent in User
mode as a percentage of the
sample interval.

This counter indicates how
many serious network errors
have occurred. These errors are



Server Bytes Received/sec

Bytes Total/sec
Bytes Transmitted/sec

Errors Logon

Work Item Shortages

System Context Switches/sec

Processor Queue Length

Creating and Editing Monitoring Tasks

Creating a New Monitoring Task

To accessthe New Monitoring Task wizard:

Conductor

generally logged in the system
event log, so you can check
there for moreinformation. If
an error occurs, take immediate
action to resolve the problem.

Thiscounter determinesif an
unauthorized user istrying to
access your system.

Thiscounter monitorsthe
number of timesthat awork
item was not allocated. You
might need to increase the
InitWorkltems and

MaxW orkltems parameters for
the LanMan Server if this
number continuesto increase.

If the valuereturned by this
counter valueishigh, assign a
higher priority to the use of
critical sections or semaphores
by the program. Thisachievesa
higher throughput and reduces
task switching.

Click Tools>Monitoring>New monitoring task. The New Monitoring Task wizard appears. Click Next to

start the procedure.

Usethe following stepsin the New Monitoring Task Wizard to create anew monitoring task:

1. Define the monitor

Configure the monitor

Discover the counters

Choose the counters for the monitoring task

Choose the instances of the counter to monitor

o g M w DN

Review the monitor definition
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7. Save and create the monitoring task

Using an Existing Monitoring Task

To select an existing monitoring task:

1. Click Tools>Monitoring>Use existing task. The Choose an Existing Task dialog box appears.

2. Select a task and click OK. The task displays in Conductor's Monitoring Options tab.

See also:
Choose an Existing Monitoring Task Dialog Box
Adding a Monitoring Machine

To accessthe New Monitoring Task wizard:

Click Tools>Monitoring>Add monitor. The Add Monitoring Machine wizard appears. Click Next to start
the procedure.

Usethe following stepsin the Add Monitoring Machine wizard to add a monitoring machine to the task:
1. Enter properties of the monitoring machine

Configure the monitor

Discover the counters

Choose the counters for the monitoring task

Choose the instances of the counter to monitor

Review the monitor definition

\‘F”P"PS’J!\’

Save and create the monitoring task
. Note: See Setting Up Integration with ServerVantage for the procedure used for this monitor type.

Editing a Monitoring Machine

To accessthe Edit Monitoring Machine wizard:

Click Tools>Monitoring>Edit monitor. The Edit Monitoring Machine wizard appears. Click Next to start
the procedure.

Usethe following stepsin the Edit Monitoring Machine wizard to change the properties of amonitoring
machine:

1. Enter properties of the monitoring machine
Configure Monitor Dialog

Discover the Counters

Choose Counters

Choose Instances

Review Monitor Definition

\'F”.U"P.W!\’

Summary
|J Note: See Setting Up Integration with ServerVantage for the procedure used for this monitor type.
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Editing Instances

Use the following procedure to edit instancesif the counters you are monitoring.

To accessthe Edit Instances dialog boxes:

1. On the Monitoring Optionstab, select the machine, the counter, or the instance to edit.

2. Click Tools>Monitoring>Edit instances. The Edit Instances dialog boxes display.

To edit the instances of a counter:

1. Inthe Choose Instances dialog box, double-click the counter group in the left-hand paneto
display the counters.

2. Select acounter and click Edit. The Select instance for counter dialog box appears.
Il Note: When a counter can not be edited, the Edit button is unavailable.
3. Perform the necessary edits. You can do the following:

= Inthe Available Instances pane, select an instance and click Add. Theinstanceisadded to the
Selected Instances pane. Repeat until you select all instances of the counter that you want to
apply to the task.

= In the Selected Instances pane, select an instance and click Remove. Theinstanceisremoved
from the Selected Instances pane and added to the Available Instances pane.

4. Click Save. The Choose Instances dialog box displays again.
5. Repeat thisprocess for each counter you want to edit.

6. Click Next. The Review Monitor Definition dialog box displays.

Review the monitor definition:

=

Review the information for the monitoring machine you defined.
2. Select one of the following:

I Set up another monitor for thistask - returnsto the Define Monitor dialog box so you can
add another monitor to the monitoring task.

I Continuewithout adding any more monitors - continuesin thisdialog box.
3. (Optional) Click Save as Template to create atemplate for thismonitoring task.

4. (Optional) Select amonitor in the Monitors pane and click Remove Monitor to delete a monitor
from the task.

5. (Optional) Type anew valuein the Sample Interval field. Thisisthe frequency, in seconds, at
which QALoad requests data from ServerVantage during runtime data collection.

6. Click Next. The Summary dialog box displays.

Save the task:

1. Review the monitorsand countersyou have selected for the task. Click Back to return to adialog
box and make changesto theinformation.
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2. IntheMonitoring task name field, type aname for the monitoring task.
In the Description field, type a description for the task.

4. Select amonitorin the Monitorspane, and click View Monitor Details. The Properties of dialog
box displayswith detailed information about the monitor configuration and the countersyou
selected.

5. Click Finish to create the monitoring task.

Server Analysis Agent

Server Analysis Agents

Server Analysis agents use enhanced ServerVantage technology to provide server utilization data without a
complete ServerVantage deployment. Server Analysis agents, provided on the QACenter Performance
Edition CD, are quickly and easily installed on the serversthat you wish to monitor during aload test.
Server Analysis agents provide you with valuable server utilization metrics — called counters— on Web
servers, application servers, and database servers being exercised by your load test to help you to pinpoint
performance bottlenecks when load testing.

Unlike a full ServerVantage installation, you can start, stop, and configure Server Analysis Agentsright
from the familiar interface of the QALoad Conductor.

Server utilization datafrom the agentsand responsetimeinformation from QALoad isall automatically
downloaded and correlated through the use of ActiveAnalysis, and is available for post-test analysis
through QALoad Analyze.

Server Analysis agents are set up when you create a monitoring task. For details about using Server Analysis
agentsin aload test, see Creating a New Monitoring Task.

Server Analysis Agent Templates
QALoad-Windows Performance

Thistemplate monitorsthe performance of the Microsoft Windows system, focusing on:
! CPU
! Disk /O
I Disk space
I Memory
I Network

The default sampling interval for thistemplateis5 minutes.

Thistemplate includesthe following counters and categories:

LogicalDisk % Disk Time
Memory Available Bytes
Cache Faults/sec

Committed Bytes
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Page Faults/sec

Paging File % Usage Peak

Processor % Processor Time

% User Time

Interrupts/sec
Server Bytes Total/sec
ServerVantage

Setting up Integration with ServerVantage

To set up integration with ServerVantage:

1.
2.
3.

© N o o

10.

On the Conductor Test Information Screen, click the Monitoring Optionstab.
Click the Set up monitoring link, then select Set up a new monitoring task.

In the Define Monitor dialog box, click the arrow in the Monitor Type box and select
ServerVantage.

In the Control Server Database Host field, click the down arrow and select the hostname of the
machine where the ServerVantage server islocated.

Click Next. The Configure Monitor dialog box displays.
In the Username field, type avalid user name to access the ServerVantage server, if necessary.
In the Password field, type the password that correspondsto the user name above, if necessary.

Select the Override Default Database check box to provide the ServerVantage database name.
When thisoption isnot selected, QALoad usesthe default ServerVantage database name. If you

provided a different name during the installation of ServerVantage, select thisoption and typethe

namein the Database Name field.

In the Name field in the Vantage Agent area, type the hostname of a machine(s) where a
ServerVantage Agent isinstalled, and click the Add button to add it to your load test.

Click Next to proceed to the next step.

Server Monitoring with ServerVantage

If you are currently alicensed user of Compuware's ServerVantage, you can integrate data from your
existing ServerVantage deployment directly into a QALoad timing file.

For thismethod to be successful, the following conditions must be met:

ServerVantage must be installed and configured correctly on your system. For more information
about installing or configuring ServerVantage refer to its product documentation.

ServerVantage must be scheduled to monitor the specified performance countersat atime that
coincideswith arunning QALoad test.
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I QALoad must be able to access the appropriate Agent stationsto collect resource utilization data at
the end of the load test.

ServerVantage

ServerVantage (formerly ECOTOOLS) monitorsthe availability and performance of applications, databases
and servers, allowing usersto centrally manage events across all application components— Web servers,
firewalls, application servers, file systems, databases, middleware, and operating systems. ServerVantage
simultaneously monitorsthese components, analyzes both historical and real-time events, and correlates
monitored information for problem detection.

Thisintegration uses standard Netbios ports. Netbios ports 137-139 and 145 should be kept open when
performing thistype of activity. Integration with ServerVantage is configured from the QALoad Conductor.
Performance counters collected during aload test areincluded in thetest'stiming file and can be sorted
and displayed in QALoad Analyze in much the same way as QALoad timing data. For more information
about installing or configuring ServerVantage refer to its product documentation.

ApplicationVantage

Overview of ApplicationVantage

QALoad integrates with ApplicationVantage to help you analyze network performance during aload test.
ApplicationVantage provides granular thread detailsthat allow network managersto identify poorly
performing applications. QALoad also providestest datathat you can open in ApplicationVantage.

Before QALoad can collect network data during aload test, the following must be true:

I The ApplicationVantage Agent isinstalled on the same machine asthe QALoad Conductor. You
can install either the ApplicationVantage Agent or the ApplicationVantage Remote Agent.

I You have specified on which NIC to capture from the Machine Assignment tab in Conductor.

At test time when atransaction is started, the Player configured to capture ApplicationVantage data starts
an ApplicationVantage trace. The trace stopswhen the transaction completes. When a Player isrunning a
script that isset to run in ApplicationVantage mode, every transaction generates a new trace file. At the
end of the test, these files are packaged into the test'stiming file.

' Hint: For information about ApplicationVantage, refer to the documentation you received with your
purchase of thistool.

Configuring atest to use ApplicationVantage

Integration with ApplicationVantage enablesyou to study network problemsin detail. You can set up one
or more ApplicationVantage (AV) Player machines for the load test. These AV Player machinesrun a
QALoad script on a periodic basiswhile the AV Agent capturesthe network traffic that the script produces.
Theresulting AV trace files (*.opx) are sent back to the Conductor with the regular QALoad timing file for
analysis after the test iscomplete.

To enable ApplicationVantage, you must be running ApplicationVantage 9.5 or greater. You must select
the ApplicationVantage option, and then set the Network Interface Card (NIC) ServiceName used by the
machine on which the datais captured.

Enabling ApplicationVantage

You can enable or disable the ApplicationVantage for each load test on a script. To enable
ApplicationVantage, you must select the option, and then set the Network Interface Card (NIC)
ServiceName.
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To enable ApplicationVantage:

Click Conductor's Script Assignment tab.

Click in the Script column to enablethe Browse (...) button. Then, click Browse. The Select Script
dialog box displays.

Click the ApplicationVantage Mode box at the bottom of the dialog box..
Click OK.
Set the NIC ServiceName.

Setting up Network Interface Card ServiceName

To use the ApplicationVantage Agent to collect data for ApplicationVantage, it isnecessary to specify
which Network Interface Card (NIC) to capture on. Thisisthe network information for the workstation
where your ApplicationVantage Remote Agent isinstalled.

To set up NIC ServiceName:

1.

With the session ID you want to use for your test open, click the Conductor's Machine
Assignment tab.

Click the Manage Player Machines button for the Conductor to query your test network for
installed Player Agents. You also can select Tools>Manage Player Machines. The Manage Player
Machines and Groupsdialog box displays with names of available Player machines.

In the All Player Machines and Groups area, double-click the Player machine that will berunning
thevirtual user to be captured. The Edit Player Machine dialog box displays.

Click the Application Vantage Settingstab.
From the drop-down list in the NIC ServiceName field, select the NIC that isused by the machine.
Click Apply, then click OK.

Troubleshooting

Conductor pre-test checks

Before atest begins, the Conductor completesthe following pre-test checks of the parameter filesand
Players. If any of these checks fail, the Conductor displays an error message.

Are there enough Players configured to support the number of users specified in the session ID file?

Doesthe number of users specified in the session ID file exceed the maximum number of users
defined by your authorization key?

Can the specified compiled script files be accessed?

Are all Playerscommunicating with the Conductor? (The Conductor sends a request message to all
the Playersto verify that they are up and running.)
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Executing SSL scriptsthat use client certificates

If you are executing SSL scriptsthat use client certificates, you must manually copy the client certificatesin
use to the Player machine(s) executing the script(s).

Manually copy the client certificates from the\ Program Fi | es\ Conpuwar e\ QALoad\ Certifi cates
directory to the same default directory on the Player machine.

El Note: On the Unix player platform, you must create the Certi fi cat es sub-directory in the QALoad
directory. The directory name is case sensitive.

Heartbeat message failure on a virtual user

When a Player machine crashes or experiences aloss of communication, the heartbeat message that the
Conductor sends out (if enabled) fails. Thissituation isindicated in the runtime Conductor through a
message on each virtual user that is affected. When the heartbeat message fails for a virtual user, the Satus
column of the Details view of a script displaysthe following message: "The Player running this user failed
to respond to a heartbeat message."

The option for enabling a heartbeat message islocated on the Player tab of the Optionsdialog box in the
Conductor.

Timing file istoo big

Depending on the length of the load test and the amount of data that was collected, timing files can grow
to excessively large sizesthat become difficult to handle. To prevent timing filesfrom becoming too large,
try modifying the following settings:

! Disable automatic middleware checkpoint timingsin the Conductor
I Usethe Conductor'stiming datathinning options

Both of these settings are located on the Timing Options dialog box, which can be accessed from the Script
Assignment tab of the Conductor.

Tips for running QALoad tests on UNIX systems

To successfully run large QALoad tests on UNIX systems, you may need to make adjustmentsto your
settings as described below:

General (AlX, Solaris, and RedHat Linux)

When you attempt to run alarge number of virtual userson UNIX platforms, the virtual users do not
always synch. If virtual usersdo not synch, try increasing the Virtual User Sartup Delay. By default,
QALoad Conductor setsthe VU Sartup Delay to 1 millisecond. Thisdefault isnot high enough for UNIX
platforms. If the UNIX Player receives a value lessthan 15 milliseconds, the delay will be 15 milliseconds
or more.

To increase the delay:

1. In the QALoad Conductor, click Tools>Options.
2. Click the Player tab.
3. IntheVU Startup Delay field, type the number of millisecondsto delay virtual user startup.
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Solaris

The default file descriptor limit on Solaris has a "soft" limit of 64, and a"hard" limit of 1024 (Solaris 2.6).
Per the Solaris 2 FAQ (refer to http://www.wins.uva.nl/pub/solaris/solaris2.html), the file descriptor limit is
described in the getrlimit() manual page as: "One more than the maximum value that the system may
assign to anewly created descriptor. Thislimit constrainsthe number of file descriptorsthat a process may
create."

To increase thislimit, system administrators can modify the/ et ¢/ syst emfile and reboot the system. For
example:

* set hard limt on file descriptors
set rlimfd_nmax - 4096
*set soft limt on file descriptors

set rlimfd_cur = 1024
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